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About the Cover

This resort complex located 200 feet from the San Carlos Bay coastline in Fort Myers Beach, Florida was elevated 
through a joint Federal, State of Florida, and local mitigation project. In the last two decades, seven hurricanes 
have caused flood- and wind-related damages to the complex, resulting in nearly $100,000 in repair costs per 
event. The Flood Mitigation Assistance (FMA) program funded the Federal share (75%) of the elevation of six 
buildings within the complex. The effectiveness of the mitigation project was tested when Hurricane Charley 
hit Fort Myers Beach in August 2004. At that point, four of the resort buildings had been elevated. Those four 
buildings experienced only minimal damage and were able to stay open and functional while several nearby 
hotels and motels were flooded, damaged, and/or forced to close. It is estimated that approximately $200,000 
in repair costs alone were avoided in 2004 because of the mitigation afforded by the elevation project. 
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1. Definitions 

1.1 Flood Insurance Terms 
Cumulative Losses – The total value of losses on a structure during a specified 
period of time. 
 
Repetitive Loss (RL) Structure – The National Flood Insurance Program (NFIP) 
definition is any property for which two or more flood insurance claims of more 
than $1,000 have been paid within any rolling 10-year period since January 1, 
1978. Each RL record is identified for FEMA internal program tracking by the 
use of a seven-digit Repetitive Loss or Property Locator number unique to the 
individual record. No additional identification is provided to distinguish the 
various sub-categories below. 
 
Target Group Repetitive Loss Properties – This is a subset of NFIP repetitive 
loss properties that have had: 

• Four or more claim payments of more than $1,000 within any rolling 10-
year period since January 1, 1978, and/or 

• Two or more claim payments within any rolling 10-year period since 
January 1, 1978, that appear to equal or exceed the reported property 
value.  

 
Severe Repetitive Loss Properties – A subset of Target Group Repetitive Loss 
Properties defined by the Bunning-Bereuter-Blumenauer Flood Insurance Reform 
Act of 2004. An SRL property is defined as a residential property (occupancy is 
single family, 2-to-4 family, other residential, or assumed condo) that is covered 
under an NFIP flood insurance policy and: 

(a)  That has at least four NFIP claim payments (including building and 
contents) over $5,000 each, and the cumulative amount of such claims 
payments exceeds $20,000; or 

(b)  For which at least two separate claims payments (building payments 
only) have been made with the cumulative amount of the building portion 
of such claims exceeding the market value of the building. 

For both (a) and (b) above, at least two of the referenced claims must have 
occurred within any 10-year period, and must be greater than 10 days apart. 

1.2 NFIP Terms and Building Code/Regulatory Standards 
Appurtenant Structures – Accessory structures that are not habitable but are 
located on the same property as the structure of interest. Examples of 
appurtenances include carports, sheds, garages, and decks. 

Base Flood Elevation (BFE) – The water surface elevation resulting from the 
base or 100-year flood (i.e., a flood that has a 1-percent chance of equaling or 
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exceeding that level in any given year). It is commonly referred to as the 100-year 
flood and is the national standard used by the NFIP and all Federal agencies for 
the purposes of requiring the purchase of flood insurance and regulating new 
development. 
 
Code Height Restrictions – Regulations, usually at the community level, that cap 
the height to which a structure can be built or elevated. These are mainly used in 
waterfront communities where coastal or riverfront views are being protected.  
 
Compensatory Storage – Floodwater storage created to offset the effects of 
development in the floodplain. Some communities require a hydraulically 
equivalent storage volume be created for floodwaters when development has 
resulted in the displacement of floodwaters from part of the floodplain.  
 
Design Flood Elevation (DFE) – Elevation to which a building is designed to 
provide protection from flooding. The DFE is generally referenced to the BFE 
and might include some level of freeboard (see definition) above the BFE for 
added protection. 
 
Dry floodproofing – Measures that eliminate or reduce the potential for flood 
damage by keeping floodwaters out of the structure. Examples include installation 
of watertight shield for doors and windows, reinforcement of walls to withstand 
hydrostatic and hydrodynamic pressures and debris impact, and use of sealants to 
reduce seepage of floodwater through walls. 
 
Flash flood – A flood that rises and falls very quickly and is usually characterized 
by high flow velocities. Flash floods often result from intense rainfall over a small 
area and can also occur in highly urbanized areas where pavements and drainage 
improvements speed runoff to a stream. 
 
Flood Insurance Rate Map (FIRM) – An official map of a community, on which 
FEMA has delineated both the special hazard areas and the risk premium zones 
applicable to the community. The map shows the extent of the base floodplain and 
may also display the extent of the floodway, and BFEs. 
 
Flood Insurance Study (FIS) – A study developed in conjunction with the 
FIRM. The FIS, also known as a flood elevation study, frequently contains a 
narrative of the flood history of a community and discusses the engineering 
methods used to develop the FIRMs. The study also contains flood profiles for 
studied flooding sources and can be used to determine BFEs for some areas. 
 
Freeboard – An additional amount of height included to provide a factor of 
safety. It is usually expressed in feet above a flood level for purposes of 
floodplain management.   
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Levee – A man-made structure, usually an earthen embankment, designed and 
constructed in accordance with sound engineering practices to contain, control, or 
divert the flow of water to provide protection from temporary flooding. 
 
Pre-FIRM Building − For insurance rating and floodplain management 
regulatory purposes, a pre-FIRM building is defined as a building constructed or 
substantially improved on or before December 31, 1974, or before the effective 
date of the initial FIRM of the community, whichever is later. Most pre-FIRM 
buildings were constructed without accounting for the flood hazard.   
 
Post-FIRM Building − For insurance rating and floodplain management 
regulatory purposes, a post-FIRM building is defined as a building constructed or 
substantially improved after December 31, 1974, or after the effective date of the 
initial FIRM of a community, whichever is later. A post-FIRM building is 
required to meet the NFIP’s minimum flood protection standards in effect at the 
time of construction. 
 
Substantial Damage – Damage of any origin sustained by a structure whereby 
the cost of restoring the structure to its before damaged condition would equal or 
exceed 50 percent of the market value of the structure before the damage 
occurred. 
 
Substantial Improvement – Any reconstruction, rehabilitation, addition, or other 
improvement of a structure, the cost of which equals or exceeds 50 percent of the 
market value of the structure before the start of construction of the improvement. 
This term includes structures that have incurred substantial damage, regardless of 
the actual repair work performed. The term does not, however, include either: 

(1) Any project for improvement of a structure to correct existing violations of 
state or local health, sanitary, or safety code specifications which have 
been identified by the local code enforcement official and which are the 
minimum necessary to assure safe living conditions; or 

(2) Any alteration of a historic structure provided that the alteration will not 
preclude the structure's continued designation as a historic structure. 

 
Wet floodproofing – Permanent or contingent measures applied to a structure 
and/or its contents that prevent or provide resistance to damage from flooding by 
allowing floodwaters to enter the structure. Such measures include the design of 
openings for intentional flooding of enclosed areas below the DFE, use of flood 
resistant building materials below the DFE, and protection of the structure and its 
contents (including utilities). 

1.3 Property Value 
Building Replacement Value – The value of a structure based on the cost of 
materials and labor to rebuild it. 
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Market Value – The value of a structure based on the estimated price for which a 
willing seller in the current real estate market would sell it to a willing buyer. 

1.4 Stormwater Management 
Detention Basin – A basin constructed to temporarily impound stormwater runoff 
and attenuate stormwater flows. 
 
Retention Basin – A basin that has a permanent pool for water quality treatment. 
It temporarily impounds and retains a specified amount of stormwater runoff and 
then discharges excess runoff through a riser structure and spillway at a specified 
rate. 
 
Debris flow – Floodwaters that have picked up and are carrying objects of all 
types (e.g., trees, automobiles, boats, storage tanks, dirt, oil, various chemicals, 
etc.). 
 
Flood frequency – The probability, expressed as a percentage, that a flood of a 
specific size on a specific stream will be equaled or exceeded in any given year. 

 
 



National Flood Mitigation Data Collection Tool and RLP Viewer  Introduction 
 

User’s Guide 2-1 August 2008 
 

2. Introduction 

2.1 Purpose  
The National Flood Mitigation Data Collection Tool (abbreviated as NFMDCT 
and referred to as the National Tool or NT) was developed for Nationwide use to 
gather information about floodprone structures in order to determine potentially 
appropriate long-term mitigation measures. The ultimate goal of the NT is to 
provide a standardized, systematic approach to collecting and interpreting 
property data and mitigation project development. 
 
While the focus of the NT is on data collection for repetitive loss (RL) properties, 
it can be used to gather information related to flood risk, building construction, 
and building value for any structure. The NT is designed to encourage a 
comprehensive sweep for information pertinent to each structure. Data fields 
within the NT require information from a variety of sources, including NFIP 
policy information; community building, tax, and historical flood records; and 
field reconnaissance. Having detailed data helps create a clearer picture of the 
property and its flooding issues, which is important in determining the most 
appropriate and cost-effective mitigation method. However, the NT can also be 
used for more cursory or limited data collection efforts as appropriate. 
 
The NT also allows you to make changes to the information that is currently 
recorded with the NFIP. FEMA recognizes that addresses linked to past and 
present claim records and NFIP policies may be vague or outdated. Similarly, past 
addressing practices may cause the data associated with RL properties to be 
linked with the wrong structure. Several RL properties have been mitigated from 
the 100-year flood or have been provided with a lesser degree of protection. If 
noted, and documented appropriately within the NT, any updated or corrected 
data captured may be revised by the NFIP. 
 
The Repetitive Loss Property (RLP) Viewer 2.0 is a standalone application that 
uses Geographic Information System (GIS) to display of point features 
representing repetitive loss properties over base map data such as roads, streams, 
county and community boundaries, and Q3 flood maps. New property point shape 
files can be produced quickly by reading latitude and longitude coordinates stored 
inside the NT Access file for each property. 

2.2 Description 
The NT was developed using Microsoft (MS) Access 2002 (i.e., XP); however, it 
was also designed to work with Access 2003 and 2007, provided that the 
installation is done properly for each of these systems and the system 
requirements are met (see Appendix A – System Requirements, Installation, and 
Maintenance Instructions). If you have Access 2002 or Access 2007, the icon that 
appears in the Start > All Programs list needs to be modified to point to the 
correct Microsoft Office folder. To do this, go to Start > All Programs and right 
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click on the NFMDCT_V3 icon.  Select Properties, and modify the target field to 
point to the correct Office folder (Office12 for Access 2007 or Office10 for 
Access 2002). 
 
The NT program is not compatible for use on Macintosh computers. Version 3.0 
of the NT is not supported in Access 2000. For any issues with installation, a 
Troubleshooting section is provided as Appendix B – Troubleshooting. 
 
In order to use the NT in the field, it should be loaded onto a laptop to incorporate 
information from the field visit(s) immediately. However, paper/hardcopy data 
collection forms are also provided within the NT and in Appendix C – Field Data 
Collection Suggested Equipment and Forms to allow data recording in the field 
that can be transferred to the NT after field work is complete. A two-person team 
is suggested to optimize efficiency in the field. Suggested equipment for field data 
collection is also included in Appendix C – Field Data Collection Suggested 
Equipment and Forms.  
 
Once the field data collection efforts are complete and the NT has been populated, 
a copy should be provided to the appropriate FEMA Regional Repetitive Loss 
Coordinator for inclusion into both the Regional and National Database 
Repositories. A list of these coordinators is provided in Appendix D – Regional 
Repetitive Loss Coordinators. The National Database Repository will be housed 
at FEMA Region IV. Each individual FEMA Region will serve as a Regional 
Repository where the populated databases will be housed and then forwarded to 
Region IV for inclusion in the National Database Repository. An upload site for 
each Region may eventually be created for field data collectors to send data to the 
Region’s Repository via the Internet. 
 
The NT database screens are best viewed with a screen resolution of 1024 by 768 
pixels. A screen resolution of 800 by 600 pixels is acceptable vertically but will 
not fit horizontally.  
 
The RLP Viewer 2.0 is an enhanced version of the Repetitive Loss Properties GIS 
Viewing Tool 1.1. The major improvement is that this GIS-based tool is suited to 
display maps and tabular data about repetitive loss properties as collected by the  
NT. It is now a standalone application capable of connecting to any standard NT 
database in Access format (.mdb). Hence, the application can be used in any state 
and county in the U.S. without any complicated preprocessing of the data in a 
different, non-standard NT database format. 
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3. Warnings and Agreements 

If the NT is running in MS Access 2007, both a Security Warning bar will appear 
along the top of the NT screen and a tool warning window will appear in the main 
area of the screen. First, click on the Options…button of the Security Warning bar 
to open the Security Alert window and then select the Enable this content option 
before clicking OK.  

 

 
 

Next, click Continue on the tool warning window. This warning serves to notify 
you to exercise care in making any modifications to the program code and 
structure of the database tables within the NT. Data collected with the NT will be 
stored in a National Repository. Changes to the structure of the NT can cause 
variations in the format of data leading to difficulties in storing it with and 
comparing it to other data. Additionally, the NT developers and FEMA 
Information Technology (IT) staff cannot provide technical support to those who 
have altered the NT. Select Continue once you have read the warning. 
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If the NT is running in MS Access 2003 when it is first opened, an MS Access 
security warning window will open. After selecting Open on this window, a Tool 
Warning window will open. Read the warning before clicking on Continue. 
 
Next, a third window will open with information on a Privacy Agreement. The 
Privacy Act of 1974 protects most, if not all, of the information about the 
properties inventoried by the NT. Sharing or using any NFIP data released with 
the NT for purposes other than those approved for the identified category of user 
may be a violation of the Privacy Act and the offender will be subject to the 
provisions of the act. In order to access the NT, you must acknowledge 
understanding this act by selecting the I Agree option and then selecting Continue. 
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4. Overview of Options 

Once the terms of the Privacy Statement are agreed upon, you will be shown the 
National Flood Mitigation Data Collection Tool (NT) main menu and presented 
with six options: Limited View, Detailed View, Reports, Utilities, Help, and Exit 
Application. 

 
 

4.1 Limited View 

The Limited View enables you to enter data from a brief visual inspection of the 
property, limited communication with the property owner/occupant or neighbor, 
and basic flood risk data from the FIRM. There is also an option to describe 
potential or pending mitigation actions in the Notes sections. Data in the Limited 
View serve as the basis for all data records and should be completed prior to the 
collection of additional data.  

4.2 Detailed View 

Detailed data collection is suitable when a more thorough inspection of the 
property and its surroundings is conducted, as well as when local or state officials 
are contacted for structure-specific information and coordination of on-site data 
collection efforts. Limited View information should also be collected and 
populated within the NT as part of detailed data collection efforts. 
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4.3 Reports 

The Reports function provides summary reports for any or all of the properties in 
the database.  Reports can be accessed from the main menu or by selecting 
Reports on the top tool bar of the Limited or Detailed Views.   

The reports generated can be printed to portable document format (PDF) even if 
your computer does not have Adobe Acrobat installed. Selecting Create PDF 
from the Print Menu or, if you have Adobe Acrobat installed, clicking on Print 
and then choosing Adobe PDF from the list of printers you have available. Once 
the PDF is created, you can rename and save the file to any location by using the 
Save As function under File on the Adobe tool bar. 

 
 
There are currently 12 types of reports available: AW-501, Basic, Benefit-Cost, 
CID Summary, Community Summary, Missing Images and Documents, 
Mitigation, Photo Summary, Properties Requiring Action/Update, Selecting 
Appropriate Mitigation Measures for Floodprone Structures (FEMA 551) – 
Worksheets, Severe Repetitive Loss Properties, and Suggested Mitigation 
Options. 

4.3.1 AW-501  

An AW-501 report is automatically generated for a property when any of 
the following fields are checked: field observations for Mitigation 
Updates; Incorrect Community and/or Address; or Duplicate Listing. The 
information contained in this report can be used to complete the NFIP 
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Repetitive Loss Update Worksheet (form AW-501). Also see Appendix G 
of this User's Guide for additional information about the AW-501. 

4.3.2 Basic  

This report is a summary of property information for each property 
selected. It includes information on the site, structure, claims, insurance, 
and mitigation measures. 

4.3.3 Benefit-Cost 

This report is prepared for each selected property and contains data 
collected with the NT that can be used in the development of a FEMA 
Benefit Cost Analysis (BCA, including property value information and 
flood risk data. 

4.3.4 CID Summary 

The Community Identification Number (CID) report provides property 
listings (Address and Property Locator/Repetitive Loss Number) for all 
records in the NT for a specific community.  

4.3.5 Community Summary 

This report provides counts of records, by community, corresponding to 
properties that require updates, properties that are mitigated, flood source, 
and land use. 

4.3.6 Missing Images and Documents 

A report listing any images or documents that are associated with a 
property but are missing from the NFMDCT folder. 

4.3.7 Mitigation 

A per property hybrid report combining selected structural, NFIP, Benefit 
Cost and Mitigation Analysis Information on a single page. Sorted by 
community first, then property locator number. This report is useful in the 
property owner consultation process.  

4.3.8 Photo Summary  

This report shows all photographs attached to a record. You can also 
generate reports for multiple selected properties. The report criteria screen 
allows you to click on the column heading to sort the properties by Rep 
Loss #, Community Name, or CID number before selecting specific and 
multiple properties that you want to generate a report.  
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4.3.9 Properties Requiring Action/Update 

This report contains a listing of properties that require follow-up action by 
FEMA. The report will include properties with any of the following boxes 
checked: Updates Made; Incorrect Community and/or address; additional 
Research Needed; Mitigation Updates based on Field observations, 
Mitigation Observed; Mitigation Verified; duplicate Listing; and Claims 
Update Required. 

4.3.10 Selecting Appropriate Mitigation Measures for Floodprone Structures 
(FEMA 551) – Worksheets 

Worksheet A from FEMA publication 551 is a sample information packet 
to be used while working with a property owner. All of the data and 
information contained within the sample packet are fictitious. Worksheet 
B is the same packet but with blank sheets that can be completed by any 
user. The small, blue and white “551” symbol indicates that this report 
requires specific fields in NT in order to be created. This symbol can be 
found next to these specific fields in tabs of both the Limited and Detailed 
View.  

4.3.11 Severe Repetitive Loss Properties 

This report generates listings, including address, repetitive loss (RL) 
number, and claims history for those properties meeting the current SRL 
definition. However, in addition to the 1-to-4 family residences identified 
in the official definition, the report will also include listings for the 
“OTHER RESID” occupancy type found in NFIP.  

The 10 SRL indicators from the imported NFIP spreadsheet use the 
following codes and values: 

 
Code    Value             

All  All Types 
V    Validated 
VU    Validated Uninsured 
VN    Validated NonResidential 
VNU    Validated Nonresidential Uninsured 
P    Pending 
PU    Pending Uninsured 
PN    Pending NonResidential 
PNU   Pending Nonresidential Uninsured 

Reports can be generated based on any or all of the SRL indicators 
selected by using a drop down box. After choosing your criteria, click on 
the Continue button to generate the report. For any report generated, the 
Property Locator/Rep Loss # will include the SRL number and indicator. 
For example, “0123456 SRL(Verified).” 
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4.3.12 Suggested Mitigation Options 

This report summarizes possible mitigation options for select properties as 
entered in the NT. For example, if the community or property owner has 
plans to mitigate the structure and is awaiting funding, it should be noted 
in the Flood Risk and Mitigation Possibilities/Possible Mitigation 
Measures section for it to appear in this report. 

4.4 Utilities 

The Utilities has three tabs: Import/Export Data, Database Maintenance, and 
Tools. With the Import/Export Data tab, you have option to import NFIP data 
(Section 4.4.2), export the Property Data Template spreadsheet, import property 
data (Section 4.4.3), or export the claims and flood events data (for use with 
FEMA’s Benefit Cost Analysis [BCA] program). The Database Maintenance tab 
has options to append properties (Section 4.4.4), merge properties (Section 4.4.5), 
review the Photo Gallery (Section 4.4.6), or create a subset NT database (Section 
4.4.7). Finally, the Tools tab (Section 4.4.8) has links to additional software 
programs and worksheets. Most of the options discussed here have a tutorial 
associated which provides step-by-step instructions. 
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4.4.1 Downloading NFIP Data  

Prior to field inspections, NFIP data for the structures of interest should be 
obtained from the appropriate FEMA Regional RL Coordinator in the 
form of a RL Data for National Tool, MS Excel file. The file contains 
records for RL structures with information on claims and, in some cases, 
previously captured mitigation information for the property. Regional RL 
Coordinators (see Appendix D) have the capability to access NFIP data 
and related systems to perform data queries. The Drill Down can be 
accessed via an Internet connection using NFIP Services, which requires 
login and password for direct access into the site. Only authorized state 
and Federal officials have access.  

Before beginning, make sure the Internet pop-up blocker is turned 
off. 

To access the system, go to  

http://nfipbureau.fema.gov  

o From the Main Screen, choose the SQANet link. 

o Click the Click here to login link. 

o Review the Privacy Statement Notice before choosing the 
Agree button. 

o In the pop-up window, enter the user name and password. 
Then click OK. 

o On the menu of links on the left-hand side under the 
Reports heading, select RL to open the sub-menu of reports 
to choose from.  

o In the sub-menu, select the report RL Data For National 
Tool. 

o Within the main area of the web page, select a state and 
select from three options for data results: Mitigated 
Properties Only, Unmitigated RL Properties Only, or 
Mitigated and Unmitigated RL Properties.  

  Next, select the Submit button to run the report. 

o After submitting this report, the main screen will be blank. 
At the top, select the far left button which is the “Export 
this report” button.  

http://nfipbureau.fema.gov
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o Next, an Information window appears about downloading 
the ActiveX file. Download this file. Unfortunately, you 
will need to repeat the previous steps again.  This may be 
corrected in the future.  

o After repeating the steps, an Export Report window will 
appear. Select the file format Microsoft Excel 97-2000 – 
Data Only (XLS). Then click OK. 

o When prompted, click Save and save the file to a folder 
with a name of your choice. Remember the folder and 
filename for importing the file into the NT later. 

 
A step-by-step tutorial on this process is available. Go to Help > Tutorials 
tab > Importing NFIP Data (which includes steps for accessing and 
downloading NFIP data). 

 
4.4.2 Importing NFIP Data 

This function allows data from NFIP to be uploaded to the NT and used to 
create new records or to update information in existing records.  
 
The NFIP database stores records of all NFIP claims and policies. NFIP 
data are used as a starting point to create records in the NT; when NFIP 
data are imported, new records will be created for each property included 
in the NFIP data that does not already have a record in the NT. Existing 
NT records that correspond to records in the NFIP data being imported 
will NOT have all NFIP-populated fields overridden each time there is an 
import; field data captured by the NT will remain intact. NFIP data 
includes the address and CID of the structure, insured and claimant 
information, data on claims paid, and information on mitigation measures 
taken that have been previously captured by FEMA. 

 
Tips 

• Delete any rows for properties that are not of interest.  

• Make sure the output file is saved as an MS Excel version 5.0 or 
higher. 

• The NFIP spreadsheet field Local Property Identifier is imported 
into the Local Lot/Parcel ID field (found in the Detailed View). 

To begin the import process: 

1. From the main menu of NT, select Utilities button to get to the 
Utilities Menu.  
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2. Under the Import/Export Data tab, select the Import repetitive loss 
properties from the downloaded NFIP spreadsheet button.   

 

3. Browse to and select the appropriate MS Excel file to import and 
click Open. A confirmation screen prompts you to make sure the 
correct file has been selected.  Select No or Cancel if you want to 
stop the import. Selecting Yes will start importing the properties 
right away.  

4. The Import NFIP Data Status window will open and show progress 
bars until the import process is complete. The window will also 
report the number of properties that were updated or added.   
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5. After the properties have been imported, selecting the Report button 
will bring to view four reports:  

1) Imported Properties from NFIP 
2) New Properties added to the Database during the NFIP Import  
3) Properties that were NOT Updated during the import 
4) Import Results (a summary of properties organized by CID) 
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Each of these reports may be printed by selecting Print… or saved as a 
PDF by selecting Create PDF.  

6. Press Close/Cancel to close the NFIP Import Data Status screen. Once 
you choose Close/Cancel, there is no way to re-enter the status 
window to obtain this status report. 

The imported NFIP data can be viewed from several of the screens in the 
NT, as shown in the “grayed out” boxes. The NFIP data cannot be 
modified. However, there are opportunities within the NT to provide 
updated or better information back to the NFIP that can be used to update 
NFIP data. If you find updated or more accurate data during field work 
and/or research that should be reported to the NFIP, check the appropriate 
update boxes on the Address and Updates tab in the Limited View and on 
the Claims tab of the Detailed View. Checked boxes will serve as markers 
that the existing information in NFIP may need to be updated with the new 
data. 

On the top tool bar under View, the Data Collection screen displays the 
NFIP date of download and the NFIP data as of date. You will also see the 
first site inspection record to be filled in with the inspector’s information 
after the first field inspection.   

The NT will create new records for each property listed in the NFIP data 
output file and update records already in the NT with this information. 
Therefore, the output file from NFIP should contain information for 
structures that need new records created or structures that need address, 
claim, and policy data updated. 

A step-by-step tutorial on this process is available. Go to Help > Tutorials 
tab > Importing NFIP Data. 

4.4.3 Importing Property Data 

This feature enables you to import additional property data, photographs 
and other NT data fields through an automated process. All fields that can 
be completed within the NT are importable using a Property Data 
Template (an MS Excel spreadsheet). The spreadsheet has three 
worksheets (Import Data, Claims, and Flood Events) with a column for 
each data field. Any errors during the import process are displayed in a 
report immediately following the import. The View Documentation link 
provides additional information about the importing property data 
procedure, possible errors and solutions. 
 
To begin using the spreadsheet: 

1. From the Main Menu, click the Utilities button. 
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2. In the Import Data tab, choose the Export the Property Data 
Template button. The spreadsheet automatically opens populated 
with the loaded Property Locator/Repetitive Loss Numbers and 
data field entries in their respective columns. Note the three 
different worksheets labeled in the tabs: Import Data, Claims, and 
Flood Events. 

 

 
 

3. For each property, populate a row starting in the column labeled 
Property Locator/Rep Loss Num.  

a. For repetitive loss structures, this should be the 7-digit 
Property Locator Number or Repetitive Loss Number.  

b. You do not need to enter any leading zeros; if the number 
entered is less than seven digits, preceding zeroes will 
automatically be added into the NT file to bring it to a total 
length of seven digits. For example, entering “56” will 
become “0000056.” 

c. For structures other than repetitive losses, the Property 
Locator/Rep Loss Num field should be populated with the 
6-digit CID followed by the street address (7 characters 
minimum, 50 characters maximum). For existing records, 
the Property Locator/Rep Loss Num must match exactly 
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with a record’s current Property Locator/Repetitive Loss 
Number in order for the data to be associated with that 
record. 

4. Complete as many of the columns as necessary in the three 
different worksheets. Some of the columns contain drop down 
lists. These lists reflect the same drop down items as presented in 
the NT. For example, the Address Updates - Incorrect Community 
column allows you to choose from Yes or No. For NT items with 
multiple fields to select, for example, the HVAC Machinery, there 
is a separate column for each item offered. 

5. The file itself is not automatically saved to your NFMDCT folder. 
To save the spreadsheet, chose File > Save or Save As. 

6. To import the spreadsheet, go to the Utilities menu in NT and 
select Import the Property Data Template.   

7. On the Import Data screen, enter your name, title/agency, and 
comments for importing data. This information is recorded every 
time there is a change to property data within the NT, including an 
import of property data.  

8. In the bottom part of the screen, browse to locate and select the 
spreadsheet, and then press Import to continue or Close to cancel. 

 
Tips  

• For troubleshooting and solutions, refer to Appendix B, Section 
B.3, Importing Property Data in to the NT. This documentation can 
also be found in the NT under Utilities > Import/Export Data tab 
and selecting the “View Documentation” link in the section called 
Property Data.   

• The Property Locator/Rep Loss Num column is required and must 
exist in the spreadsheet. The number itself does not have to contain 
the leading zeros. 

• Do NOT rename any of the column names. 

• You can delete or hide any columns that you won’t be importing. 

• If no date is entered for the inspection, claims, or flood events, the 
respective data will not be imported.  

• To increase the speed of the import (e.g., with data several 
thousand properties), you can delete any rows for those properties 
not being updated or delete those worksheets without data to 
update. 
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4.4.3.1  Including Images or Documents 
The Image / Documents Path column of the spreadsheet allows the 
multiple images or documents to be imported. For each image or 
document, the FULL directory path to the corresponding file must be 
included. For example, an image with the name “56_011005_01.jpg” 
located in the C:\program files\Images subfolder should have the 
following text entered in the field:   
 

C:\program files\Images\56_011005_01.jpg 
Tips 

• Do not include blank spaces in the filename. Either replace the 
spaces with an underscore (“_”) or removed the spaces in the file 
name completely to create a one-word filename before entering the 
path.  

• To import multiple files for the same property, the file names must 
be separated with a comma or a semicolon (i.e., 
c:/RL00001899_1.jpg, c:/RL00001899_2.jpg, etc.). Do not mix 
commas and semicolons as file separators in the same cell.  

• If multiple properties are to share the same image/document, enter 
the same document path and file name for each property in the 
spreadsheet. The image/document will only be moved once, but 
will be associated with all the properties it was assigned to. 
Likewise, the same principle applies for existing 
images/documents in the database. If you are importing an 
image/document that already exists for another property, the 
image/document itself will not be moved.  However, an association 
will be made between the property and the existing 
image/document and the image/document may be viewed in both 
property records. 

• To increase the speed of the import (e.g., with data for several 
thousand properties), you can delete any rows for those properties 
not being updated or delete those worksheets without data to 
update. 
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4.4.3.2 Including Latitude and Longitude 
Latitude and longitude are numeric fields that should be formatted as 
decimal degrees with up to three numbers left of the decimal [and a 
negative sign (“-”) when necessary], and six numbers to the right of the 
decimal (for example, “-123.123456”). All latitude measurements must be 
between -90 and 90 degrees and all longitude measurements must be 
within the -180 to 180 degree range. 
 
In our example that follows, we hid several columns (note how the top 
column headings move from A to AL). Any hidden or deleted columns 
will not be imported.  

 

 
 

Latitude and longitude readings can be collected by and downloaded from 
most handheld Global Positioning System (GPS) units. Location readings 
can be transcribed from the visual display on the unit for each location; 
however, downloading them directly into the computer may be preferred. 
Most GPS units on the market today come with computer attachment 
cables and software included or is available as an option. Once the GPS 
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data is transferred to the computer, the entire list of GPS readings can be 
managed systematically and the cut and paste tools can be used to 
minimize the errors associated with re-typing the numbers. 

 
Many other tools are also available for use in downloading GPS points to 
computers, some of which can be acquired for little or no cost. One 
example for Garmin® users is a program called DNRGarmin from the 
Minnesota Department of Natural Resources1 which imports and exports 
information between the GPS and the computer using formats compatible 
with Geographic Information Systems (GIS). Other products are available 
on the Internet that download data from other or, in some cases, many 
makers.  
 
In order to get the latitude/longitude readings from the handheld GPS into 
a format usable for import into the NT, some re-formatting may be 
necessary. To import the readings into the NT, latitude/longitude 
measurements must have only numeric characters, with the exception of a 
negative sign (“-”) for western longitude readings, or southern latitude 
readings. No directional letter symbols (N, S, E, W) should be included as 
part of the numbers. Additionally, the values must be in the decimal 
degree format, and latitude and longitude measurements should be stored 
in different fields and not combined as one piece of data. Examples of 
correct and incorrect formatting of a longitude reading are provided in the 
example below: 

 
 Decimal degrees:   -76.905791o    CORRECT 

 Degrees-Minutes-Seconds:  76o54’20.846” W    INCORRECT 

 Degrees-Minutes: 76o54.347’ W INCORRECT 
 

To convert degrees-minutes-seconds readings to decimal degrees, the 
following conversion formula is used, where DD.MM.SS.SSS represents 
the degrees-minutes-seconds format, and DD.DDDDDD represents the 
decimal degrees format. 

 
DD + [(MM+ SS.SSS/60)/60] = DD.DDDDDD 

 
Similarly, to convert degrees-decimal minutes readings to decimal 
degrees, the following conversion formula is used, where DD.MM.MMM 
equals the degrees-decimal minutes format, and DD.DDDDDD equals the 
decimal degrees format. 

 
 DD + (MM.MMM/60) = DD.DDDDDD 

                                                 
1 The program is available on-line at 
http://www.dnr.state.mn.us/mis/gis/tools/arcview/extensions/DNRGarmin/DNRGarmin.html 

http://www.dnr.state.mn.us/mis/gis/tools/arcview/extensions/DNRGarmin/DNRGarmin.html
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4.4.4 Appending Properties 

This feature is useful for attaching or adding properties from another 
database into the currently open database.  
 
To begin this process: 

1. From the Main Menu, click the Utilities button. 

2. In the Database Maintenance tab, choose the Append Properties 
from another NT database into this one button.   

 

 
 

3. A pop-up window will appear to confirm that a backup of the 
database you are currently working with has been made along with 
its associated NFMDCT folder. The append procedure cannot be 
undone, so it is important to create this backup copy.  

 

 
 

4. Next, the Append Data window opens. Click on the Browse button 
to select the database containing the records to be added. 
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5. Next there are two options to choose from: either append All 

Properties or only Selected Properties. 

a. Select the All properties option to read all the properties 
from the database you selected. Click Continue to get to the 
Append Options window. You must select one of each 
option before continuing. The options you select will 
depend upon whether there are existing properties in the 
database or not.  Move the mouse over each option to get 
more of a description.  When finished, click Append. 

 

 
 

b. If the Selected Properties option is chosen, an Append 
Criteria window appears. This window has three tabs: 
Address Fields; Claims, Insurance, Mitigation; and 
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Miscellaneous. When finished selecting specific fields 
criteria, click OK and you are returned to the Append Data 
window.  
 
After pressing Continue, the Append Options window 
displays. You must select one of each option before 
continuing. The options you select will depend upon 
whether there are existing properties in the database or not.  
Move the mouse over each option to get more of a 
description.  When finished, click Append. 
 
Note: If you need to re-enter the Append Criteria window 
before continuing with the append process, click on the 
Edit button next to the field Selected Properties. 
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6. After making your selections, the Confirm Append window will 
appear to show what options you chose. If all options are correct, 
click OK to begin the append process. Once the process is 
complete, the Append Status screen will display the progress of the 
append process. This screen will also show the number of images 
and documents updated. 
 

 
 

7. By selecting the Report button, you can view a list of the appended 
properties, existing properties in the database that were not 
updated, and any missing image/document files. You can print the 
report by selecting the printer icon.  However, once you close the 
screen, the report will no longer be available. Press Close when 
finished.  
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A step-by-step tutorial on this process is available. Go to Help > Tutorials 
tab > Appending Data into an Existing Database. 

 
4.4.5 Merging Properties 

Merging data from one property into another is useful in consolidating the 
information for duplicate properties to maintain consistency of the data 
entered. Any data entered for one property (“A”) can be merged into 
another (“B”) to either overwrite all of the existing values existing in 
property “B” or only add in data for value fields not filled in property “B.”  
However, you must merge from a property with a PL # higher into a 
property with a PL # that is lower. This is to ensure that the original NFIP 
data (usually associated with the property created earlier in time; hence, 
the property with the lower PL #) remains. 
 
Once the merge process is complete, property “A” can be deleted from the 
database to avoid confusion over which duplicate property is more 
“complete,” data wise. Be sure to check the “Duplicate Listing with 
Property Locator #” box and add the PL # from property “A.” 
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Only the data capable of being entered in NT can be merged. The NFIP 
data fields cannot be merged or changed. 
 

 

4.4.6 Photo Gallery 

The photo gallery is an alphabetical listing of all images in the NFMDCT 
folder and what properties they are assigned to. Within the gallery, you 
can assign, remove assignment and delete photos.  Double-clicking on the 
property number in the photo gallery will automatically take you to that 
property record, provided that the Limited or Detailed Views are open in 
NT.  
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4.4.7 Creating a Subset NT Database  

A subset database is a new NT database created from a master NT 
database that includes a subset of records from either the master NT 
database or another NT database.  Creating a subset database is useful if 
you need to provide specific property data to a community official or field 
inspector. For a community official, the subset database needed may 
contain only the properties in the official's community. Field inspectors 
may find it easier to work with a 
database that contains only the 
properties being inspecting during 
their site visit.  
 
 
The steps to create a subset database are nearly identical to the steps for 
appending a database (refer also to Section 4.4.4, Appending Properties):  

 

The NT database and the 
NFMDCT folder must remain 
together at all times. 
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1. Begin by creating a new folder to contain the subset database and 
its associated images and documents. Copy an empty version of 
the NT database and rename the NFMDCT_V3_empty.mdb file to 
something more recognizable for your purpose.   
 

2. Open the subset NT database. From the Main Menu, click on the 
Utilities button to get to the Utilities Menu. Click on the Database 
Maintenance tab, and then select Append Properties.  
 
A pop-up window will appear with a message to Backup Files 
Before Continuing. This is a warning to alert you to the fact that 
the append function cannot be undone.  You should backup the 
database and the associated NFMDCT folder anytime you have 
properties in the database that you are appending to. Since our 
database is empty, it is not necessary to back it up.  Press Yes to 
continue. 
 

3. In the Append Data window, Browse and select the master 
NFMDCT database that contains the properties you want in your 
subset database.   
 
a. To append all the properties from the master database, select 

All Properties. Click Continue to get to the Append Options 
window and select one of each option. You must select one of 
each option before continuing.  The options you select will 
depend upon whether there are existing properties in the 
database or not. Move the mouse over each option to get more 
of a description.  Since the database is empty, any of the 
options can be selected. When finished, click Append.  
 

b. To append specific properties from the master database, select 
Selected Properties. The Append Criteria window will appear. 
This window has three tabs to select specific fields to update: 
Address Fields; Claims, Insurance, Mitigation; and 
Miscellaneous. When finished, click OK and you are returned 
to the Append Data window. 

 
After pressing Continue, the Append Options window 
displays. You must select one of each option before continuing. 
 The options you select will depend upon whether there are 
existing properties in the database or not.  Move the mouse 
over each option to get more of a description.  When finished, 
click Append. 
 
Note: If you need to re-enter the Append Options window 
before continuing with the append process, click on the Edit 
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button next to the field Selected Properties in the Append Data 
window. 

 
4. Next, the Confirm Append pop-up window displays to confirm the 

file and options chosen. If all options are correct, press OK to start 
appending properties into the database.   
 
The Append Status screen displays the status of each step of the 
Append process. The Append process may take some time, 
depending on the number of properties, images and documents 
being appended. This screen will also show the number of images 
and documents updated. 
 
After the process is complete, a new NFMDCT folder is created 
within the folder that has the new subset database. 
 
By selecting the Report button, you can view a list of the 
properties that were appended into the database. You can print the 
report by selecting Print… or Create PDF.  However, once you 
close the screen, the report will no longer be available. Press Close 
when done. The database now contains all of the properties, their 
images and documents that you selected.  You can view them by 
going into the Limited or Detailed Views. 

 
Now that you’ve created and populated a subset database with your 
selected properties, you can copy it to a laptop, CD or another location of 
your choice. To move the subset database, make sure to move both the 
subset database and the NFMDCT folder. Alternative methods may be 
used to create a subset of records on another computer, but this is the 
preferred method. Refer to Section 4.4.4, Appending Properties, for 
further instructions. 
 
A step-by-step tutorial on this process is available. Go to Help > Tutorials 
tab > Creating a Subset NT Database. 

4.4.7.1  Updating the Master Database from a Subset Database 
After the field inspector’s version of the subset database has been updated, 
it is necessary to merge the field data back into the master database in 
order to keep it current.  This process is almost the same as creating the 
subset database for the field inspector. See also Section 4.4.4, Appending 
Properties. 

1. Move the field inspector’s database into its own folder, with a date 
(example: Alabama/From_Field/20070925). See also Appendix 
Section A.4, NT Folder Organization and Maintenance, for 
additional guidance. 
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2. Backup the master NT database. One way to do this is to create a 
compressed file, using a utility such as WinZip™, that contains the 
database (.mdb file) and the NFMDCT folder.  You may want to 
store your compressed files in a folder called “Backups.” If so, 
include the backup date in the name of the compressed file and 
move it to the Backups folder.  

3. To begin the process:  

a. From the Main Menu of the master database, click the 
Utilities button.  

b.  In the Database Maintenance tab, choose the Append 
Properties from another database into this one button.  

c. The pop-up window *Backup Files Before Continuing* 
will appear. Ensure that you have created a backup of the 
master database and click Yes. The append procedure 
cannot be undone, so it is important to create this backup 
copy. 

d. Next, the Append Data window opens. Click on the Browse 
button to select the database containing the records to be 
added to the master. You must also choose from one of two 
property options to update the master: All Properties or 
Selected Properties.  

1. If the All Properties option is chosen, click 
Continue to get to the Append Options window. 
You must select one of each option before 
continuing. The options you select will depend upon 
whether there are existing properties in the database 
or not.  Move the mouse over each option to get 
more of a description. When finished selecting your 
options, click Append.  

2. If the Selected Properties option is chosen, an 
Append Criteria window appears. This window has 
three tabs: Address Fields; Claims, Insurance, 
Mitigation; and Miscellaneous. When finished 
selecting specific fields criteria, click OK and you 
are returned to the Append Data window. 

After pressing Continue, the Append Options 
window displays. You must select one of each 
option before continuing. The options you select 
will depend upon whether there are existing 
properties in the database or not.  Move the mouse 
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over each option to get more of a description.  
When finished, click Append. 

 
Note: If you need to re-enter the Append Criteria 
window before continuing with the append process, 
click on the Edit button next to the field Selected 
Properties in the Append Data window. 

 
e. After making your selections, the Confirm Append window 

will appear to show what options you chose. If all options 
are correct, click OK to begin the append process. Once the 
process is complete, the Append Status screen will display 
the progress of the append process. This screen will also 
show the number of images and documents updated. 
 

f. By selecting the Report button, you can view a list of the 
appended properties, existing properties in the database that 
were not updated, and any missing image/document files. 
You can print the report by selecting the printer icon.  
However, once you close the screen, the report will no 
longer be available. Press Close when finished.  

4. The master database is now up-to-date and is ready for the next 
subset.  If two field inspectors have the same set of data in their 
respective subset, the Append process allows you to choose which 
set of properties are appended back into the master database.  This 
is done by using the Select Properties option on the Append screen 
and then selecting the criteria you desire (Inspection Date, 
Inspector’s Name, Updates Made checkbox as well as others).  

4.4.8 Tools 

• Repetitive Loss Property Viewer* (See Appendix A, Section A.3, 
Installing the Repetitive Loss Property (RLP) Viewer) 

• Selecting Appropriate Mitigation Measures for Floodprone Structures 
(FEMA 551)  

* You can move the location of this tool on your computer by clicking on 
the Change Program Location button. 

4.5 Help 

The Help button on either the Main Menu or top tool bar opens a separate Help 
Menu with five tabs:  
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• Documentation (support documents in PDF format2) 

1. 2004 FIRA 

2. AW-501 Instructions and Form 

3. Drop Down Menus 

4. Elevation Certificate Bulletin 

5. Field Work Data Collection Form 

6. Selecting Appropriate Mitigation Measures for Floodprone Structures 
(FEMA 551) 

7. SRL Regulations 

8. User’s Guide 
 

• Tutorials: MS PowerPoint Slide Shows provide a step-by-step look at 
performing these functions. 

1. Importing NFIP Data (includes accessing and downloading NFIP data) 

2. Creating a Subset Database 

3. Appending Data into an Existing Database 

4. Maintaining a Master Database 
 

• Tools 

1. Repetitive Loss Property Viewer* (See Appendix A, Section A.3, 
Installing the Repetitive Loss Property (RLP) Viewer) 

2. Selecting Appropriate Mitigation Measures for Floodprone Structures 
(FEMA 551) 

* You can move the location of this tool on your computer by clicking on 
the Change Program Location button. 

 
• Helpful Links 

1. AW-501 Forms 

2. FEMA 551 

3. FEMA Home page 

4. FEMA Library  

5. FEMA Map Service Center 

6. National Flood Insurance Program 

                                                 
2 Note that Adobe Reader 7.0 has a known bug where it will not display PDF documents when they are 
linked from a Microsoft Office document such as an Access database. You will need Adobe Reader 6.0 to 
use the links to the PDF documents.  
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7. NFIP Flood Insurance Manual 

8. NFIP Services 

9. Mitigation Best Practices Portfolio 

10. HMA Grant Programs 

 
• About this Database: Information about the database, including name of 

the database file, application path, location of images and documents, 
database location on the PC, and the versions of the NT and MS Access. 
 

 

4.6 Exit Application 

The Exit Application feature closes the NT and exits out of Microsoft Access.  
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5. Data Gathering 

Specific property information that is not imported from the NFIP should be 
obtained during the field inspection, from the FIS, local officials, and other 
sources. Coordination with the community prior to field deployment is 
imperative, particularly when detailed data are being collected for a structure.   
 
Prior to conducting the field inspection visit, contact the appropriate local official 
to inform them of the planned field work and to obtain any additional information. 
Depending on the size of the community, there may be more than one official or 
agency where important information may be obtained. The following section 
highlights the offices or agencies within a community that may have relevant 
information. 

5.1 Community Contacts 

There are several community agencies that may have relevant information needed 
for a complete data collection effort. They include the Engineering or Public 
Works Department, Building Official or Code Enforcement Department, and the 
Tax Assessor’s Office. Following is a list of information that may be collected 
from each of these community agencies:  

 
Engineering or Public Works Department 

• Historical Flooding 

o Dates 

o Recurrence interval with documentation 

o Extent of damage within community 

• Flood Protection Projects 

o Pending or completed 

o Description and agency ownership 

o Level of protection provided (recurrence interval) 

o Date (or anticipated date) of completion 

o Flood events since project completed 
 

Building Official/Department 

• Permit Records 

o Structure and site elevation information 

o Post-flood repairs, including amount and type of damage 
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o Mitigation projects 

• Regulations 

o Floodplain ordinance (higher regulatory standards such as 
freeboard) 

o Height restrictions 

o Compensatory storage 

Tax Assessor’s Office 

• Tax ID and parcel number 

• Assessed value of structure and lot 

• Estimated market value of structure and lot (if available) 

5.2 Field Data Collection 

During the field data collection process, there is a possibility of meeting property 
owners or neighbors interested in the purpose of the field work. It is mandatory 
for field crews to carry proper identification at all times. If “windshield” type 
surveys are being conducted, prior notification of owners may not be necessary.  
 
Appendix F – Site Data Collection Notification and/or Explanation Letters 
contains a sample letter which can be modified to notify property 
owners/occupants and state or local officials. A second letter is also included that 
should be carried by FEMA employees or FEMA contractors during field work to 
alleviate any concerns from interested parties, such as property owners who may 
have questions about the data collection efforts. A third letter is included in the 
appendix as a sample for local official use. This letter can be modified as 
necessary and either mailed to property owners prior to field work, or used by 
community employees or contractors during site inspection. 
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6. Data Collection with the NT 

The NT categorizes most data according to whether it falls in the Limited View or 
the Detailed View. In addition to recording information for existing records 
within these views, new records can also be created both views.  
 
At the bottom of both views are additional “shortcut” search buttons: 

• Go to PL# 

• Go to Record # 

• Find Properties 

• Show All Properties 

• Go to Detailed View (or Go to Limited View)  

• Save 

• Close 
 

Use the arrow keys on the bottom left of the NT screen to move either from one 
record to another or to the first or last record.   
 
Tips 

• Your keyboard’s Page Up and Page Down keys can be used to move to the 
previous and next records, respectively. The Home key can be used to 
access the first record, and the End key can be used to access the last 
record.  

 
 

• To access an existing data record or create a new one, first choose either 
the Limited or Detailed View option from the Main Menu screen. Once in 
the desired view, you can access functions via the top tool bar. 
 

• The Go to Detailed View button changes over to Go to Limited View, and 
vice versa, depending on which view you are currently in. 
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6.1 Top Tool Bar Functions 

There are five options along the top tool bar: File, View, Reports, Tools, and 
Help. Under four of the options are drop down menus with several options.   

 

 
 

6.1.1 File 

There are five functions available under the File 
menu: Find, New, Save, Delete, and Close. Below the 
Close function, the 10 most recent properties worked 
on will be shown and available for quick return. (For 
brevity, only the last five properties are shown here at 
right.) 

 
Find - The Find function is used to retrieve existing 
records that meet certain criteria. The Find window 
has three tabs: Address Fields; Claims, Insurance, 
Mitigation; and Miscellaneous. This search is 
performed on NFIP data that has been uploaded to the 
database. 
 
After entering your specific search criteria, click Find or press Enter to 
open all the records matching the criteria. Clicking the Show All 
Properties button removes the search criteria chosen and returns you the 
entire set of records within the NT database. 
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New – The New selection creates a new property record. Generally, new 
records that are not RLs will be created within the Limited View. Records 
for RL properties should be created by importing NFIP information 
(including claims and insurance information) using the Import NFIP data 
function (refer to Section 4.4.2, Importing NFIP Data).  

1. After selecting the New function, the Data Collection 
window opens. The fields Date of Download and NFIP 
Data as of Date correspond to NFIP data that have been 
imported and will be automatically populated during an 
import; they cannot be manually entered or edited in NT. 
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2. Complete the Inspection Date, Inspector, and Title/Agency fields in 
order to create the record. The Site Inspection box is checked 
automatically for new records; with subsequent updates, this box 
can be unchecked. At this point, completing the Comments section 
is not essential. 

3. After the information is entered and Save/Continue is selected, an 
Add New Record window will appear to assign a Property 
Locator/Rep Loss# to the record.  

For non-RL properties, the convention for this naming includes 
the six-digit CID followed by the street address not to exceed 50 
characters total. For example, in the City of Hopkinsville, 
Kentucky, where the CID is 210055, the Property Locator number 
for 333 Main Street would be “210055 333 Main St.” There should 
be no apostrophes or quotes used in the Property Locator number.  
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Records for RL properties should be created through the Import 
NFIP Data function (see also Section 4.4.2, Importing NFIP Data).  

4. After assigning a Property Locator number and clicking OK, a new 
blank record will be available. If a Property Locator number of 
more than 50 characters is chosen, there will be an error message.  

 
Save – Selecting the Save function (either from the top tool bar or at the 
bottom right of the screen) will cause the Data Collection window to 
appear. Each time changes are made to a record, the Data Collection 
window appears to keep track of the history of changes. Within this 
window you will be required to complete the name of the inspector (first 
and last name), the title or agency of the inspector, and comments stating 
the reason for the change, if necessary.  
 
If you enter additional data for a property and attempt to move to another 
record (or between views) without saving, a Close window will appear to 
confirm whether or not you would like to save the changes: 
 

 
 
Selecting Yes will prompt the Data Collection window to appear, and you 
will be required to complete the information requested. Selecting No will 
return you to the database screen for the property without saving any 
changes. However, in order to retain any changes and move to another 
record, you will need to complete the Data Collection window fields. 
 
Delete – This function is used to delete individual records and must be 
used when the record to be deleted is open. After choosing delete, a 
window will open to confirm the deletion of the record. 
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Close – This will close all of the records and return to the Main Menu. If 
data have been edited but not saved, choosing Close will prompt a window 
asking if you want to save changes. If Yes is selected, the Data Collection 
window will appear, and you will be required to complete the information 
requested. 

6.1.2 View 

There are eight options under the drop down menu for View: Data 
Collection; Detailed View; Documents; Images; Insurance/Claim 
Information; Owner, Occupant and Neighbor Information; Photo Gallery; 
and FEMA Regions.  
 

 
 

Data Collection – This feature opens a window to view and/or update 
information regarding the Inspection Date, Site Inspection box, Inspector, 
Title/Agency of the inspector, and any Comments. The Site Inspection box 
is checked automatically; it can be unchecked if no site inspection 
occurred. 
 
With multiple inspection entries, you can click on any entry to view the 
full inspection record. The Site Inspection checkbox is the only field that 
can be changed. This is especially useful in reviewing the Comments 
section, which only shows the abbreviated text in the main field.  
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Detailed View – This feature changes the screens to the Detailed View. 
Once in the Detailed View, the drop down option automatically changes to 
Limited View. You can also switch between views by clicking on the Go 
to Detailed (or Limited) View button at the bottom of the database screen. 
 
Documents – The Documents feature provides an interface for loading and 
viewing documentation attached to individual records. Such 
documentation might include a copy of an Elevation Certificate, a 
FIRMette with the property location marked, or information about pending 
mitigation projects (project description, cost estimate, etc.).  
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To insert a document: 

1. With the Documents window open, click Load.  

2. Browse to the desired file, and select it.  
 

To view an attached document: 

1. Select it from the Loaded Documents list 

2. Choose View.  
 

Similarly, selecting a file name and clicking Delete will delete the file. 
 
Tips  
 

• Do not include commas, semi-colons, or blank spaces in the file 
names. Either replace these items with an underscore (“_”) or a 
hyphen (“-”). 
 

• To load more than one document at a time, hold down the CTRL 
key as you select the documents.  

 
Images – The Images feature 
provides an interface for 
loading and viewing images to 
attach to an individual record. 
The Load Images window 
displays a thumbnail of the 
image, and the Load Images 
window can display up to six 
thumbnails at a time.  
 
Once a file has been loaded, it 
can be set as the main image or 
deleted by right clicking on it 
(by default, the main image 
will be the first image loaded 
and displayed on the basic 
report generated).  
 
If the View thumbnail image box is checked and the Load Images window 
is closed, the main image will appear as a thumbnail in the upper right 
portion of the Limited View. This thumbnail can be dragged to different 
locations on the database screen. It will also remain in place when 
switching between Limited and Detailed Views until the View thumbnail 
image box is unchecked. Also, a full-sized version of the image can be 
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displayed by clicking on the thumbnail. It will remain in place even if you 
move to another the record within the database. The window can be closed 
by selecting exit (the “X” in the upper right corner). 
 
To insert an image in the Load Images window: 

1. Click Load 

2. Browse to the desired image file from the Locate Files window 

3. Click OK  
 
Tips  
 

• Do not include commas, semi-colons, or blank spaces in the file 
names. Either replace these items with an underscore (“_”) or a 
dash (“-”). 
 

• To load more than one image at a time, hold down the CTRL key 
as you select the images.  

Insurance/Claim Information – This feature provides information on the 
insurance policy and allows you to enter additional information as well. 
The Insurance section indicates whether the structure is insured, whether 
it is insured as either pre- or post-FIRM, the current insured’s name, the 
zone it’s insured in, and the occupancy type. All of this insurance 
information comes from the NFIP download. Additional fields where you 
can enter information are unshaded and include the insurance company 
number, policy number, and the premium paid. The Claims section shows 
information from NFIP and includes the Name of Last Claimant, the Total 
Number of Claims per NFIP, the Date of Last Claim, the Estimated 
Building Value, and Total Payments Made for the property (both building 
and contents).  

The bottom text note states that for the Total number of claims per NFIP, 
the NFIP Bureau and Statistical Agent should count claims paid within 10 
days of each other as one claim. Claims with identical dates are also 
displayed as one claim with all payments combined. Claims within 10 
days of each other, but on separate dates, are displayed as separate claims 
(see Claims tab in the Detailed View) but only counted once under total 
number of claims per NFIP. 

 



National Flood Mitigation Data Collection Tool and RLP Viewer  Data Collection with the NT 
 

User’s Guide 6-10 August 2008 
 

 
 
Owner, Occupant and Neighbor 
Information – Fields in this window 
should be completed if there was 
communication with the owner, 
occupant, or a neighbor as part of the 
data collection efforts. Dates of 
contact, names, and phone numbers 
should be entered. Additionally, if the 
owner was contacted, indicate whether 
or not the owner expressed an interest 
in mitigating the structure. 
 
Photo Gallery – The photo gallery is an 
alphabetical listing of all images in the NFMDCT folder and what 
properties they are assigned to. Within the gallery, you can assign, remove 
assignment and delete photos.  Double-clicking on the property number in 
the photo gallery will automatically take you to that property record, 
provided that the Limited or Detailed Views are open in NT.  
 
FEMA Regions – This window displays a list of states and U.S. territories 
within each FEMA Region. 

6.1.3 Reports 

The Reports drop down menu gives you access to specific reports that can 
be generated. For more information on each of the reports available, see 
Section 4.3, Reports. 

6.1.4 Tools 

The Tools drop down menu gives you access to specific tools available. 
• Export Property Data Template 
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• Export Claims and Flood Events (for use with FEMA’s Benefit Cost 
Analysis [BCA] program) 

• Merge Properties (see also Section 4.4.5, Merging Properties) 

6.1.5 Help 

The Help menu provides access to useful reference documents in five tabs: 
Documentation, Tutorials, Tools, Helpful Links, and About this Database. 
Refer to Section 4.5, Help, for more detailed information regarding these 
tabs and options provided. 

6.2 Limited View 

Within the data collection portion of the NT, there are three tabs for data entry 
under the Limited View: Address and Updates, Site Observations, and Flood Risk 
and Mitigation Possibilities. 

6.2.1 Address and Updates Tab 

6.2.1.1 NFIP Address 

The NFIP Address section is populated by importing information from the NFIP 
data import and represents the address information currently associated with the 
property. The NFIP Data as of field is the date which the data was downloaded. If 
the address has been modified from an earlier listing, the previous address will 
also be imported and can be viewed by pressing the Previous Address button on 
the top right of the screen. All of the information imported from NFIP is for 
reference only and cannot be edited; thus, these fields are “grayed out.” 

6.2.1.2 Address Updates 

The Address Updates section allows you to update data from the NFIP import 
process as necessary to facilitate easier searches for records within the NT. 
Additionally, if there are cosmetic errors with the address from NFIP or if the RL 
record is currently assigned to the wrong community, the address information 
may be corrected in this section. Also, completing fields such as the Directional 
(e.g., N, S, E, W) and St Type (structure type) fields can further distinguish the 
property. If updated data are provided, select the Incorrect Community and/or 
Address box. There is also a Notes button that will open a pop-up window to enter 
more information about the property location or directions to the property.  If 
notes exist, hovering the cursor over the Notes button will display a preview of 
the text within. 
 
The Address Updates section is the first section in NT which has datasheet view 
icons present, allowing you to see the data contained in the particular section for 
all of the currently selected records within a datasheet view. This allows you to 
change the same piece of information for multiple records at the same time or to 



National Flood Mitigation Data Collection Tool and RLP Viewer  Data Collection with the NT 
 

User’s Guide 6-12 August 2008 
 

If any entries in the Mitigation 
Updates Field boxes in the 
Limited View are checked, the 
Updates Made box will 
automatically be checked when 
the property is saved.  The NT 
system will also check these 
mitigation action fields to 
ensure they have been 
appropriately entered. 

compare data between different structures. Also, information from these views 
can be exported into MS Excel format for more detailed analysis.  
 
 

 
 
 
 
 

 
 

6.2.1.3 Mitigation Updates 

Four mitigation categories are listed on the 
left half of this section. Adjacent to the right 
of the categories (Unable to Locate 
Property, Flood Protection Provided, No 
Building On Property, and Historic 
Building) are two columns of boxes with 
“FEMA” as the header. The data found in 
these columns are populated from the NFIP 

Datasheet 
View icon 

Datasheet 
View icon 
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Data import and are “grayed out” boxes, representing NFIP information that 
cannot be manipulated once the NFIP data have been uploaded. You can update 
the two columns by checking the boxes with the Field header where appropriate 
based on field observations and the data collected.  
 
You must assess whether or not any of the four mitigation categories apply to the 
structure and if the corresponding FEMA data are accurate. Coordination with 
state or local officials may be necessary to obtain documentation required to 
support the findings. The boxes across the four “mitigated” categories correspond 
to the data in NFIP that FEMA has on record for the structure. The four numbered 
boxes correspond to codes for different mitigation actions and mitigation funding 
sources. These mitigation action and funding source codes can also be found on 
the NFIP Repetitive Loss Update Worksheet (AW-501). A sample AW-501 form 
is provided in Appendix G or by going to Help > Documentation > 2. AW-501 
Instructions and Form. Boxes 1 and 2 list the mitigation action codes and boxes 3 
and 4 list the primary and secondary mitigation funding codes, respectively. 
Boxes 1 and 2 are lined up with the “mitigated” categories to which the action 
codes apply – Flood Protection Provided and No Building On Property, 
respectively. Following is a description on completing this section.  

 

 
 

• Unable to Locate Property – If the corresponding FEMA box is marked with 
an “X,” the NFIP data indicate this structure could not be located. If during 
the field visit the structure cannot be located, check the corresponding box. 
Also, open the Notes window to identify the steps taken to locate the property 
and identify the nature of the address deficiency. 

• Flood Protection Provided – If some sort of retrofitting measure has been 
completed to protect the property from flood damage, check this box. 
Otherwise, the box should remain unchecked.  

o If you check this box, choose from mitigation action codes “a” through 
“f” from the drop down menu labeled Box 1, corresponding to the type 
of protection provided (elevation, floodproofing, stormwater 
management, flood control project). 

o Next, boxes 3 and 4 should be used to indicate the primary source of 
mitigation funding and the secondary source of any known additional 
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funding, respectively. If either of these boxes is completed, the Flood 
Protection Provided value must be marked in either the Field or 
FEMA boxes. The rational being that funding cannot be provided to a 
non-existent mitigation project. 

If no value is needed in box 4, select “y” for unknown. 
 

• No Building On Property 

o If this box is checked, choose from mitigation action codes “g” 
through “i” from the pull down menu labeled Box 2, detailing whether 
the building was acquired and/or demolished or relocated. 

• Next, boxes 3 and 4 should be used to indicate the primary source of 
mitigation funding and the secondary source of any known additional 
funding, respectively. If either of these boxes is completed, the No 
Building On Property value must be marked in either the Field or 
FEMA boxes. The rational being that funding cannot be provided to a 
non-existent mitigation project. 

If no value is needed in box 4, select “y” for unknown. 
 
• Historic Building – If the FEMA box is marked, the structure has been 

determined to be a historic structure either listed on the National Register of 
Historic Properties or on a similar State register. If during the field visit it is 
determined that the structure is listed on the National Register or a State 
Register, the Field box should be checked. Structures eligible for the 
National Register or a State Register also qualify for special consideration by 
the NFIP. If a structure seems potentially eligible for inclusion on one of 
these registers, this should be noted in the Notes section. 

 
Note: A Historic Building is not an equivalent designation to buildings that 
are within a Historic District. An individual historic property or structure 
derives its significance from being associated with important historical 
events, persons, or a distinctive architectural style, in comparison to a 
district, which derives its importance from being a unified entity, even 
though it is often composed of a wide variety of resources. The identity of a 
district results from the interrelationship of its resources, which can convey a 
visual sense of the overall historic environment or can be an arrangement of 
historically or functionally related properties. For example, a district can also 
encompass several interrelated activities, such as industrial, residential, or 
commercial buildings or could contain buildings, structures, sites, objects, or 
open spaces that do not contribute to its historic significance. 

 
In the example below, the property has been mitigated via a flood protection 
measure, according to NFIP records. The “A” in Box 1 indicates that the structure 
was elevated to or above the BFE, and the “J” in Box 3 notes that the Hazard 
Mitigation Grant Program (HMGP) served as the primary funding source. As 
previously mentioned, these codes are defined in the drop downs under the field 
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boxes and correspond to the codes found on the second page of the AW-501 form 
(Appendix G) or, within NT, going to Help > Documentation > 2. AW-501 
Instructions and Form. 

 

 
 

If a record needs to be tagged for additional research, the Additional Research 
Needed box should be checked. Other information pertaining to the items for 
further investigation can also be included in the Notes section.  
 
Under the Mitigation Observed drop down menu, you can populate the NT with 
apparent mitigation measures observed on-site not yet part of the NFIP record. 
The measures included under the drop down box are as follows: 

• Structure appears to have been elevated 

• Structure appears to have been floodproofed 

• There is a floodwall, berm, or other type of barrier 

• Lower area subject to damage appears to have been modified 

• Drainage improvements appear to have been made 

• Flood control project should have reduced the threat 

• Owner/neighbor/local official report mitigation actions taken 

• Further Research Required 

• Other (explain in notes) 
 

If the mitigation listed from the NFIP download has been observed in the field, 
the Mitigation Verified drop down box can record this verification. 

 
In the Duplicate Listing / with Property Locator # field, check the box if the 
property is a duplicate listing and note the Repetitive Loss/Property Locator 
number of the other repetitive loss listing(s). 
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Tip  
• To keep the number of duplicate listings within a database under 

control or to maintain consistency of the additional information added 
for several duplicates, you can use the merge properties function. 
Refer to Section 4.4.5, Merging Properties. 

 
If changes or updates are recorded in the Mitigation Updates section (including 
checked mitigation type boxes, and mitigation codes or funding sources) or the 
property is a duplicate listing, check the Updates Made box. 
 
Check the Updates Made box if any additional information is added to the other 
sections. This box will indicate whether updates should be made within the NFIP 
system. Additionally, if any entries in the Mitigation Updates Field boxes in the 
Limited View are checked, the Updates Made box will automatically be checked 
when the property is saved.   

6.2.2  Site Observations Tab 

This screen contains several sections that should be completed during the field 
inspection. Note that a datasheet view is available for this section. 
 
The small, blue and white “551” symbol (e.g., next to No. of Stories field) 
indicates that the specific field must be completed in order to generate the FEMA 
551 report, that is, to aid in  completing Worksheet A (Technical Considerations 
Scorecard) and Worksheet B (Appropriate Mitigation Measures). Both of these 
worksheets are used with the information packet while working with a property 
owner.  



National Flood Mitigation Data Collection Tool and RLP Viewer  Data Collection with the NT 
 

User’s Guide 6-17 August 2008 
 

 

6.2.2.1 Site 

The following data should be entered in this section based on a site visit: 

• Inspection Date – mm/dd/yyyy format 

• Inspector – First and last name 

• Latitude and Longitude coordinates – These figures (formatted as decimal 
degrees and six figures to the right of the decimal) should be obtained in 
the field using GPS equipment such as a handheld GPS unit. Accuracy 
within 20 meters (approximately 65 feet) is required for FEMA grant 
applications. The accuracy of the GPS unit should be checked, and the 
reading taken at the corner of the structure with the lowest adjacent 
grade whenever possible. If the grade is uniform, the reading should be 
taken at the corner of the structure closest to the flood source. 

See also Section 4.4.3.1, Including Latitude and Longitude, for additional 
guidance on obtaining and notating Latitude and Longitude coordinates. 

• No. of Stories* – The number of stories in a building may be determined 
from a field visit or from building records. A story is defined as a 
complete above grade section of a building having one continuous or 
approximately continuous floor. Generally, this does not include attics or 
basements (sub-grade or partially sub-grade).  
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*This field must be completed to generate the FEMA 551 report. 

• Basement – Check this box if there is a basement as defined by the NFIP. 
A basement is defined as any area of a building with a floor that is below 
ground level on all sides. 

• Occupied – The structure’s occupancy status should be indicated using the 
following selections: Yes, No, or Seasonal. 

• Residence – If it is known, indicate whether the building is a Primary, 
Rental, or Secondary residence.  

• Fill – If there is fill, the height should be indicated. This option has a drop 
down menu with choices from below street grade to greater than 4 feet. 

• Land Use – The structure’s appropriate land use should be indicated from 
the following list of 13 uses: single-family residential; 2-to-4 family 
residential; multi-family residential (5 or more units); commercial 
(highway, office, retail, downtown); industrial (light, heavy); institutional 
(hospitals, churches); educational (schools, colleges); non-profit; public; 
semi-public; transportation; open space; and other (explain in notes). 

• Spoke with – Check the appropriate box to indicate whether you (or the 
inspector) spoke with the Owner/Occupant or Neighbor, if applicable. 
Upon checking one of these boxes, the Owner, Occupant, and Neighbor 
Information window will open if further details should be added, including 
pertinent details about the communication.  

• Neighborhood – Information on the neighborhood surrounding the 
property should be provided by making the appropriate selection from the 
following:  

o Commercial highway 

o Commercial office 

o Commercial retail/downtown 

o Heavy industrial 

o Light industrial 

o Residential – high density (multi-family/apartments) 

o Residential – low density (single-family) 

o Residential – medium density (2-family/townhouses, rowhouses) 

o Rural residential 
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• Elevated – Indicate the structure’s lowest floor elevation above grade, if 
applicable. A drop down menu provides selections ranging from Not 
Applicable to greater than 12 feet. 

• Adequate Vents Present – Choose Yes, No, N/A (Not Applicable), or 
Undetermined to best indicate if vents are present that meet the 
community’s floodplain management requirements. For post-FIRM 
structures with enclosures below the BFE, this means at least two 
openings having a net area at least 1-square inch for every square foot of 
enclosed space are situated on different walls of the enclosure, so that their 
bottom edges are no higher than 1 foot above grade. Additional minimum 
NFIP requirements for vents can be found in the Code of Federal 
Regulations [44 CFR §60.3(c)(5)]. If the structure is pre-FIRM, not in a 
Special Flood Hazard Area (SFHA), or without enclosures below the BFE, 
select N/A. 

• Flooding this site will have community-wide implications – A check in 
this box indicates that the building has either an essential public function, 
contains a special population, or has hazardous material storage on-site. If 
this box is checked, then one of the following options should be selected 
from the drop down menu:  

o Important for flood warning/response (e.g., lumber supplies 
company) 

o Important for disaster recovery  

o Important for public health (e.g., wastewater treatment plant) 

o Contains hazardous materials 

o Contains special population (e.g., nursing home) 

o Important utility service 

o Other (explain in notes) 

• Structure Type* – This is indicative of the major type of materials used to 
construct the structure and the degree of engineering involved in its 
design. General categories should be selected if further details are 
unknown (i.e., wood frame versus engineered wood frame, or steel versus 
heavy steel). Consultation with the local building official is highly 
recommended. The NT provides a selection of common structure types 
and includes a choice for Other and a Notes section if the inspector 
encounters a construction type not listed. 
 
*This field must be completed to generate the FEMA 551 report. 
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• Condition of Structure* – These data are based on the level of repair 
required. Consultation with the local building official is highly 
recommended. 

o Good (optional minor repair) – Select this option when only 
cosmetic type repairs are needed  

o Fair (needs minor repair) – Select this option when the following 
characteristics are observed: 
• Minor shrinkage cracks due to thermal expansion and 

contraction 
• Signs of rust on iron or steel members 
• Signs of corrosion of rebar 

o Poor (needs significant repair) – Select this option when the 
following types of damage are observed: 
• Bowed brick veneer wall or parapet walls 
• Leaning of wall 
• Cracking of wall due to excessive settlement 
• Building settlement  
• Large cracking around sills, eaves, chimneys, parapets, and 

iron or steel lintels  
• Differential settlement of chimney 
• Fungal and insect attack of wood  
• Exposed rebar in concrete walls due to corrosion 
• Fire damage 

 
*This field must be completed to generate the FEMA 551 report. 
 

• Foundation Type* – The selection of a foundation type may require a 
close inspection of the structure. Consultation with the local building 
official is highly recommended. The NT provides a selection of common 
foundation types and includes a choice for Other and a Notes section 
should you encounter a foundation type not listed. 

 
*This field must be completed to generate the FEMA 551 report. 

 
• Condition of Foundation* – This is based on the level of repairs needed. 

Consultation with the local building official is highly recommended. 
o Good (optional minor repair) – Select this option when only 

cosmetic type repairs are needed  
o Fair (needs minor repair) – Select this option when one or more of 

the following is observed: 
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• Minor shrinkage cracks in foundation pier 
• Soil shrinkage due to nearby trees or plants 
• Cracks associated with thermal expansion and contraction 

o Poor (needs significant repair) – A foundation is considered to be 
in poor condition if one or more of the following conditions exist: 
• Movement of foundation  
• Soil erosion around foundation 
• Settlement or rotation of pier footing 
• Cracking in foundation wall due to movement 
• Deterioration of pier like vertical cracking or bulging. 
• Fire damage 

o Needs further investigation 
*This field must be completed to generate the FEMA 551 report. 

 
• EC Diagram No. – This refers to the type of structure and foundation as it 

corresponds to one of eight diagrams included as part of the FEMA 
Elevation Certificate (EC) (FEMA Form 81-31) on pages 6 through 7 of 
the EC Instructions. The option Unable to Determine is also available. 
 
The diagrams from the FEMA Elevation Certificate are attached to this tab 
for reference. Select the button labeled Building Diagrams to see 
representations of each type of building. 

6.2.2.2 Appurtenant Structures  

Appropriate boxes should be checked for appurtenant/accessory structures located 
on site such as a Carport, Deck, Detached Garage, Shed, Other, or None 
Observed. Any additional comments can be provided in the Notes section. 

6.2.2.3 HVAC 

Information about the location of the Heating, Ventilation, and Cooling (HVAC) 
is collected in this section. All locations of HVAC machinery and ductwork 
should be identified (crawlspace, inside, or outside) and multiple selections can be 
highlighted. Others that are not included in the list may be explained in the 
corresponding Notes section. 

6.2.3 Flood Risk and Mitigation Possibilities Tab 

This section includes information such as current FIRM data, flooding sources, 
likely areas of flood damage, potential hydraulic impacts, and mitigation 
observations. The information for this tab is found through study of the FIRMs, 
and through an assessment of the site performed in the field. 
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6.2.3.1 Current FIRM Data 

A datasheet view is available for this section, which contains information that is  
obtained from the FIRM, such as the FIRM Index Date, Flood Zone (A, AE A1-
30, AH, AO, AR, A99, B/XShaded, C/XUnshaded, D, V, and VE V1-30) Vertical 
Datum, FIRM Panel # and Date, and BFE/ Depth (AO and AH zones).  
The NFIP Community Status Book (available online at 
http://www.FEMA.gov/fema/csb.shtm) can be used to identify the date of the 
current FIRM Index to be used when locating the structure on its appropriate 
FIRM panel. On the panel, it is the date listed under the Current Effective Map 
column. 
 
A vertical datum type should be entered for the BFE. It will generally be NGVD 
29 (National Geodetic Vertical Datum of 1929) or NAVD 88 (North American 
Vertical Datum of 1988). In some instances, a locally applicable vertical datum 
may be used. If the BFE and building elevation are provided in different vertical 
datum, it will be necessary to obtain the conversion information (probably from a 
local source) and enter the conversion formula in the notes section. Information 
on the FIRM Index Date, Flood Zone, Vertical Datum, Panel # and Date, and 
BFE/Depth is obtained from the FIRM. 
 
The Likely Source of Flooding should be determined during the field visit with 
assistance from the FIRM or other map as necessary. The appropriate source from 
the drop down menu (e.g., riverine flooding, coastal flooding, sheet flow, etc.) 
should be selected. 

http://www.FEMA.gov/fema/csb.shtm


National Flood Mitigation Data Collection Tool and RLP Viewer  Data Collection with the NT 
 

User’s Guide 6-23 August 2008 
 

 

 
 

For the Likely Areas of Flood Damage, an option from the drop down should be 
selected to identify the likely areas of flood damage (water over or below first 
floor, water in areas below grade, etc.). This information may be obtained from a 
site visit and/or talking with the property owner or neighbor. 

 

 
 

The Potential Hydraulics Impacts section provides a list of potential structures 
and infrastructure that might affect the frequency and/or severity of flooding in 
the area. Multiple items may be selected by pressing the Control or Shift on the 
keyboard. A wide range of projects includes, for example, bridges, levees, and 

http://www.FEMA.gov/fema/csb.shtm
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storm drain systems. For the planned projects and other selections, a Notes area is 
provided to describe impacts that are not listed. 

6.2.3.2 Mitigation Observations 

This section allows you to input information 
regarding pending mitigation projects. It also 
provides you an opportunity to analyze the 
results of the data collected and provide any 
comments on possible appropriate mitigation 
actions. Use your knowledge and experience 
to assess the situation and suggest feasible 
measures that might be cost-effective. The 
View button enables access to the list of 
Possible Mitigation Measures window. Notes 
buttons under each of the three subsections of 
the Possible Mitigation Measures window are 
included for the input of additional 
information. 
 
Adequate Clearance – Check this box if the structure is clear by at least 20 feet on 
each side to allow for equipment and construction on site. This clearance may be 
necessary for constructing mitigation projects, such as structure elevation, on the 
site.  

6.3 Detailed View 
The Detailed View is applicable and suitable when a more thorough inspection of 
the property and its surroundings is conducted, and when contact with local or 
state officials is made to gather structure-specific information and coordinate on-
site data collection efforts. There are four tabs within the Detailed View: 
Additional Site Information, Elevation and Hazard, Claims, and Events and Total 
Damages. 

6.3.1 Additional Site Information Tab 

In the top center of the screen, the Tax ID numbers and Local Lot/Parcel ID 
numbers can be added. This information is useful in identifying a property when 
the address is unclear or inadequate. Note that a datasheet view icon is also 
available for this page if you wish to view or edit data for multiple records.  
 
If the View thumbnail image box is checked, the main image will appear as a 
thumbnail in the upper right portion. Refer to Section 6.1.2, View, under the sub-
section Images for more information about thumbnail images. 
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6.3.1.1 Regulatory Requirements 
A datasheet view is available in this section that includes important criteria that 
could affect potential mitigation measures. Information on these regulatory 
requirements should be collected from local building officials. They include the 
following: 

• Freeboard – If the community requires structures in floodprone areas to be 
elevated a specific height above the BFE, the Freeboard box should be 
checked. The required height above the BFE should be selected in the 
Level drop down menu. 

• Code Height Restrictions – This indicates the maximum elevation/height 
to which a structure can be constructed or elevated, and is usually 
implemented in waterfront communities to protect views. A text box is 
provided to note the height restriction. 

• Compensatory Storage Requirements – Some communities have 
regulations requiring a hydraulically equivalent storage volume to be 
created for floodwaters when development results in the displacement of 
floodwater storage capacity from part of the floodplain. If this is 
applicable, it should be recorded in the text box provided. 
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• Other Higher Regulatory Standards – Any other state or local regulations 
that could affect mitigation measures such as enclosure limitations or 
special requirements for the protection of critical facilities should be 
recorded in the provided text box. 

6.3.1.2 Equipment/Contents 
Only the total value of noteworthy, expensive or unusual equipment (e.g., 
machinery, merchandise) and contents should be entered in this section. This will 
generally apply only to non-residential 
uses. A description should be provided 
along with any other information that is 
relevant. The values of contents or 
machinery common to the current or 
anticipated occupancy do not need to be 
entered. 

6.3.1.3 Building Market Value 

This is the value of a structure based on the estimated price for which a willing 
buyer in the current real estate market would pay to a willing seller. This 
information may be available from a tax assessor’s office or from local building 
officials. While tax assessment records do not always give an actual building 
market value, they may note a multiplier to be used with the assessment value in 
order to calculate at a market value. If a tax assessment is available without some 
type of conversion multiplier but seems undervalued for a market value, this 
should be stated in the Notes section along with the following data: 

• Dollar value 

• Date the value was estimated 

• Source (e.g., local building official, tax assessor’s office) 

• Source type (Certified Appraisal, Community Tax Records, or Other) 

6.3.1.4 Building Replacement Value 

This refers to the value of a structure based on the cost of materials and labor to 
rebuild. Building replacement values may be available from local building 
officials and are required for Benefit Cost Analyses. If necessary, the value may 
be determined by a building official, engineer, or architect using cost estimating 
tools such as the Marshall and Swift Handbook, R.S. Means Cost Data, or other 
comparable resources. Information to be completed for this section includes the 
following: 

• Dollar value 

• Date the value was calculated 
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• Source of the value, including who created the estimate and what method 
of calculation was used to develop the estimate 

6.3.1.5 Land Value 
As with the building market value, the land value of the property may be available 
from tax assessment records, and should be recorded separate from the building 
value. If this assessment seems undervalued (or overvalued), enter a message in 
the Notes section indicating a possible discrepancy. Information to be completed 
for this section includes the following: 

• Dollar value 

• Date the value was estimated 

• Source of the value  

• Source type (Certified Appraisal, Community Tax Records, or Other) 

6.3.1.6 Building Information 
The top right of this screen tab provides an area for the entry of Construction 
Date.  This information might be found in building permit records. Normally, the 
date the permit was applied for will be used. If the year is known but not the exact 
date, the month and day can be entered using “01/01.” Fields for the square 
footage of the building footprint* and the total structure are also provided. While 
this information can be gauged during a site visit, the best source for accurate 
measurements is the local building or zoning department. 
 
*This field must be completed to generate the FEMA 551 report. 

6.3.1.7 Source of Information 
This feature enables you to report the various source(s) of information recorded 
under the Detailed View. A date should be included for each source that is 
checked. The Notes section can be used to provide names, phone numbers or 
addresses of contacts. 

6.3.2 Elevation and Hazard Tab 

This tab contains data related to the flood hazard and various elevation reference 
points of the structure that may be on file with the community. The left half of the 
screen requires information about the BFE and elevation of the structure. The 
right half of the screen requires additional flood hazard information from the FIS 
or other comparable source. Note that a datasheet view icon is also available for 
this page if you wish to view or edit these data for multiple records. 
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6.3.2.1 EC or Elevation Data 
This section should capture information directly from a FEMA Elevation 
Certificate, if available. The FIRM information gathered here may be different 
than the current FIRM data gathered in Section 6.2.3.1, Current FIRM Data, if 
community FIRM panels were revised after the structure was permitted for 
construction. If an elevation certificate is not available, certain fields may be 
completed using as-built records or similar certified data. Any discrepancies noted 
in the BFE, FIRM Zone, FIRM Index date, etc. (as compared to data collected for 
the Limited View tab/Flood Risk and Mitigation Possibilities) should be noted in 
the section’s Notes area. Following is a description of each requested data field. 

• Source of Information – If an elevation certificate is not provided, the 
source of information might be a building permit application or an as-built 
certification. An engineer working for the property owner or developer, or 
the local building code official or zoning officer may have determined and 
gathered certified elevation information. Generally, the flood elevation 
data will have been taken from the community FIS or FIRM where the 
BFE for a given site is mapped. However, when the area is mapped as an 
Approximate A or V zone, a local study or historical high water marks 
might be used to establish the BFE. Additionally, if a regional or local 
study completed more recently than the effective FIS indicates an increase 
in the BFE, this study might be used as a source for flood hazard data. 
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• Map and Panel # – The FIRM map and panel number should be entered 
here if it was recorded on the certified data. 

• Date of FIRM Index – This should be taken from the elevation certificate 
or other certified data where available. 

• Flood Zone – The flood zone from the elevation certificate or other 
certified data (corresponding to FIRM zones, for example, AE, VE, B/X 
shaded, etc.) should be noted here. 

• BFE/Depth* – The BFE or flood depth (AO, AH zones) from the certified 
data should be entered here. 

*This field must be completed to generate the FEMA 551 report. 

• Building Diagram # * – This is the elevation certificate building diagram 
number reported on the elevation certificate. The linked FEMA Elevation 
Certificate can be viewed for reference by clicking on the Elevation 
Certificate button.   

 
*This field must be completed to generate the FEMA 551 report. 

• Vertical Datum – Enter the vertical datum type for the BFE from the 
elevation certificate or other certified data (see Section 6.2.3.1, Current 
FIRM Data, for a description of vertical datum types and possible 
conversion notations). 

• Conversion / Comments – If the BFE datum is different from the structure 
elevation information datum, a method for conversion should be entered 
here. 

 
The next set of entries corresponds to those found in Section C of the FEMA 
Elevation Certificate. Structure elevation data and data about flood vents are 
entered here. The FEMA Elevation Certificate may be referred to for any 
questions. Again, this information should only be included if there is a certified 
source, such as an elevation certificate, on file with the community: 

• Top of bottom floor – This includes basements and other possible 
enclosures. 

• Top of next higher floor  

• Bottom of lowest horizontal structural member – This measurement is 
generally only taken in V zones but may also be relevant in communities 
with Coastal A zone regulations.  

• Attached garage  
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• Lowest elevation of machinery and/or equipment  

• Lowest Adjacent Grade*  

*This field must be completed to generate the FEMA 551 report. 

• Highest Adjacent Grade 

• No. of permanent openings – This includes the openings that serve as 
flood vents to allow the automatic entry and exit of floodwaters from areas 
below the BFE. 

• Total area of permanent openings (flood vents) – The surface area of flood 
vent openings in square inches.   

• Certifiers Information section – The certifier’s contact information, license 
number, company name and street address should be recorded in this 
section. 

6.3.2.2 Additional Flood Hazard Data 

Information from the FIS or a comparable source (where the FIS is not available 
or more recent information is available) is collected here to characterize the flood 
risk and to collect flood hazard risk information that is necessary to run a Benefit 
Cost Analysis (BCA). 

• Date of FIS 

• Date of Other Source 

• Describe Source (if other than FIS) – The name of the study or other 
source used should be provided here [e.g., U.S. Army Corps of Engineers 
(USACE) flood information reports, Federal Highway Administration 
(FHWA) floodplain studies, etc.]. Adequate documentation of this source 
is necessary, including an electronic copy if available, or scanned images 
of pertinent parts of studies. These can be attached to the NT using the 
documents button to attach them (see Section 6.1.2, View, for how to load 
documents). 

• Streambed Elevation from FIS – Include the elevation obtained from the 
flood profiles in the FIS. 

• Flash Flooding* – Information on whether or not the structure is subject to 
flash flooding may be obtained from the FIS or community officials’ 
knowledge of the area. 

*This field must be completed to generate the FEMA 551 report. 
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• Flood Velocity* – Mean flood velocity within the floodway can be 
obtained from the FIS. For flood velocities at sites outside of the 
floodway, historical flood data might provide more accurate velocity 
estimations. 

*This field must be completed to generate the FEMA 551 report. 

• In Floodway* – If a floodway analysis was performed as part of the FIS, 
the floodway delineation on the FIRM or floodway map will indicate 
whether the site is located within or outside of the floodway. 

*This field must be completed to generate the FEMA 551 report. 

• Flood Zone Characteristics – In this section, the type and characteristics of 
the flood zone should be included (ice jams, sewer backflows, other, 
riverine, coastal, sheet flow, shallow floods, ponding). 

• Flood Frequency Based Discharges (Q) and Elevations Table – Discharge 
information is available for certain points along a detailed studied stream 
and is found in the Summary of Discharges table in the Hydrologic 
Analyses section of the FIS. The elevations are usually available for 
detailed studied flood areas from the flood profiles and are necessary to 
run FEMA’s Mitigation Benefit Cost Analysis (BCA) Toolkit. 

• Depth of 100 year flood at site – This depth will be calculated 
automatically if information on the BFE and Lowest Adjacent Grade is 
entered in the EC or Elevation Data section of this screen. 

6.3.3 Claims Tab 

Claims information from the NFIP download is recorded in this section.  
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Reported Value – This is the reported value of the building associated with the 
most recent loss as recorded in NFIP. It is determined by taking the replacement 
cost value (RCV) when available or, alternately, the actual cash value (ACV). The 
figures for RCVs were not reported prior to May 1, 1997. If the reported value 
from the most recent date of loss is not acceptable, the value from the previous 
date of loss is examined and used if deemed acceptable. Acceptable is defined as 
any value that is greater than zero, but less than $10 million for one-to-four family 
properties and greater than zero but less than $100 million for other properties. If 
multiple occurrences of flooding are found for any date of loss, the "ASSUMED 
CONDO" label is used in the property value field. If no value meeting the 
definition of acceptable is found, the "VALUE NOT AVAILABLE" label is 
inserted in the property value field.  

6.3.3.1 NFIP Summary 
o Cumulative Payment – This refers to the total of all payments from claims 

as noted in the last column of the Known Claims table. 
 

o Average Building Payment – This refers to the average payment per claim 
for building payments only. It does not include the contents value.  
 

o Average Cumulative Payment – This refers to the average payment per 
claim, including both contents and building. The entry is calculated from 
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claims in the Building Payments and Contents Payments columns of the 
Known Claims table. 

 
o Average Contents Payment – This refers to the average payment per claim 

for contents payments only. It does not include the building value. 

6.3.3.2 Known Claims 
The Known Claims table values are imported from NFIP and contains information 
for each claim made on the structure, up to a maximum of nine claims. It includes 
information on the loss date, building payments, and contents payments.  
 

• Additional Claims Filed – This box should be checked when there is an 
indication from the owner or other source (such as a local official) that a 
claim was made on the structure that was erroneously excluded from the 
NFIP data. 

• Claims Update Required – This box should be checked when there are 
data to support a missing claim and adequate data for the claim to be 
further investigated and/or added to the NFIP data can be provided. 

6.3.3.3 Missing Claims 
The information in the Missing Claims table is similar to that in the Known 
Claims section except that it allows you to enter missing records. When 
information is provided or obtained that indicates that a claim was made, but not 
properly recorded with the corresponding structure (it may have been recorded 
with another structure) in the NFIP records, the claim information may be 
recorded in this table. This information may be obtained from copies of checks, 
adjusters’ statements, proof of loss records gathered from property owners or 
local officials, or documented claims or records within the NFIP data. 
Additionally, uninsured losses for building and contents corresponding to known 
claims (such as deductibles or damages exceeding the limits of the policy) may be 
added to this section. The source of the data should be noted in the Notes field on 
the screen and any documentation (digital files) should be added via the 
documents attachment function (see Section 6.1.2, View). Records in the Missing 
Claims section can be added, edited, or deleted using the keys on the bottom left 
of the screen.  

 

6.3.4 Events and Total Damages Tab 

This tab has additional information about reported damages to the structure where 
there are no insurance claim records to be entered. This screen also summarizes 
all of the losses for the structure, including known claims, missing claims and 
other events.  
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6.3.4.1 Events Table 
The Events table enables you to enter information about specific flood events, 
including their recurrence interval and flood depth. These events may or may not 
correspond to claims made that were recorded on the previous screen. If there are 
losses associated with the event that were not insured, the loss information should 
also be included in this table and explained. Records can be added, edited, or 
deleted using the keys on the bottom left of the table. In order to add an event, the 
following information should be provided:  
 

• Event Name (e.g., Hurricane Floyd or February 1991 snowmelt and 
rainfall event)  

• Event Date  

• Frequency of the Event (e.g., 25-year flood or 100-year flood)  

Note: FEMA’s Mitigation BCA Toolkit provides guidance on acceptable 
methodologies for determining flood recurrence intervals. 

• Frequency Source of Information - Clear documentation of the sources 
used for determining the recurrence interval/frequency of the event as 
well as any losses should be provided. The following are considered 
acceptable sources for flood event frequency determination: FEMA FIS, 
U.S. Geological Survey (USGS) Post-Event Reports, USACE Post-Event 
Report, and National Weather Service (NWS) or National Oceanic and 
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Atmospheric Administration (NOAA) recurrence interval estimates. 
Estimates vary from location to location, so accurate documentation is 
necessary. 

• Depth of flood 
o very shallow (<1 ft)  
o shallow (1 to 3 ft)  
o moderate (3 to 6 ft)  
o deep (>6 ft)  

• Velocity of flood 
o fast (>5 ft/s)  
o slow/moderate (<5 ft/s) 

 
The appropriate boxes should be checked if the following has occurred: 

• Flash Flooding  

• Ice/Debris Flow (<1 hr) 

• Declaration Declared 

• Were there pollutants in the flood waters that required any special 
cleanup? 

 
Finally, this table should include the monetary amount of any flood damages 
caused by flooding events that were reported by the property owner with either a 
NFIP policy not in effect or with damages incurred that did not exceed the 
deductible or $1,000 paid under the NFIP. 
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6.3.4.2 Total Damages (Claims and Events) 
The Total Damages section contains information on all damages entered on the 
Claims and Events and Total Damages screens and presents it in the form of a 
concise summary. The table contains information on total payments (both 
building and contents), total uninsured damages, and total losses. Any edits made 
to either the Missing Claims table (in the Claims tab) or the main table of the 
Events and Total Damages tab will be reflected in the Total Damages section. 
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A.1 System Requirements 

• Microsoft Excel 5.0 or higher  
 
• Microsoft Access 2002 (XP) , 2003 or 2007 

 
• Adobe Acrobat Reader   

 
• While there are not strict guidelines for PC processing speeds or RAM when 

using the NT, a Pentium III processor with at least 512MB of RAM or better 
will help to facilitate the following: 1) successful import of NFIP data when 
there are hundreds or thousands of records; 2) successful appending of records 
when there are hundreds or thousands of records; 3) faster record loading 
times when browsing through records; 4) faster display of thumbnails when 
browsing through records; and 5) faster download of pictures in the image 
gallery.  

 
• Recommended screen resolution of 1024 by 768 pixels 
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A.2 Installation Instructions 
 

1. Load the installation CD. If it does not automatically start, browse to the 
installation CD folder and click NTSetup.exe. 

 
2. The following screen will appear: 

 

 
 

Click Yes to continue. The program installation will start.  
 

 
3. Next, the Setup Wizard will appear. Click Next to continue. 
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4. Enter your username and organization. This information is usually already filled 

in. 
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5. Select Typical as your Setup Type.  Select the option Custom to change the 

default installation folder. 
 

 
 
 Click Next to continue. 
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6. Click Install to begin the installation process. To review your settings, click 

Cancel to exit the Setup Wizard. 
 

 
 

After clicking Install, the status window will appear: 
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7. When the installation process is completed, click Finish to exit the Setup Wizard. 

 

 
 

If you have Access 2002 or Access 2007, the icon that appears in the Start > All 
Programs list needs to be modified to point to the correct Microsoft Office folder. 

To do this, go to Start > All Programs and right click on the NFMDCT_V3 icon.  Select 
Properties, and modify the target field to point to the correct Office folder (Office12 for 
Access 2007 or Office10 for Access 2002). 
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A.3 Installing the Repetitive Loss Property (RLP) Viewer 
 
1. Open the Setup Disk. 
 
2. Run the MapWinGISOCXOnly.exe program and follow the instructions. 
 
3. Once the MapWinGISCXonly installation is done, open the Release folder 

inside the Setup CD. 
 
4. Run the Setup.exe file.  
 

The RLP Viewer was developed using Visual Studio .NET. If this is the first 
installation in the computer, it will start the deployment of Microsoft .NET 
Framework. Just follow the instructions. At the end of the process, it could ask 
to reboot the computer. 

 
5. After rebooting the computer, if asked, the installation process will continue. 
 
6. View the PowerPoint presentation in the Presentation folder on the CD. 
 
7. Instructions for downloading shapefiles can be found in this file in the 

presentation folder: RLP Viewer 2.0 GIS Data Formatting.doc or in Appendix 
A.3.1. 
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A.3.1 RLP Viewer 2.0 GIS Data Formatting  

 
There are two steps involved before using the RLP Viewer: 1) obtaining your GIS 
data and 2) formatting your GIS data. 
 

Note: Also view the PowerPoint presentation in the Presentation folder on the 
RLP Viewer CD. 

 
 

Step 1: Obtaining your GIS data 
 

1. Navigate your web browser to the URL: 
http://arcdata.esri.com/data/tiger2000/tiger_download.cfm. 

 
Next, select a state from the drop down list (Figure 1). 

 

 
(Figure 1) 
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2. From the next drop down list, select the county that pertains to your data, 

click ”Submit Selection.” 
 

 
 (Figure 2) 

 

http://arcdata.esri.com/data/tiger2000/tiger_download.cfm
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3. From the list of available GIS data layers check the box next to: 

“County200,” “Line Features – Hydrography,” and “Line Features – 
Roads” (Figure 3). At the bottom of the page, click “Proceed to 
Download” (not shown). 

 
 

 
      (Figure 3) 
 
 

http://arcdata.esri.com/data/tiger2000/tiger_download.cfm
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4. At this page, click “Download File” (Figure 4). Download the data to the 

desired folder location. 
 

 
    (Figure 4) 
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5. After the download is complete, extract the individual WinZip folders 

(Figure 5), then extract the shapefile components (Figure 6).  
 

 
    (Figure 5) 
 

 
(Figure 6) 
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Step 2: Formatting your GIS data 
 

For each GIS layer you will see a collection of 3 files with the same name, 
but different file extensions (Figure 6 in Step 1). This collection of files 
that comprise each GIS layer needs to have the same name in order to 
work properly. The naming convention needs to match the example on 
page 8 of the RLP Viewer 2.0 manual. The minimum requirement is the 
county boundary shapefile. 
 
For our example (and for all data retrieved from ESRI ArcData site) the 
file name changes should be: 
 
Original File Name   New File Name 
tgr19153cty00    IA_POLK_County 
tgr19153lkA    IA_POLK_Roads 
tgr19153lkH    IA_POLK_Streams 
 
Your shapefile components also need to have the appropriate name and 
attribute fields in order for RLP Viewer 2.0 to map your properties.  

 
Layer Field Name Field Type Description 

Properties PROPLOCATR Text (50) It corresponds to the Property Locator 
number in the NT database 

Roads TIPTEXT 
 
NAME 

Text 
 
Text 

Text to be displayed as a “tip” when the 
user stops the cursor over a street segment 
For labels 

Stream TIPTEXT 
 
NAME 

Text 
 
Text 

Text to be displayed as a “tip” when user 
stops the cursor over a stream segment 
For labels 

Q3 FLOODWAY 
ZONE 

Text 
Text 

For identifying flood way 
For thematic coloring the flood map and 
to be displayed as a “tip” when the user 
stops the cursor over a flood polygon. 

Community TIPTEXT 
 
NAME 

Text 
 
Text 

Text to be displayed as a “tip” when user 
the stops the cursor over a community 
polygon  
For labels 

County NAME Text For selecting which new property feature 
will be added to the properties shapefile 
avoiding points outside the extent of the 
county polygon. 

    (Figure 7)  
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1. To add a field, open the .dbf file using Excel. Right click on the .dbf 
file and choose the option “Open With.” Select Microsoft Office Excel 
(Figure 8). 

 

 
      (Figure 8) 

 
2. You should see the following (Figure 9): 

 

 
    (Figure 9) 
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3. Next, type “NAME” into the next empty column header. In order for 

the .dbf file to save correctly, select ‘Insert’ from the main menu, then 
“Name,” then “Define.” Delete all names in the workbook and select 
“OK” (Figure 10).  

 

 
    (Figure 10) 

 
 

4. Save the file and exit Excel. When prompted choose to save the file in 
the DBF 4 format (Figure 11). 

 

 
    (Figure 11) 

 
 

5. Repeat these steps to add the required fields for the streams and roads 
files, adding the appropriate column headers from Figure 7. 

 
Your GIS data is now properly formatted for use with RLP Viewer 
2.0. 
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A.4 NT Folder Organization and Maintenance 

By default, an NT database and a documentation folder will be installed into 
C:\Documents and Settings\<username>\NFMDCT_V3, but you can change 
this location during installation to another folder on your hard drive or network.  
The documentation folder within the NFMDCT_V3 folder is called NFMDCT.  
The nested NFMDCT folder initially contains only the NT documentation; 
however, it is also the repository for all images and documents uploaded into the 
NT.   
 
If you install to the default folder and want to move it later to the network or other 
location, you can do so without any problems. You do not need to reinstall from 
the CD to the network.   

The NT can store and organize properties in any way you prefer: by community, 
county, state, or FEMA region. How you work with field inspectors and others 
who use the data will determine the best way to set up your folder structure.  Keep 
the following in mind: 

• Always keep one database (the master) up-to-date with the latest field 
inspections and NFIP data.  Updating multiple databases can be confusing 
and time-consuming. See also Section 4.4.7.1, Updating a Master 
Database from a Subset Database. 

• Create subset databases from the master database as needed (by state, 
county, community, etc.) for field inspectors, community officials, or 
other users. Creating subset databases from the master ensures that you 
will always have the most recent data. 

• Organize the field inspector’s databases by date so you can rebuild the 
master if necessary.   

• Organize downloaded NFIP spreadsheets by date. 

• You will need an empty version of the NT database each time you want to 
create a subset database, so copy the NFMDCT_V3_Empty.mdb database 
from the installation CD to a folder on your local PC or network so it’s 
easy to retrieve when needed.   

• If there are other users who need to use the master database on the 
network, provide a separate copy to work with instead of the original.  
This will help to protect the master database from accidental data and/or 
file corruption. 

• See the graphics below for a few ideas for folder structure.  These are only 
suggestions; do what works best for your needs.  
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If you have access to a network, it’s strongly recommended that you store your 
databases on the network.  It not only provides a regular backup of the data but 
also allows for unlimited storage capabilities .  
 
As images and documents are added to the database, you will need an increasing 
amount of disk space to store them.  How much space is needed depends upon the 
size and quantity of images/documents.  
 
If you do store the databases on your local PC, make sure you back it up 
frequently to an external device. 

Folders organized by State 

Folders organized by Function 
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A.5 Enhancements Made to Version 3.0 
 

1. NEW FEATURES 
a. Added the ability to Export a Property data Template spreadsheet.  The 

spreadsheet will be populated with all of the data fields in the NT.  It can 
then be modified and imported back into the NT.  The only fields not 
importable are Possible Mitigation Measures Observed and the Certifiers 
Information.   

 
b. Added the ability to Export Claims and Flood Event information into an 

Excel spreadsheet. 
 

c. Added the last 10 properties worked on to the File menu. 
 

d. Added a Merge feature to the Utilities menu.  You can now merge the data 
entry fields from one property into another.   
 

e. Added 4 new Tutorials:  Importing NFIP Data into the NT, Creating a 
Subset NT Database, Appending Data into an Existing NT Database, and 
Maintaining a Master Database. 
 

f. Added the ability to print reports to PDF without having a PDF printer.  
During the NT installation, two additional files will be installed called 
DynaPDF.dll and StrStorage.dll.  They will be installed in the same folder 
as the database.  If you move the database and it can’t find the files, you 
won’t be able to print to PDF without a PDF printer. 
 

g. Added the ability to track multiple site visits on the Data Collection 
screen. 
 

h. Added a Photo Gallery that is available from the View menu in Limited 
and Detailed views, or from the Utilities menu. 
 
 

2. SCREEN CHANGES 
a. Made the Property Locator/RL# red and bolded and added 

“SRL(indicator)” after it to indicate SRL properties.    
 

b. Added the NFIP Data As of Date (from the collections screen) to the 
Limited View / NFIP Address section. 
 

c. Added Insured Status from the Insurance Screen to the Limited View / 
NFIP Address section.   
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d. The Data Collection screen will now collect multiple site visit information 
as well as track data changes made through the screen interface or through 
the Property Data Template import process.  To enter site inspection 
information, click on the inspectors name or date in the Limited View. 
 

e. Added the Data Collection screen and FEMA Regions to the View Menu.  
 

f. Added new buttons to the bottom of the Limited and Detailed Views:  
Find Properties, Show All Properties, Go to Detailed/Limited View, Save, 
Close, Go to PL# and Go to Record #.   
 

g. Made the thumbnail image larger and it will now appear in the last place it 
was dragged.   
 

h. All screens that open from the View menu can be sized and left open as 
you scroll through properties.   
 

i. The thumbnail will stay open when you switch between limited and 
detailed views.  You can also turn the image on and off from the detailed 
view as well as limited. 
 

j. Reformatted the Help screen and the Help menu.  Added sections for 
Documentation, Tutorials, Tools and Helpful Links.  Added a link to the 
RLP Viewer program. 
 

k. Added Last Claimant Name (Revised) to the Insurance screen.  
 

l. Added Streambed Elevation from FIS to the detailed view.  
 

m. If notes exist, they will be displayed when the mouse is moved over the 
Notes buttons in Limited and Detailed views. 
 

n. Added a “551” image next to each field that is needed in order to run the 
FEMA 551 worksheets.  
 

o. Added “Clear All” buttons next to the HVAC, Duct Work and Potential 
Hydraulics Impacts.  This is the only way to ‘deselect’ all options. 

 
p. FIND SCREEN – Reformatted into Tabs. 

i. Added Zone Insured In, Inspection Date, NFIP Data as of Date, 
Severe Rep Loss Indicator and Community ID starts with. 

ii. When you press Enter it will automatically perform the Find.  
iii. Reformatted and grouped items. 
iv. Fixed a bug in the Find Number of Claims payments. 
v. Added Last Claimant Name and Last Claimant Name (Revised). 
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3. NFIP IMPORT 

a. Importing additional fields from the NFIP spreadsheet:  Severe Rep Loss 
indicator, County and Local Property Identifier.  The Local Property 
Identifier is being imported into the Local Lot/Parcel ID field (detailed 
view).  The user can still overwrite the data.  If there is a value in the field 
when the NFIP data is imported, it will NOT be overwritten with the NFIP 
data. 

 
b. Added a third report produced in the NFIP Import Process.  It is a 

summary report by CID showing the number of properties per CID in the 
database before the Import, how many were Imported, the properties not 
Imported, and the new properties Imported.  

 
c. The community name, CID, city, county, state and zip fields will be filled 

in on the Limited View / Address Updates section.  This will happen only 
for new records, or if these fields are blank. 
 

d. Added the ability to cancel an import. 
 
 

4. APPEND PROCESS 
a. Added an Append Options screen which provides additional ways to 

append the data. 
 

b. Modified the Append process to capture “53 – File Not Found” errors.  If 
the file isn’t found then it is added to a new “Missing Images/Document” 
report.  The new report will display after pressing the Report button and 
closing the first report. 
 

c. When Appending into another database, the NT documentation files 
(user’s guide, tutorials, etc) will also be copied to the NFMDCT folder (if 
they don’t currently exist). 
 

d. Fixed an issue when appending the same data into a database causing the 
images to be duplicated.   

 
 

5. REPORTS 
a. Added the following new reports:  FEMA 551 worksheets A and B, 

AW501, Missing Images and Documents and Mitigation. 
 

b. Changed the Severe Rep Loss report screen drop-down box to list each of 
the SRL types. 
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c. The SRL type was added after the property locator number on all of the 
reports.  
 

d. Modified the report criteria screen for the Photo summary report so you 
can sort the properties by Rep Loss #, Community Name or CID number.  
You can get to this screen through the main menu – Reports option.  Also, 
only properties with photos will now appear in the list. 

 
e. Reformatted the Basic and Severe Rep Loss reports. 

 
f. Added the Inspection Date to the Properties Requiring Action/Update 

report. 
 
 

6. DATA STRUCTURE CHANGES 
a. Widened the Tax id field (detailed view) from 30 characters to 50 

characters. 
 

b. Widened the filename field for document names when loading pictures 
and documents from 42 characters to 247 characters.   
 

c. Widened the Local Lot/Parcel ID field in the Additional Site Information 
Tab of the Detailed Data view to 75 characters. 

 
 
7. MISCELLANEOUS 

a. Replaced the term “BureauNet” with “NFIP.” 
 

b. Changed the View menu to say Detailed View OR Limited View, not 
Detailed Data. 
 

c. Changed the CID field to a character field throughout the system in order 
to display the leading 0.  
 

d. Removed the # in all filenames that are uploaded to the tool and replaced 
it with “_”.   
 

e. Eliminated having to be administrator to load the tool – removed all OCX 
and DLL files that had to be registered. 
 

f. If there any entries in the Mitigation Updates Field boxes in the Limited 
View, the “Updates Made” checkbox will automatically be checked when 
the property is saved.  Also when saving the Limited View, the system 
will check the field mitigation actions to ensure they have been 
appropriately entered.  
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g. Added progress bars to several processes.  
 

h. Modified the transition process between the Limited and Detailed views to 
be smoother and quicker. 

 
i. Fixed several bugs throughout the system.  
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B.1  Troubleshooting 
 
Main Menu Function 
 
NFIP Import 
 

Problem – The NFIP import process begins, but “hangs” before it is finished. 
 
Solution – This is generally a computer processing issue related to the speed and 

memory specifications of the PC. See System Requirements in 
Appendix A for suggested PC configuration and try importing smaller 
portions of data (fewer records) if necessary. 

 
 
Problem – After choosing a file for import, there is an error message, “The 

Following error has occurred: -2147418113 – Catastrophic 
failure”   

 
Solution – Make sure you have the correct drill down. There are drill downs with 

similar but not identical formats to the one used with the tool – the RL 
Data for National Tool. Be sure the drilldown being used is in the 
correct format and refer to Section 4.4.1 of the User’s Guide on how 
to access this data. 

 
 

Problem – When importing NFIP data for updates of existing records, the 
older data are not being replaced with data from the new import. 
Instead, new records are created. 

 
Solution – Make sure that the Property Locator/Rep Loss number on the record 

matches the one in the NFIP spreadsheet.  
 
 
Appending Data 
 
 

Problem – I appended data more than once from the same database. Some of 
my image names have changed to include “_01” or “_02” and the 
disk space used has increased dramatically. 

 
Solution – When you append data into the database, it also appends the images 

into the NFMDCT folder where your database resides. During the 
append process you can select how duplicate images are handled.  If 
you selected to Not overwrite files with the same name, then the file 
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was renamed with a sequential number.  This  doubles up the amount 
of disk space used and isn’t very efficient.  

 
To correct the situation, you can use one of these two options.  

1. Manually remove the extra images by deleting them from each property 
record. 

2. Create a new database and append the data only one time. If there are a lot 
of renamed images, this may be less time-consuming than Option 1. To 
create a new database, copy the empty NFMDCT database from the 
appropriate folder on the installation CD. Append the data from the 
original database only one time into the empty database.  

 
 

Problem – I appended data from a previous version of the NT and the “Total 
Number of Claims per NFIP” field on the Insurance screen 
contains “Unknown.” 

 
Solution – This occurs because this field did not exist in the older versions of the 

NT. To fix the problem, re-import the latest NFIP data. 
 

Images 
 

Problem – TIF images are not loading on the image screen or being displayed 
as a thumbnail. 

 
Solution – Microsoft Office 2003 does not include TIF graphics filter files which 

are necessary for proper viewing of TIFs in this application. You can 
load the necessary files from installation CDs for previous versions of 
OFFICE (XP). To load the files, load the Microsoft Office CD into 
the PC and choose Custom Installation. Load the Graphics Filters 
found under Office Shared Features, Converters, and Filters. Make 
sure to click on all other entries and apply the “X” so the older 
applications are not installed. 

 
 
PDF Documents 
 

Problem – When clicking on a PDF document link, my screen flashes and the 
document never displays.  

 
Solution – PDF documents are located throughout the NT application, but reside 

mostly on the HELP screen. Adobe Reader 7.0 has a known bug 
where it won’t display PDF documents when they are linked from a 
Microsoft Office document. If you have Adobe Reader 7.0, uninstall 
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it and download the latest version of Adobe Reader from the Adobe 
web site (www.adobe.com).  

 
Problem – When clicking on a PDF document link, I receive the error 

“Unable to open …PDF.  No program is registered to open this 
file.”   

 
Solution – Several of the supporting documents for the NT are PDFs (Portable 

Document Format). These documents need Adobe Acrobat Reader in 
order to open them. You can download Adobe Reader from the 
Adobe web site (www.adobe.com). Please note the Adobe Reader 
7.0 issue in the preceding problem and solution. 

 
Problem – I could not print to PDF.   
 
Solution – During the NT installation, two additional files will be installed called 

DynaPDF.dll and StrStorage.dll into the same folder as the database. 
Check the location of these files. These are necessary in order to print 
to PDF. If you move the database and not the files, you won’t be able 
to print to PDF without a PDF printer. 

 
 
Miscellaneous 
 

Problem – My database continues to grow in size. Can it be compacted? 
 
Solution – Yes. Microsoft Access databases do not recover unused space until 

they are compacted. As with all Microsoft Access databases, it will 
need to be compacted periodically.  Access has a built in feature to 
compact automatically every time the database is closed. However, 
this feature is not included in the NT program because of the time 
delay and risk of corruption.  If the compact process is interrupted, 
the database will be corrupted. Therefore, compacting is a process 
that must be performed manually. 

 
There are two ways you can compact: 

• Through the use of the Compact_MDB program in NT 

• Through Microsoft Access 
 

Compacting using the Compact_MDB program in NT 
 

1.  Locate the Compact_MDB.exe file on the NT Installation CD 
and copy it to the same location as the master database. 

 

http://www.adobe.com
http://www.adobe.com
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2.  Double-click the filename to execute. 
 
3.  Click “Browse” to locate the database to be compacted, then 
press OK. 
 
4.  An ***Important*** information box is displayed (as shown at 

upper right).  The database will be backed up into a new folder 
called “Backup.”  Do not interrupt the compact process once it 
has started.  If it is interrupted, the database will be corrupt.  If 
that happens, you can restore it from the backup folder located 
where the database resides. 
 

6. Click Yes to continue and the database will be compacted.  
When completed, a message will be displayed. 
  

7. The database is now compacted.  A backup is captured for you 
in the Backup folder.  As other compactions are done, the 
backups will be numbered sequentially in the Backup folder. 

 
Compacting through Microsoft Access 2002 or 2003 

 

1.  Open Microsoft Access. 

2.  On the toolbar, select Tools / Database Utilities / Compact and 
Repair Database menu item. 

3.  You are prompted for the “Database to Compact From” file.  
Browse to and select the master database and press Compact. 

4.  You are then prompted for the “Compact Database Into” filename.  
Enter a new filename (example: 
NFMDCT_RegionIV_Master_Compacted.mdb) and press Save.  
The compacting process will begin. 

5.  When the compacting process is finished, exit Microsoft Access. 

6.  Rename the old master database to something more meaningful 
(example: NFMDCT_RegionIV_Master_Backup1.mdb) 

7.  Rename the compacted database to the original name 
(NFMDCT_RegionIV_Master.mdb). 

 
Compacting through Microsoft Access 2007 
 
1.  Open Microsoft Access 2007. 
 
2.  Click on the Office button in the top left corner of the screen. 
 
3.  Click Manage on the left, then Compact and Repair Database. 

http://www.adobe.com
http://www.adobe.com
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4.  You are prompted for the “Database to Compact From” file.  
Browse to and select the master database and press Compact. 
 
You are then prompted for the “Compact Database Into” filename.  
Enter a new filename (example:  
NFMDCT_RegionIV_Master_Compacted.mdb) and press Save.  The 
compacting process will begin. 
 
5.  When the compacting process is finished, exit Microsoft Access. 
 
6.  Rename the old master database to something more meaningful 
(example: NFMDCT_RegionIV_Master_Backup1.mdb) 
 
7.  Rename the compacted database to the original name 
(NFMDCT_RegionIV_Master.mdb). 
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B.2  FAQs 

Q: How do I create a smaller database with specific properties? 
A: Create a subset NT database (Section 4.4.7). 

 
Q:  How do I combine several community databases into one main county database?  

A: Append properties (Section 4.4.4).  
 

Q:  How do I create a spreadsheet with selected properties so I can update 
information in a single category all at once? 
A:   There are two ways: 1) From Limited or Detailed Views, use Find Properties 
to select the properties you want, and then select Export Property Data Template 
from the Tools Menu. And 2) From the Main Menu, select Utilities, then Export 
Property Data Template. Delete the rows for properties you don’t want to import. 

 
Q:  I exported the Claims and Flood Events spreadsheet and updated it. Why can’t I 

import it into NT? 
A: This spreadsheet cannot be imported into NT. The data from this 

spreadsheet is for use with FEMA’s Benefit Cost Analysis (BCA) 
program. To add updated Claims or Flood Events data, update the data 
fields in the Property Data Template spreadsheet under the appropriate 
worksheet tab and then import the Property Data Template into NT to add 
the information. 

 
Q:  I need to have the same photo associated with several different properties. Should 

I rename the photo file each time I want to add it to a different property before 
importing? 
A: You can go into the Photo Gallery, locate the image, right click it and 

assign it to additional properties. Alternatively, in the property data 
template spreadsheet, enter the same document path and file name of the 
photo for each property you want. The photo will be imported once, but 
NT will associate it with all of the different properties. Same reasoning 
works for the same document associated with several different properties 
(Section 4.4.3). 

 
Q:  I entered all of my field information into a property and then later found out that it 

is the duplicate of another property. Do I have to retype all of the same 
information into the main property?   
A: No, you can Merge properties (Section 4.4.5). 

 
Q:  Why did I receive an error after trying to import several photos? I included the 

entire path. 
A: Make sure the filenames of your photos do not have any blank spaces. If 

they do, either replace the spaces with an underscore (“_”) or remove the 
spaces entirely. 
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B.3  Importing Property Data into the NT 
 
Many data fields for multiple properties can be imported at one time by populating a 
Property Data Template (a Microsoft Excel spreadsheet) with the Property Locator/Rep 
Loss Number and a column for each data field found in NT. Any errors during the import 
process are displayed in a report immediately following the import.  
 
Steps for Importing Property Data (with notes for each step) 
 
1. Export the property data template. 

• This template is run from the Utilities Menu or from the Tools menu in 
Limited and Detailed Views.  
 

• Template is a Microsoft Excel spreadsheet containing a column for each data 
field that can be imported. 
   

• The property data for each property is also exported.   
 

• Some of the columns limit your entries by using drop down lists. 
 

• Three worksheets are exported – Import Data, Claims, and Flood Events. 
 

• You can limit the properties exported by using the Find Properties feature in 
the Limited or Detailed Views. 
 

2. Populate the spreadsheet with the values to be imported.  
• Delete or hide the columns you don’t want to import.  It won’t hurt to keep an 

empty column. 
 

• Delete the rows for properties you don’t need to import. 
 

• Delete the additional worksheets you will not be using to import data. 
 

• The Property Locator/Rep Loss Num column is required and must exist in the 
spreadsheet.  The number does not have to contain the leading zeros. 

 
• Do NOT rename any of the column names.  If you do, the import process will 

fail for that column. 
   

• If you enter inspector information, make sure to enter the inspection date.  If 
you don’t, the inspection information will not be imported.   

   
• Claims and flood events will also not import without the date. 
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• You can import multiple image and document files for a property by 
separating the filenames with a comma or a semi-colon (e.g., 
c:/RL00001899_1.jpg, c:/RL00001899_2.jpg, etc.). Do not mix commas and 
semi-colons as a file separator in the same cell.  Also, do not include blank 
spaces in the filename. Replace blank spaces with an underscore (“_”) or 
hyphen (“-”). 

 
• If multiple properties share the same image or document file, enter the same 

document path and filename for each property in the spreadsheet.  The file 
will only be moved once, but it will be associated with each property it was 
assigned to.   
 
NOTE:  This same process applies to existing image or document files in the 
database.  That is, if you are importing a file that has already been imported 
for another property, the file will not be moved (if your path is the NFMDCT 
folder). However, an association will be made between the new property and 
the existing file. The image or document file can then be viewed in both 
property records.   

 
3. Import the data.   

• Open the NT database, go to the Utilities menu, and select Import the 
Property Data Template.  Browse to locate and select the spreadsheet, and 
then press Import to continue or Close to cancel.   
 

• If any warnings or errors are detected in the import process, a Property Data 
Import Warnings and Errors report will be generated to provide more detailed 
information about the errors.  The following table lists possible warnings and 
errors included on the Property Data Import Warnings and Errors report with 
their solutions. 

 
Possible Warnings, Errors, and Solutions 
 

Warning/Error Solution 
The Property Locator/Rep Loss Num 
column was not found in the spreadsheet.  

The Property Locator/Rep Loss Num column is 
required.  Make sure the column exists and the 
spelling of the column name is correct. 

Invalid Column. Not imported. The column name is not recognized as a valid 
column.  Check the spelling of the column name 
against the template columns and/or export the data 
template and copy the column name. 

Text data too long.  Only n chars 
allowed. 

The column data value for this row contains too 
many characters.  It is limited to the number of 
characters given. 

Invalid Date. The column data value for this row does not contain 
a date in valid date format.  Format the column as a 
date field (mm/dd/yyyy). 
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Invalid value.  Must match a value in the 
drop-down box. 

The data value for this column does not match a valid 
value from the drop down box in the NT.  Check the 
NT screen drop down box for this field for valid 
values or print the drop down box values from the 
Help menu. 

File doesn't exist in the path stated. The image/document doesn’t exist in the path stated.  
Check the spelling and location of the 
image/document path.  If both commas and semi-
colons were used in the same cell to separate multiple 
image/document names, change to only one type of 
separator.  You cannot use both commas and semi-
colons in the same cell when separating filenames.   

Number too large.  Must be < 
999,999,999. 

The number value is too large.  Make sure it is less 
than the number listed.  

Invalid value.  Valid Values are:  x, x, x The value entered is invalid.  Select one of the values 
listed. 

Inspection must contain an inspection 
date.  Not imported. 

The inspection date is missing for this row.  The 
inspection record won’t be imported unless it has a 
valid inspection date.  Enter the inspection date in the 
format mm/dd/yyyy. 

Warning: Image/Document already exists 
for property: n.  This property will be 
assigned to the existing 
Image/Document. 

The image/document being imported already exists 
in the NFMDCT folder; therefore, this 
image/document was not imported.  The imported 
property was assigned to the existing 
image/document. 
 
If the imported property shouldn’t be assigned to the 
existing image/document, you can un-assign it by 
going to the View > Images or Documents menu and 
deleting the image/document.  The image/document 
will not be permanently deleted from NT until it is 
deleted from the last property assigned to it. 
 
If the image/document name is not spelled correctly, 
change it before re-importing.        

Warning: Image/Document already 
existed in the NFMDCT folder, but it was 
not assigned to any properties.  The 
existing Image/Document was 
overwritten with the new 
Image/Document. 

The image/document being imported already existed 
in the NFMDCT folder, but there were no properties 
assigned to the image/document.  This may occur 
when images/documents are manipulated outside of 
the NT database. 
 
Since the image/document wasn’t assigned to a 
property, the new image/document replaced the 
existing image/document.   
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Suggested Field Equipment 

• Laptop with the NT installed and up to date NFIP data imported 

• Handheld GPS unit 

• Digital camera 

• Mapped travel route 

• Area road maps and FIRMs 
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Address and Updates Tab 
 

Property Locator / Repetitive Loss #:       

 

Address Updates: 

  Incorrect Community and/or Address    

Community             

CID         

Notes:              

              

Street #    Directional             St Type   Unit   

Street Name    _______ 

City       State   Zip   

County        

Mitigation Updates: 
    Field Field    

Unable to Locate Property    

Flood Protection Provided   1:   (Circle One)  

a. The building was elevated to or above the Base Flood 
Elevation (BFE).  

b. The building was elevated, but not to the BFE.  
c. The building (non-residential) was floodproofed to the BFE.  
d. The building was partially floodproofed (but, not to the BFE).  
e. The building was protected by a flood control/stormwater 

management project.  
f. The building was replaced by a new elevated/floodproofed 

building.  
 

No Building on Property   2:   (Circle One)   

g. The building was demolished, but not acquired through any 
program.  

h. The building was acquired and demolished as part of a 
program.  

i. The building was relocated out of the floodplain.  
 

Historic Building    3:  (Circle One) 

j. Hazard Grant Mitigation Program (HMGP)  
k. Flood Mitigation Assistance Program (FMA)  
l. Pre-Disaster Mitigation Grant Program (PDM)  
m. Repetitive Flood Claims (RFC) 
n. Sever Repetitive Loss Program (SRL) 
o. Section 1362 Acquisition Program  
p. Other FEMA Programs  
q. Increased Cost of Compliance (ICC) Coverage  
r. U.S. Housing & Urban Development (HUD) Community 
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Development Block Grant (CDBG)  
s. U.S. Army Corps of Engineers or Natural Resources 

Conservation Services (NRCS) Project  
t. Other Federal Program  
u. State Program  
v. Local Program  
w. Property Owner  
x. Natural Disaster or Fire  
y. Unknown  

 

     4:  (Circle One) [If not available or unknown, circle letter “y”] 

j. Hazard Grant Mitigation Program (HMGP)  
k. Flood Mitigation Assistance Program (FMA)  
l. Pre-Disaster Mitigation Grant Program (PDM)  
m. Repetitive Flood Claims (RFC) 
n. Sever Repetitive Loss Program (SRL) 
o. Section 1362 Acquisition Program  
p. Other FEMA Programs  
q. Increased Cost of Compliance (ICC) Coverage  
r. U.S. Housing & Urban Development (HUD) Community 

Development Block Grant (CDBG)  
s. U.S. Army Corps of Engineers or Natural Resources 

Conservation Services (NRCS) Project  
t. Other Federal Program  
u. State Program  
v. Local Program  
w. Property Owner  
x. Natural Disaster or Fire  
y. Unknown  

  

Notes:              

              

 Additional Research Needed Notes:          

              

Mitigation Observed:   (Select one)  

     Structure appears to have been elevated 
     Structure appears to have been floodproofed 
     There is a floodwall, berm, or other type of 

barrier 
     Lower area subject to damage appears to have 

been modified 
     Drainage improvements appear to have been 

made 

     Flood control project should have reduced the 
threat 

     Owner/neighbor/local official report mitigation 
actions 

     Further Research Required  
     Other (explain in notes) 

Notes:               

              

Mitigation Verified*  Yes       No       N/A Notes:       

              

*(Verification of FEMA data observed in the field) 

 Duplicate Listing / with Property Locator #       
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Site Observations Tab 
 

Property Locator / Repetitive Loss #:       

 

Inspection Date:  / /    

Inspector:           

Latitude:     + / -       Longitude: :     + / -     

No. of Stories       Basement      

Occupied:     Yes     No      Seasonal Neighborhood:     Commercial Highway 
      Commercial Office 
      Commercial Retail/Downtown 
      Heavy Industrial 
      Light Industrial 
      Residential – high density (multi family/apts) 
Residence:    Primary        Residential – low density (single family) 
   Rental         Residential – medium density (2- 
   Seasonal        family/townhouses, rowhouses) 
     Rural residential 

Fill:     Below Street Grade    Elevated:    Not Applicable 
   None         At Grade 
   0-1 Feet        0-1 Feet 
   1-2 Feet        1-2 Feet 
   2-3 Feet   2-3 Feet 
   3-4 Feet   3-4 Feet 
   >4 Feet   4-6 Feet 

  6-8 Feet 
  8-12 Feet 
  >12 Feet 

 
Land Use: 

  Single-family residential 
  2-4 family residential 
  Multifamily residential (5 or more units) 
  Commercial (highway, office, retail, downtown) 
  Industrial (light, heavy) 
  Institutional (hospitals, churches) 

  Educational (schools, colleges) 
  Non-profit 
  Public 
  Semi-Public 
  Transportation 
  Other (explain in notes)

 

Notes:              

              

Adequate Vents Present:    Yes     No      N/A      Undetermined 

Spoke with:    Owner/Occupant  

     Neighbor  
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 Flooding this site have community-wide implications    

 If box is checked, select one: 

   Important for flood warning/response (e.g. lumber supply companies) 
   Important for disaster recovery 
   Important for public health (e.g. wastewater treatment plant) 
   Contains hazardous materials 
   Contains special population (e.g. nursing home) 
   Important utility service 
   Other (explain in notes)  

Notes:              

              

 

Structure Type:  

   Wood frame 
   Engineered wood frame 
   Steel 
   Light steel 
   Heavy steel 
   Concrete 
   Reinforced concrete 

   Unreinforced concrete 
   Masonry 
   Reinforced Masonry 
   Unreinforced Masonry 
   Manufactured home 
   Modular Housing 
   Other (explain in notes) 

Notes:              

              

 

Condition of Structure:       Good  (optional minor repairs)    Fair  (needs minor repairs)    

      Poor (needs significant repairs)   

Foundation Type:  

   Slab-on-grade  
   Basement sub-grade on all sides  
   Basement sub-grade with windows  
   Basement with walkout  
   Split-level - slab-on-grade  
   Split-level  
   Piers, posts, piles, columns, or parallel shear walls  
   Piers, posts, piles, columns, or parallel shear walls w/ full or partial enclosure  
   Elevated foundation walls w/full or partial enclosure  
   Crawlspace – floor at or above grade on at least 1 side  
   Other (explain in notes)  
   Unable to determine  

  

Notes:              

              

 
Condition of Foundation:    Good  (optional minor repairs)    

     Fair  (needs minor repairs)    
      Poor (needs significant repairs)    
      Needs further investigation   
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EC Diagram Number:       

(See diagrams that follow and select one) 

1.    Slab-on-grade 
 2.    Basement  

3.    Split level slab-on-grade  
4.    Other split level  
5.    Piers, posts, piles, columns, parallel shear walls  
6.    Piers, posts, piles, columns, parallel shear walls with enclosure  
7.    Full story foundation walls with enclosure  
8.    Crawlspace 
Unable to determine 
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Appurtenant Structure:    Carport     Detached Garage      Other  

      Deck     Shed      None Observed  

Notes:               

              

 

HVAC:  Machinery:   (Select all that apply) 

   Crawlspace/under elevated floor 
   Inside-in basement 
   Inside-on first floor 
   Inside-on second floor or higher 
   Outside-At/close to grade 
   Outside-Lower than first floor 
   Outside-Higher than first floor 
   Cannot tell 
   Other (explain in notes) 

Ductwork:   (Select all that apply) 

   Crawlspace/under elevated floor 
   Inside-in basement 
   Inside-on first floor 
   Inside-on second floor or higher 
   Outside-At/close to grade 
   Outside-Lower than first floor 
   Outside-Higher than first floor 
   Cannot tell 
   Other (explain in notes) 

 

Notes:              
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Flood Risk and Mitigation Possibilities Tab 
 

Property Locator / Repetitive Loss #:       

 

FIRM Index Date:    Panel # and Date:      / /  

Flood Zone:      BFE/Depth       

  A    B/XShaded  

  AE A1-30   C/XShaded 

  AH    D 

  AO    V 

  AR    VE V1-30 

  A99 

Notes:              

              

Vertical Datum:     

Likely Source of Flooding: 

  Stream or other source of riverine flooding  
  Ocean, lake or other source of coastal flooding  
  Sheet flow  
  Natural drainage - Site is flat or drains poorly  
  Natural drainage - Ponding, or site is low or site 
is in a bowl  

  Natural drainage- Exceptionally heavy 
precipitation overwhelmed drainage system  

  Drainage System - Undersized culvert or 
inadequate drainage feature downstream  

 
  Drainage System - Drainage from lot is blocked 
by roadbed or other feature  

  Drainage System - System can’t handle runoff 
from recent upstream development  

  Sewer backup  
  Cannot tell  
  Other (explain in notes)  

 

Notes:              

              

Likely Areas of Flood Damage: 

  Water over 1st floor - Flood level higher than floor 
level  

  Water over 1st floor - Building is on slab close to 
grade  

  Water below 1st floor - Water in crawlspace  
  Water below 1st floor - Water in enclosed area 
below elevated floor  

  Water in areas below grade - Building is a bilevel, 
split level or has finished areas below grade  

  Water in areas below grade - Building has basement 
with below grade window wells or stairwell  

  Water in areas below grade - Building has 
basement, no obvious entry point for water  

  Damage to items outside the structure-Likely 
damage to deck, bulkhead, etc.  

  Damage to items outside the structure - Outside A/C 
unit is low  

  Damage to items outside the structure - Storage 
tanks present  

  Cannot tell  
  Other (explain in notes)  

 

Notes:              
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Potential Hydraulics Impacts:   (Select all that apply) 

  Low Bridge 
  Culvert(s) 
  Storm Drainage System 
  Planned Projects 
  Pump Stations 
  Dams 

  Levees 
  Run off from U/S dev. 
  Retention Basins 
  Detention Basins 
  Other (explain in notes) 

 

Notes:              

              

 

  Adequate Clearance   

 

Mitigation Observations: 

   Possible mitigation measures observed   

Pending mitigation actions: 

(Select all that apply) 

Possible retrofitting project: 

(Select all that apply) 

Possible flood control project: 

(Select all that apply) 

    A pending flood control/drainage 
improvement project may mitigate 
the flooding 

    Community has plans to mitigate 
the structure 

    Owner has plans to mitigate the 
structure 

    Other (explain in notes) 

   Structure may be elevated 

   Structure may be dry floodproofed 

   Structure may be wet floodproofed 

   Structure may be protected by a 
barrier 

   Structure may be acquired 

   Structure may be relocated 

   Removal of undersized culvert or 
other downstream obstruction 

   Increased drainage capacity via 
channel or pumping improvements 

   Construction of a levee or other 
barrier 

   Construction of an upstream 
storage basin 

   Other (explain in notes) 

 

   No possible mitigation measures observed 

 

Additional Notes:             
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Additional Site Information Tab 
 

Property Locator/Repetitive Loss #:      

Regulatory Requirements: 

   Freeboard:         1.0 ft    3.0 ft 

      1.5 ft    Other (explain in notes) 

      2.0 ft  

Notes:              

              

 

   Code Height Restrictions  Notes:         

              

   Compensatory Storage Requirements Notes:         

              

   Other Higher Regulatory Standards Notes:         

              

 

Equipment/Contents: 

Value of Equipment and Contents: $      

Equipment - Describe contents, equipment or inventory of value:       

              

       Building Information: 

Tax ID:       Construction Date:     

Local Lot/Parcel ID:     Footprint (Sq. Ft)     

       Total Sq. Ft.:      

 

Building Market Value: 

Value:     Date of info: / /  

Source:     Source Type:    Certified Appraiser       Community Tax Record 

          Other (explain in notes) 

     Notes:          

                 

 

Building Replacement Value: 

Value:     Date of info: / /  

Source:     Notes:          
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Land Value: 

Value:     Date of info: / /  

Source:     Source Type:     Certified Appraiser       Community Tax Record 

          Other (explain in notes) 

     Notes:          

                 

 

Source of Information:   Date 

   Site Visit    / /  

   Engineering Study   / /  

   Local Official   / /  

   Owner    / /  

   Neighbor    / /  

 

Notes:              
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Elevation and Hazard Tab 
Property Locator/Repetitive Loss #:      

 

EC or Elevation Data (Complete only if you have certified data): 

Source of Information:            

Map and Panel #:             

Date of FIRM Index:    Building Diagram #:      

BFE/Depth:     Flood Zones(s): 

  A    B/XShaded  

  AE A1-30   C/XShaded 

  AH    D 

  AO    V 

  AR    VE V1-30 

  A99 

Vertical Datum:    NGVD 1929       NAVD 1988          Other  

Conversion/Comments:            

              

 

Top of bottom floor:     

Top of next higher floor:     

Bottom of lowest horizontal structural member:    

Attached garage:    

Lowest elevation of machinery and/or equipment:    

Lowest Adjacent Grade:    

Highest Adjacent Grade:    

No. of permanent openings:    

Total area of permanent opening (flood vents):    

 

Certifier’s Information: 

Name:           

License Number:       Street Address:        

Title:                 

Company Name:        City:      State:    

Telephone Number:       Zip Code:    

 

Notes:              
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Additional Flood Hazard Data: 

Date of FIS: / /   Flash Flooding:   Yes     No      Unknown 

      Flood Velocity:   ft/sec 

Date of other source: / /  In floodway:   Yes     No      Unknown 

Flood Zone Characteristics: 

Describe source (if other than FIS):   Riverine 
    Coastal  
    Sheet flow  
   Shallow floods  
   Ponding  
   Sewer backflow  
   Ice jams  
   Other  
 

Notes:              

              

 

Streambed Elevation from FIS:     

 

Freq.    Q (cfs)    Elev (ft) 

10 yr.           

50 yr.            

100 yr.            

500 yr.            

 
   Depth of 100 yr flood at site: (Automatically calculated by NT) 
 

(Flood depth is determined by subtracting the Lowest 
Adjacent Grad Elevation from the Base Flood Elevation.) 

 
Notes:              
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Claims Tab 
 

Property Locator/Repetitive Loss #:      

 

Known Claims:    [Information provided by NFIP] 

(Claims with identical dates are displayed as one claim with all payments combined.) 

   Additional Claims Filed      Claims Update Required 

Notes:             

             

             

 

Missing Claims:   

Loss Date Building Payments Contents Payments Uninsured Contents Uninsured Building 

     

     

     

     

     

     

     

     

     

 

 

Insurance/Claim Information 
[Found as an NT pop-up window OR going to View > Insurance/Claim Information] 

 

Insurance Company Number:      

NFIP Policy Number:       

Premium:    $     

 

Notes:               
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Events and Total Damages Tab  
[Add additional pages if needed for more events] 

Property Locator/Repetitive Loss #:      

(More important if detailed FIS information is not available) 

Name of Occurrence:           

Date of Event:  / /   

Frequency of Event:      

Source of Frequency Determination:           
  

Flood Depth:   Very shallow, less than 1 ft.    Deep, greater than 6 ft.    Shallow, 1 – 3 ft.    Moderate, 3 – 6 ft.  

Flood Velocity:    Slow/Moderate (<5 ft/s)      Fast (>5 ft/s) 

   Flash flood  (<1 hr)   Ice/Debris Flow        Declaration Declared 

Question for the owner: 

Were there pollutants in the flood waters that required any special cleanup?    Yes     No 

Uninsured damages:  Building: $     Contents: $     

 

Name of Event:             

Date of Occurrence:  / /  Frequency:       

Source of Frequency Determination:          

 

Flood Depth:   Very shallow, less than 1 ft.    Deep, greater than 6 ft.    Shallow, 1 – 3 ft.    Moderate, 3 – 6 ft.  

Flood Velocity:    Slow/Moderate (<5 ft/s)      Fast (>5 ft/s) 

   Flash flood  (<1 hr)   Ice/Debris Flow        Declaration Declared 

Question for the owner: 

Were there pollutants in the flood waters that required any special cleanup?    Yes     No 

Uninsured damages:  Building: $     Contents: $     

 

Name of Event:             

Date of Occurrence:  / /  Frequency:       

Source of Frequency Determination:          

 

Flood Depth:   Very shallow, less than 1 ft.    Deep, greater than 6 ft.    Shallow, 1 – 3 ft.    Moderate, 3 – 6 ft.  

Flood Velocity:    Slow/Moderate (<5 ft/s)      Fast (>5 ft/s) 

   Flash flood  (<1 hr)   Ice/Debris Flow        Declaration Declared 

Question for the owner: 

Were there pollutants in the flood waters that required any special cleanup?    Yes     No 

Uninsured damages:  Building: $     Contents: $     
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LIMITED DATA VIEW  
Address and Updates Tab  

Address Updates  

State: All 50 states plus the District of Columbia and 7 U.S. territories:  

AK  Alaska  KY Kentucky  NY New York  
AL  Alabama  LA Louisiana  OH Ohio  
AR  Arkansas  MA Massachusetts  OK Oklahoma  
AZ  Arizona  MD Maryland  OR Oregon  
CA  California  ME Maine  PA Pennsylvania  
CO  Colorado  MI Michigan  RI Rhode Island  
CT  Connecticut  MN Minnesota  SC South Carolina  
DC  District of Columbia  MO Missouri  SD South Dakota  
DE  Delaware  MS Mississippi  TN Tennessee  
FL  Florida  MT Montana  TX Texas  
GA  Georgia  NC North Carolina  UT Utah  
HI  Hawaii  ND North Dakota  VA Virginia  
IA  Iowa  NE Nebraska  VT Vermont  
ID  Idaho  NH New Hampshire  WA Washington  
IL  Illinois  NJ New Jersey  WI Wisconsin  
IN  Indiana  NM New Mexico  WV West Virginia  
KS  Kansas  NV Nevada  WY Wyoming  
AS  American Samoa    NoM Northern Mariana Islands  
DC  District of Columbia    PR Puerto Rico  
FSM  Federated States of Micronesia  RMI Republic of the Marshall Islands 
GU  Guam    VI Virgin Islands  

 
Mitigation Updates  

Field 1:  
a. The building was elevated to or above the base flood elevation (BFE).  
b. The building was elevated, but not to the BFE.  
c. The building (non-residential) was floodproofed to the BFE.  
d. The building was partially floodproofed (but not to the BFE).  
e. The building was protected by a flood control/stormwater management project.  
f. The building was replaced by a new elevated/floodproofed building.  

 
Field 2:  

g. The building was demolished, but not acquired through any program.  
h. The building was acquired and demolished as part of a program.  
i. The building was relocated out of the floodplain.  

 
Field 3:  

j. Hazard Grant Mitigation Program (HMGP)  
k. Flood Mitigation Assistance Program (FMA)  
l. Pre-Disaster Mitigation Grant Program (PDM)  
m. Repetitive Flood Claims (RFC) 
n. Sever Repetitive Loss Program (SRL) 
o. Section 1362 Acquisition Program  
p. Other FEMA Programs  
q. Increased Cost of Compliance (ICC) Coverage  
r. U.S. Housing & Urban Development (HUD) Community Development Block Grant (CDBG)  
s. U.S. Army Corps of Engineers or Natural Resources Conservation Services (NRCS) Project  
t. Other Federal Program  
u. State Program  
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v. Local Program  
w. Property Owner  
x. Natural Disaster or Fire  
y. Unknown  

 
Field 4:  

j. Hazard Grant Mitigation Program (HMGP)  
k. Flood Mitigation Assistance Program (FMA)  
l. Pre-Disaster Mitigation Grant Program (PDM)  
m. Repetitive Flood Claims (RFC) 
n. Sever Repetitive Loss Program (SRL) 
o. Section 1362 Acquisition Program  
p. Other FEMA Programs  
q. Increased Cost of Compliance (ICC) Coverage  
r. U.S. Housing & Urban Development (HUD) Community Development Block Grant (CDBG)  
s. U.S. Army Corps of Engineers or Natural Resources Conservation Services (NRCS) Project  
t. Other Federal Program  
u. State Program  
v. Local Program  
w. Property Owner  
x. Natural Disaster or Fire  
y. Unknown  

 
Site Observations Tab  

Neighborhood:  
Commercial Highway 
Commercial Office 
Commercial Retail/Downtown 
Heavy Industrial 
Light Industrial 
Residential – high density (multi family/apts) 
Residential – low density (single family) 
Residential – medium density (2-family/townhouses, rowhouses) 
Rural residential 
 

Elevated:  
Not Applicable 
At Grade 
0-1 Feet 
1-2 Feet 
2-3 Feet 
3-4 Feet 
4-6 Feet 
6-8 Feet 
8-12 Feet 
>12 Feet 
 

Land Use:  
Single-family residential 
2-4 family residential 
Multifamily residential (5 or more units) 
Commercial (highway, office, retail, downtown) 
Industrial (light, heavy) 
Institutional (hospitals, churches) 
Educational (schools, colleges) 
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Non-profit 
Public 
Semi-Public 
Transportation 
Other (explain in notes) 
 

Flooding this site will have community-wide implications:  
Important for flood warning/response (e.g. lumber supply companies) 
Important for disaster recovery 
Important for public health (e.g. wastewater treatment plant) 
Contains hazardous materials 
Contains special population (e.g. nursing home) 
Important utility service 
Other (explain in notes) 
 

Structure Type:  
Wood frame 
Engineered wood frame 
Steel 
Light steel 
Heavy steel 
Concrete 
Reinforced concrete 
Unreinforced concrete 
Masonry 
Reinforced Masonry 
Unreinforced Masonry 
Manufactured home 
Modular Housing 
Other (explain in notes) 
 

Foundation Type:  
Slab-on-grade  
Basement sub-grade on all sides  
Basement sub-grade with windows  
Basement with walkout  
Split-level - slab-on-grade  
Split-level  
Piers, posts, piles, columns, or parallel shear walls  
Piers, posts, piles, columns, or parallel shear walls w/ full or partial enclosure  
Elevated foundation walls w/full or partial enclosure  
Crawlspace – floor at or above grade on at least 1 side  
Other (explain in notes)  
Unable to determine  

 
Elevation Diagram No. (See diagrams that follow)  

1. Slab-on-grade  
2. Basement  
3. Split level slab-on-grade  
4. Other split level  
5. Piers, posts, piles, columns, parallel shear walls  
6. Piers, posts, piles, columns, parallel shear walls with enclosure  
7. Full story foundation walls with enclosure  
8. Crawlspace 
Unable to determine 
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HVAC  

Machinery (select all that apply):  
Crawlspace/under elevated floor 
Inside-in basement 
Inside-on first floor 
Inside-on second floor or higher 
Outside-At/close to grade 
Outside-Lower than first floor 
Outside-Higher than first floor 
Cannot tell 
Other (explain in notes) 
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Duct Work (select all that apply):  
Crawlspace/under elevated floor 
Inside-in basement 
Inside-on first floor 
Inside-on second floor or higher 
Outside-At/close to grade 
Outside-Lower than first floor 
Outside-Higher than first floor 
Cannot tell 
Other (explain in notes) 
 

Flood Risk and Mitigation Possibilities Tab  

Flood Risk  

Flood Zone:  
A  
AE A1-30 
AH 
AO 
AR 
A99 
B/XShaded 
C/XUnshaded 
D 
V 
VE V1-30 
 

Likely Source of Flooding:  
Stream or other source of riverine flooding  
Ocean, lake or other source of coastal flooding  
Sheet flow  
Natural drainage - Site is flat or drains poorly  
Natural drainage - Ponding, or site is low or site is in a bowl  
Natural drainage- Exceptionally heavy precipitation overwhelmed drainage system  
Drainage System - Undersized culvert or inadequate drainage feature downstream  
Drainage System - Drainage from lot is blocked by roadbed or other feature  
Drainage System - System can’t handle runoff from recent upstream development  
Sewer backup  
Cannot tell  
Other (explain in notes)  

 
Likely Areas of Flood Damage:  

Water over 1st floor - Flood level higher than floor level  
Water over 1st floor - Building is on slab close to grade  
Water below 1st floor - Water in crawlspace  
Water below 1st floor - Water in enclosed area below elevated floor  
Water in areas below grade - Building is a bilevel, split level or has finished areas below grade  
Water in areas below grade - Building has basement with below grade window wells or stairwell  
Water in areas below grade - Building has basement, no obvious entry point for water  
Damage to items outside the structure-Likely damage to deck, bulkhead, etc.  
Damage to items outside the structure - Outside A/C unit is low  
Damage to items outside the structure - Storage tanks present  
Cannot tell  
Other (explain in notes)  
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Potential Hydraulics Impacts (select all that apply):  
Low Bridge 
Culvert(s) 
Storm Drainage System 
Planned Projects 
Pump Stations 
Dams 
Levees 
Run off from U/S dev. 
Retention Basins 
Detention Basins 
Other (explain in notes) 
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DETAILED DATA VIEW 

Elevation and Hazard Tab 

 
EC or Elevation Data (complete only if you have certified data)  

Flood Zones(s):  
A  
AE A1-30 
AH 
AO 
AR 
A99 
B/XShaded 
C/XUnshaded 
D 
V 
VE V1-30 
 

State: All 50 states plus the District of Columbia and 7 U.S. territories:  

AK  Alaska  KY Kentucky  NY New York  
AL  Alabama  LA Louisiana  OH Ohio  
AR  Arkansas  MA Massachusetts  OK Oklahoma  
AZ  Arizona  MD Maryland  OR Oregon  
CA  California  ME Maine  PA Pennsylvania  
CO  Colorado  MI Michigan  RI Rhode Island  
CT  Connecticut  MN Minnesota  SC South Carolina  
DC  District of Columbia  MO Missouri  SD South Dakota  
DE  Delaware  MS Mississippi  TN Tennessee  
FL  Florida  MT Montana  TX Texas  
GA  Georgia  NC North Carolina  UT Utah  
HI  Hawaii  ND North Dakota  VA Virginia  
IA  Iowa  NE Nebraska  VT Vermont  
ID  Idaho  NH New Hampshire  WA Washington  
IL  Illinois  NJ New Jersey  WI Wisconsin  
IN  Indiana  NM New Mexico  WV West Virginia  
KS  Kansas  NV Nevada  WY Wyoming  

AS  American Samoa    NoM Northern Mariana Islands  
DC  District of Columbia    PR Puerto Rico  
FSM  Federated States of Micronesia  RMI Republic of the Marshall Islands 
GU  Guam    VI Virgin Islands  

 
Flood Zone Characteristics:  

Riverine 
Coastal  
Sheet flow  
Shallow floods  
Ponding  
Sewer backflow  
Ice jams  
Other  
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User’s Guide D-1 August 2008 

Regional Repetitive Loss Coordinators 
As of January 1, 2008 

 

REGION CONTACT NAME CONTACT 
PHONE # 

BACK-UP 
CONTACT SUPERVISOR 

I Daisy Sweeney 617-832-4788 None Designated Mike Goetz 
II 

Sharon Edwards 212-680-3633 Richard Einhorn 
732-427-1543 Bruce Swiren 

III David Odegard 215-931-5506 Richard Rein 
215-931-5732 

Marty Frengs /   
Nancy Carpenter 

IV Robert Durrin 
 770-220-5428 Jackie Bell 

770-220-5439 Susan Wilson 

V Eric Kuklewski 312-408-5230 None Designated Terry Fell 

VI Ross Richardson 
(interim) 940-898-5210 David Boston 

940-898-5348 Frank Pagano 

VII Connie Wisniewski 816-283-7013 Jim Donley 
816-283-7010 Roger Connell 

VIII Diana Heyder 303-235-4606 None Designated Mike Hillenburg 
IX Mike Hornick 510-627-7260 Sam Schultz 

510-627-7224  

 
X Jeffery Woodward 425-487-4664 

Denise Atkinson 
425-487-4677 

Steven Randolph 
425-487-4671 

Chris Jonientz-Trisler 
 

 
 
FEMA HEADQUARTERS CONTACT 
 
Errol Garren 
(202) 646-3678  
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Appendix E – NT Sample Reports 
 
 

 

The following Sample Reports were generated using the NT with 

fabricated property addresses and Property Locator Numbers for the 

purposes of providing examples in this User’s Guide. 
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Federal Emergency Management Agency
National Flood Insurance Program

NFIP REPETITIVE LOSS UPDATE WORKSHEET (AW-501)

OMB #1660-0022 EXPIRES August 31, 2010

THE INFORMATION ON THIS FORM IS BASED ON CLAIMS ON OR BEFORE:  

REPETITIVE LOSS NUMBER: 9999002 Internal Use Only A N/A FRR

NFIP COMMUNITY NAME:
LOCAL PROPERTY IDENTIFIER:

CURRENT PROPERTY ADDRESS PREVIOUS PROPERTY ADDRESS/COMMUNITY ID #

LAST CLAIMANT:

INSURED: NAMED INSURED:

DATES OF 
LOSSES:

TOTAL NUMBER OF 
LOSSES FOR PROPERTY:

REQUESTED UPDATES
MARK ALL UPDATES BELOW THAT APPLY (IMPORTANT - SEE INSTRUCTIONS)

INFORMATION PROVIDED NOT SUFFICIENT TO IDENTIFY PROPERTY

COSMETIC CHANGES REQUIRED TO THE ADDRESS:

PROPERTY NOT IN OUR COMMUNITY OR JURISDICTION:

FLOOD PROTECTION PROVIDED

NO BUILDING ON PROPERTY

DUPLICATE LISTING WITH RL NUMBER: COMBINE AS ONE LISTING.

HISTORIC BUILDING: 

1.

2.

3.

4.

5.

6.

7.

BEACHCOMBER, CITY OF CID#: 099992

123 10TH PLACE SE, 123 10TH PLACE SE
DISASTERVILLE, DC 999930000

DOE, JOHN AND JAYNE 

 ANDERSON, HANS C.          

123 10TH PLACE SE, 123 2ND ST
DISASTERVILLE, DC 999930000
CID#: 099992

1/2/1999, 10/8/1996, 3/13/1993, 8/31/1985
4

Choose this update if all attempts to locate the property fail.  Please describe the steps you took to locate the property in 
the comments section below.

Update the address shown above and/or add your local 
alternative property identifier such as a Tax Assessor #.

Choose this update if you have positively determined that the property shown is not located in your community.  
Please provide the correct NFIP community name and if known the NFIP Community ID Number.  If available, please 
attach a map showing the property location.

ASSIGN TO NFIP COMMUNITY NAME: NFIP COMMUNITY ID#:

Choose this update only if some type of structural intervention has occurred to the building, property or the source of 
flooding that protects the building from future events similar to those that occurred in the past.  The correction must be 
supported by documentation such as an Elevation Certificate and the Mitigation action and funding information below 
must be provided.
Mitigation Action 1.) Source of Primary Mitigation Funding 3.) Secondary Source of Funding 3.)

Choose this update only if the property in question can be positively identified as the site of the previously flooded 
building and documentation is available to support that an insurable building no longer exists at this site.  The 
correction must be supported by documentation such as a Demolition or Relocation Permit and the Mitigation 
information below must be provided.
Mitigation Action 2.) Source of Primary Mitigation Funding 3.) Secondary Source of Funding 3.)

Choose this update to identify two or more separate listings that are for the same building.  List all other RL numbers 
that are duplicates to this property.  Please indicate which address shown is the correct address to use.

Choose this update if you know the building is listed on a State or National Historic Registry.

COMMENTS SECTION

235.1234Lat: 555.6624Long: Local Lot/Parcel ID:

5/31/2008



Basic Report
Property Locator / Rep Loss # 9999006

Longitude: 112.5689

Community Name: BEACHCOMBER, CITY OF

 97 BIRCHWOOD ST, DISASTERVILLE, DC  99993

 Mitigation Updates

Top of Bottom Floor:

Top of Next Higher Floor:

BFE/Depth: 10Flood Zone: AO

 Claims Summary

Likely Source of Flooding:

Likely Areas of Flood Damage:

Natural drainage-Site is flat or drains poorly (Property located in low spot 
at end of culdesac)

Water in areas below grade-Building has basement, no obvious entry 
point for water(Water flows in through garage and fills up basement)

Occupancy:

Lowest Adjacent Grade:

Pending Mitigation Actions:

SINGLE FMLY

Unable to Locate Property

Historic Building

Flood Protection Provided

No Building on Property

Current Insured's Name: MICHAEL D. & TUESDAY B.       BLOOMIN

Name of Last Claimant: MICHAEL BLOOMINGDALE

Total 

$10,325.58

Field FEMA Field FEMA
Additional Research Needed

Mitigation Observed:

Mitigation Verified:

Duplicate Listing with PL #:Updates Made

Potential Hydraulics Impacts:

Storm Drainage System,(Inadequate catch basin)

1:

2:

3:

4:

1:

2:

3:

4:

Latitude: 223.2456

Possible mitigaton measures observed

Structure may be protected with a retrofitting project:

Flooding may be relieved by a flood control project:

Building 

$7,488.14

Contents 

$2,837.44

Total 
Payments 
Made:

Single-family residential

Bottom of Lowest Horizontal Structural Member:

Date

1/2/1999

Building 

$2,592.05

Contents 

$1,158.49

Total 

$3,750.54

3/13/1993 $2,484.28 $244.00 $2,728.28

8/31/1985 $1,215.25 $1,434.95 $2,650.20

6/18/1982 $1,196.56 $0.00 $1,196.56

Residence: Primary

# Claims per NFIP: 4

 Mitigation Observations

Local Lot/Parcel ID: Lot 7, Block 6

Tax ID: 99-22-56-99

County: KELTY COUNTY

CID #: 099992

 Site Information

 Flood Risk and Elevation

 Most Recent Claims

No. of Stories: 2 Const. Date: 1/1/1960

FIRM: PREOccupied: Yes

Total Sq. Ft.: 0

Building Market: $0.00 Land: $0.00

Structure: Wood Frame

(Condition) Good  (optional minor repairs)

Land Use:

Foundation: Basement with walkout

EC Diagram #:

(Condition) Good  (optional minor repairs)

Values:

7/17/2008 Page 1 of 1FEMA-NT



Benefit-Cost

BEACHCOMBER, CITY OF / 099992Community Name / CID#:

1# 9999002

123 10TH PLACE SE, 123 10TH PLACE SE
DISASTERVILLE, DC 999930000

235.1234Latitude:Property Locator / 
Rep Loss #:

Address

Number of Stories:Structure Type:

Yes Tot. Floor Area (sq ft):

Land Use? Single-family residential

2200Construction DateOccupied?

Wood Frame 2 Basement:

Foundation Type: Slab-on-grade

No

HVAC Location: Ductwork Location:

Other Structures on the Lot? • Deck

Land:

Building Market:

Reported Value:

Building Replacement:

$78,000
Equipment/Content:

Notes:

Base Flood Elevation:Flood Zone:

Natural drainage-Site is flat or drains poorlySource of Flooding:

Potential Hydraulics Impact: Notes:

Top of Next Higher Floor:Top of Bottom Floor:

Bottom of lowest horizontal 
structural member:

Highest Adjacent Grade:Lowest Adjacent Grade: 10.00
Lowest elevation of 
machinery and/or equipment:

Date of FIS:

Other Source of Flood Data:

Date of Other Source:

10 yr.

50 yr.

100 yr.

500 yr.

0.0

0.0

0.0

0.0

0.0

0.0

0.0

0.0

555.6624Longitude:

Flood Frequency Discharge (cfs) Elevation (ft)

Event Name Date Freq. Frequency Source Depth Velocity

As of Date

5/31/2008

Tax ID:

Local Lot/Parcel ID:

Source of EC or Elevation data:

Value

Streambed Elevation:

Page 1 of 3647/17/2008 3:30:04 PM FEMA-NT



CID Summary

CID #099992  BEACHCOMBER, CITY OF

Property Locator / 
Rep Loss #  Address City State Zip

9999002 DISASTERVILLE DC 999930000123 10TH PLACE SE, 123 10TH PLACE SE

9999003 DISASTERVILLE DC 999930000CHOWDER EIGHT UNIT 3 FIRE PL

9999004 DISASTERVILLE DC 999936 CHOWDER HOUSE N SIDE CENTRAL AVE & 
FRIENDSHIP

9999005 DISASTERVILLE DC 99993500 N CHOWDER DRIVE

9999006 DISASTERVILLE DC 9999397 BIRCHWOOD ST
Tax ID: 99-22-56-99
Local Lot/Parcel ID: Lot 7, Block 6

9999007 DISASTERVILLE DC 99993559 MAYJAR LN

9999008 DISASTERVILLE DC 999930000215 BLACKWOOD ST

9999009 DISASTERVILLE DC 9999100002008 FEMA BLVD
Tax ID: 28-53-992-99
Local Lot/Parcel ID: Lot 5, Block 7

9999010 DISASTERVILLE DC 9999300002008 FEMA BLVD

9999011 DISASTERVILLE DC 9999300002008 FEMA BLVD

9999012 DISASTERVILLE DC 99993LAKESIDE ELEVEN, 95 FIRE PL UNIT 6

9999013 DISASTERVILLE DC 99993000098 BIRCHWOOD ST

9999014 DISASTERVILLE DC 999930000BIRCHWOOD ST BLK A LOT J

9999015 DISASTERVILLE DC 999930000FRIENDSHIP & FIRST PLACE

9999016 DISASTERVILLE DC 999930000S MAIN STREET AND FRIENDSHIP, BEACH CONDO 
UN 4 LT 7 & 9

9999017 DISASTERVILLE DC 999930000S MAIN STREET AND FRIENDSHIP, BEACH CONDO 
UN 3 LT 7 & 9

9999018 DISASTERVILLE DC 999930000S MAIN STREET AND FRIENDSHIP, BEACH CONDO 
UN 2 LT 7 & 9

9999019 DISASTERVILLE DC 999930000S MAIN STREET AND FRIENDSHIP, BEACH 
CONDOMINIUM

9999020 DISASTERVILLE DC 99993UNIT 6 LAKESIDE SEVEN CONDOMINIUM, FIRE 
AVENUE AND 10TH PLACE

Page 1 of 187/17/2008 2:17:27 PM FEMA-NT



Community Summary

BEACHCOMBER, CITY OF/099992Community Name / CID #
Number of Properties 

Inventoried

364

FEMAField Verified

Incorrect Community and/or Address

Unable to Locate Property

Flood Protection Provided

No Building on Property

Historic Building

0
0
0
0
0

0
0
0
0

N/A

Number VerifiedNumber Observed

Appears to have been elevated

Appears to have been floodproofed

Floodwall, berm, or other type of barrier

Lower area appears to have been modified

Drainage improvements appears to have been made

0
0
0
0
0

Flood control project reduced the threat

Owner/neighbor/local official reported mitigation action taken

Further research needed

Other

0
0
0
0

Stream

Coastal

Sheet flow

Natural drainage

Drainage system

1
0
0
0
0

Sewer backup

Cannot Tell

0
0
0

Public

Multi-family residential (5 or more)

2-4 family residential

0

0
0

Non-profit

Commercial (hwy, ofc, retail, etc.)

0

0

Institutional (hospitals, churches)

Industrial (light, heavy)

0
0

Semi-Public 0

Single-family residential 1

Educational (schools, colleges) 0

Number of Properties Requiring Updates

Number of Properties Reported as Mitigated

Number of Properties By Land Use

Number of Properties Inventoried by CID #

Number of Properties By Flood Source

New

0
0
0
0

N/A

0
0
0
0
0
0
0
0
0

Transportation 0

Other 0
Open space 0

Validated
Validated Uninsured

Validated Nonresidential

Validated Nonresidential 
Uninsured

Pending183
0
0

0

0
Pending Uninsured

Pending Nonresidential

Pending Nonresidential 
Uninsured

0
0

0

Number of Properties By SRL Type

Updated

0
0
0

0

0
0
0

0

Inspected

Mitigated

Insured

Total Claims

1
0

280

1,744 $44,404,857.55

Number of Properties

Number UpdatedNumber

Total NFIP Payments

Other

Page 1 of 87/17/2008 1:04:40 PM FEMA-NT



The following files are associated with the listed Rep Loss #, but were not found in the NFMDCT folder.  

To correct this, you can either locate the file and move it into the NFMDCT folder, or you can remove the 
association to the property.  

To remove the association to the property, navigate to the Images (or Documents) option from the View menu 
(in either the Limited or Detailed Views).  For images, right click on the file and select Delete.  For Documents, 
highlight the file and click the Delete button.

Missing Image and Document Files

Type Filename

# 9999009

RL9999009_3.JPG1. Image
RL9999009_2.JPG2. Image
RL9999009_1.JPG3. Image
RL9999009_4.JPG4. Image

# 9999010

RL9999010_2.JPG1. Image
RL9999010_1.JPG2. Image
RL9999010_3.JPG3. Image

# 9999011

RL9999011_2.JPG1. Image
RL9999011_1.JPG2. Image
RL9999011_3.JPG3. Image

Total Missing Files: 10

Page 1 of 17/17/2008 3:44:31 PM FEMA-NT



Mitigation Report
BEACHCOMBER, CITY OF / 099992Community Name / CID#:

1# 9999006
97 BIRCHWOOD ST

223.2456Latitude:

Property Locator / Rep Loss # # of Stories:

Structure:

Yes

1/1/1960

Total Sq. Ft.:

Land Use: Single-family residential

0

Const.Date:

Occupied:

Wood Frame

2

Basement:

Foundation Basement with walkout

Yes

HVAC:

Ductwork:

Other Structures:

Land:Building Market:

Reported Value:Bldg Replacement: $72,600

$0Equipment/Contents

Base Flood Elev.:Flood Zone: 10
Source of Flooding:

Potential Hydraulics 
Impact:

Top of Next Higher Floor:

Top of Bottom Floor: Bottom of lowest horizontal structural member:

Highest Adjacent Grade:Lowest Adjacent Grade:

Lowest elevation of machinery and/or equipment

Date of FIS: Other Source of Flood Data:

10 yr.

50 yr.

100 yr.

500 yr.

112.5689Longitude:

Flood Frequency Discharge (cfs) Elevation (ft)

Event Name Date Freq. Frequency Source Depth Velocity

 As of Date   

5/31/2008

99-22-56-99Tax ID:

Lot 7, Block 6Local Lot/ 
Parcel ID:

Community Development FilesEC/Elev. data source:

Value 

KELTY COUNTYCounty:

Good  (optional minor repairs)

(Condition) Good  (optional minor repairs)

(Condition) PREFIRM:

SINGLE FMLYOccupancy:

PrimaryResidence:

EC Diagram #:

  As of Date   Value 

Areas of Damage:

Insured's Name:

Last Claimant:

# Claims per NFIP:

Payments Made: Building Contents Total

Claim Information

DISASTERVILLE, DC 99993

Inside-in basement, Inside-on first floor
Shed

Inside-in basement

AO

Storm Drainage System, (Inadequate catch basin)

Water in areas below grade-Building has basement, no obvious entry point for water (Water flows in through 
garage and fills up basement) 

Natural drainage-Site is flat or drains poorly (Property located in low spot at end of culdesac) 

Locally funded study (4/1/2008)

0.0
0.0
0.0
0.0

0.0
0.0
0.0
0.0

7,488 2,837 10,326

MICHAEL D. & TUESDAY B.       BLOOMINGDALE
MICHAEL BLOOMINGDALE
4

Hurricane Alice 7/1/2008 USACE event analysis Very Shallow,less than 1 ft. Slow/Moderate ( <5 ft/s)

Page 1 of 17/17/2008 2:27:57 PM FEMA-NT



Photo Summary

Property Locator/Rep Loss # 9999012

Property Address: 

Community Name/CID#: 

LAKESIDE ELEVEN, 95 FIRE PL UNIT 6
DISASTERVILLE, DC 99993
Latitude: Longitude: 

BEACHCOMBER, CITY OF / 099992

235.6678 112.5689
Tax ID: 

Local Lot/ 
Parcel ID: 

15.678.231.55
Lot 1, Block 2, Peabody Edition

Total Number of Claims per NFIP: 4

Payments
 Made

$34,589
Contents: $11,596

Total: $46,185

Building:

RL9999012_3.JPG
(1 of 3)

RL9999012_2.JPG
(2 of 3)

RL9999012_1.JPG
(3 of 3)
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Properties Requiring Action/Update

Community Name/CID#: BEACHCOMBER, CITY OF / 099992
Property Address: 123 10TH PLACE SE, 123 10TH PLACE SE

DISASTERVILLE, DC 999930000

Property Locator/Rep Loss # 9999002

Latitude: 235.1234
Longitude: 555.6624

ACTION/UPDATED ITEMS

BEACHCOMBER, CITY OF 099992
    
DISASTERVILLE, DC 999930000

Address Updates

New Community: New CID:

New Address:

Updates Made

New City,State Zip:

Current Insured's Name: ABBOTT AND          COSTELLO
Last Claimant's Name: ABBOTT AND COSTELLO

Tax ID:

Local Lot/Parcel ID:

Inspection Date: 7/17/2008

Community Name/CID#: BEACHCOMBER, CITY OF / 099992
Property Address: CHOWDER EIGHT UNIT 3 FIRE PL

DISASTERVILLE, DC 999930000

Property Locator/Rep Loss # 9999003

Latitude: 123.4567
Longitude: 321.6547

ACTION/UPDATED ITEMS

a

j
p

BEACHCOMBER, CITY OF 099992
    
DISASTERVILLE, DC 999930000

Address Updates

New Community: New CID:

New Address:

Mitigation 
Observed: 

Mitigation Verified: 

Flood Protection Provided:

Historic Building:

X

Field FEMA Field

1:

3:

4:

Drainage improvements appear to 
have been made

Yes

Updates Made

New City,State Zip:

Current Insured's Name:

Last Claimant's Name: JACK CORONATO

FEMA

Mitigation and Funding Codes*

Tax ID:

Local Lot/Parcel ID:

Inspection Date: 7/17/2008

Page 1 of 37/17/2008 2:54:13 PM FEMA-NT



Properties Requiring Action/Update

Community Name/CID#: BEACHCOMBER, CITY OF / 099992
Property Address: 6 CHOWDER HOUSE N SIDE CENTRAL AVE & 

FRIENDSHIP
DISASTERVILLE, DC 99993

Property Locator/Rep Loss # 9999004

Latitude:

Longitude:

ACTION/UPDATED ITEMS

Needs demolition permit - see photo.

g
v
y

BEACHCOMBER, CITY OF 099992
    
DISASTERVILLE, DC 99993

Address Updates

New Community: New CID:

New Address:

Additional Research Needed: 

No building on Property:

Historic Building:

X

Field FEMA Field

2:

3:

4:

Updates Made

New City,State Zip:

Current Insured's Name:

Last Claimant's Name: JOHNSON ASSOCIATES

FEMA

Mitigation and Funding Codes*

Tax ID:

Local Lot/Parcel ID:

Inspection Date: 7/17/2008

Community Name/CID#: BEACHCOMBER, CITY OF / 099992
Property Address: 559 MAYJAR LN

DISASTERVILLE, DC 99993

Property Locator/Rep Loss # 9999007

Latitude:

Longitude:

ACTION/UPDATED ITEMS

Address doesn't exist

BEACHCOMBER, CITY OF 099992
    
DISASTERVILLE, DC 99993

Address Updates

New Community: New CID:

New Address:

Additional Research Needed: 

Unable to Locate Property: X

Field FEMA Field

Updates Made

New City,State Zip:

Current Insured's Name: JACK J                   LEYMAN
Last Claimant's Name: JACK J LEYMAN

FEMA

Mitigation and Funding Codes*

Tax ID:

Local Lot/Parcel ID:

Inspection Date: 7/17/2008

Page 2 of 37/17/2008 2:54:13 PM FEMA-NT



Properties Requiring Action/Update

Community Name/CID#: OCEAN ISLES, TOWN OF / 099993
Property Address: 1409 DOVE AVE

WATER ISLAND, DC 99498

Property Locator/Rep Loss # 9999183

Latitude: 234.1265
Longitude: 213.2456

ACTION/UPDATED ITEMS

g
n
p

OCEAN ISLES, TOWN OF 099993
    
WATER ISLAND, DC 99498

Address Updates

New Community: New CID:

New Address:

No building on Property:

Historic Building:

X

Field FEMA Field

2:

3:

4:

Updates Made

New City,State Zip:

Current Insured's Name: FRODO                    HOBBIT
Last Claimant's Name: FRODO HOBBIT

FEMA

Mitigation and Funding Codes*

Tax ID:

Local Lot/Parcel ID:

Inspection Date: 7/17/2008

* Key to Mitigation Codes:
a. The building was elevated to or above the Base Flood 
Elevation (BFE).
b. The building was elevated but not to the BFE.
c. The building (non-residential) was floodproofed to the BFE.
d. The building was partially floodproofed (but, not to the BFE).
e. The building was protected by a flood control/stormwater 
mgmt project.
f. The building was replaced by a new elevated/floodproofed 
building.
g. The building was demolished, but not acquired through any 
program.
h. The building was acquired and demolished as part of a 
program.
i. The building was relocated out of the floodplain.

* Key to Funding Codes:
j. Hazard Mitigation Grant Program (HMGP)
k. Flood Mitigation Assistance Program (FMA)
l. Pre-Disaster Mitigation Grant Program (PDM)
m. Repetitive Flood Claims (RFC)
n. Severe Repetitive Loss Program (SRL)
o. Section 1362 Acquisition Program
p. Other FEMA Programs
q. Increased Cost of Compliance (ICC) coverage
r. U.S. Housing  Urban Development (HUD) Community Development Block Grant (CDBG)
s. U.S. Army Corps of Engineers or Natural Resources Conservation Service (NRCS) Project
t. Other Federal Program
u. State Program
v. Local Program.
w. Property Owner
x. Natural Disaster or Fire
y. Unknown
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Instructions to complete Worksheet A:  Technical Considerations Scorecard
1.  For each of the questions, based on the property information, put a check mark in the appropriate box in the "Response" column.
2.  For the row with a check mark in the "Response" column, check all boxes that are not blacked out.
3.  After completing the questions, review each of the mitigation measures columns.  Select the "Appropriate Mitigation Measures" box only for those columns that do not have any blacked out boxes in the 
selected response row.

Question Response

Drainage
Improve-
ments Barriers

Wet 
Flood-
proofing

Dry 
Flood-
proofing Elevation Relocation Acquisition Comments

Worksheet A: Technical Considerations Scorecard

Date Prepared:
Property Owner Name:
Property Address:
Repetitive Loss Property Locator Number:
Prepared by:

Legend

Mitigation measure is not appropriate.

Mitigation measure may be appropriate and requires additional consideration.

Mitigation measure is appropriate.

NT Reference indicates where the information may be found in the National Tool.

Date Property Visited: 7/17/2008

123 10TH PLACE SE, 123 10TH PLACE SE, DISASTERVILLE, DC 999930000
9999002

7/17/2008

Janet Inspector

1.  What is the structure type?

2.  What is the condition of the 
structure?

3.  What is the foundation type?

4.  What is the number of stories?

Wood Frame / Metal / Other

Concrete / Masonry / Brick Faced

Manufactured Home

Good

Fair

Poor

Slab-on-Grade
  (Diagram 1, 3, 6 or 7)

Basement/Split Level
  (Diagram 2 or 4)

Piers, Posts, Columns, or 
Crawlspace (Diagram 5 or 8)

NT Reference - Limited Data View, 
Site Observations tab

NT Reference - Limited Data View, 
Site Observations tab

NT Reference - Limited Data View, 
Site Observations tab

Diagram numbers refer to Elevation 
Certificate found in the NT.

1-2

3 or more

NT Reference - Limited Data View, 
Site Observations tab
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Question Response

Drainage
Improve-
ments Barriers

Wet 
Flood-
proofing

Dry 
Flood-
proofing Elevation Relocation Acquisition Comments

Worksheet A: Technical Considerations Scorecard

Date Prepared:
Property Owner Name:
Property Address:
Repetitive Loss Property Locator Number:
Prepared by:

Legend

Mitigation measure is not appropriate.

Mitigation measure may be appropriate and requires additional consideration.

Mitigation measure is appropriate.

NT Reference indicates where the information may be found in the National Tool.

Date Property Visited: 7/17/2008

123 10TH PLACE SE, 123 10TH PLACE SE, DISASTERVILLE, DC 999930000
9999002

7/17/2008

Janet Inspector

5.  What is the building footprint?

6.  What is the flood protection 
depth?

7.  Does flash flooding occur at the 
project site?

8.  What is the flood velocity?

9.  Is the structure located in the 
floodway?

NT Reference -Detailed Data View, 
Additional Site Information tab

< 2,500 sq ft

> 2,500 sq ft

NT Reference -Detailed Data View, 
Elevation and Hazard  tab

Deep ( > 6 ft)

Moderate (3 to 6 ft)

Shallow (< 3 ft)

NT Reference -Detailed Data View, 
Elevation and Hazard  tab

Yes

No

Fast ( > 5 fps)

Slow/Moderate ( < 5 fps)
NT Reference -Detailed Data View, 
Elevation and Hazard  tab

NT Reference -Detailed Data View, 
Elevation and Hazard  tab

Yes

No

Appropriate Mitigation Measures
fps = feet per second
ft = feet

sq ft = square feet
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H (6 pts)

(4 pts)M

(2 pts)L

H (6 pts)

(4 pts)M

(2 pts)L

H (6 pts)

(4 pts)M

(2 pts)L

H (6 pts)

(4 pts)M

(2 pts)L

H (6 pts)

(4 pts)M

(2 pts)L

H (6 pts)

(4 pts)M

(2 pts)L

H (6 pts)

(4 pts)M

(2 pts)L

H

M

L
pts

Drainage Improvements

Wet Floodproofing

Dry Floodproofing

Elevation

Relocation

Acquistion

Barriers

(3 pts)

(2 pts)

(1 pt)

H

M

L

(3 pts)

(2 pts)

(1 pt)

H

M

L

(3 pts)

(2 pts)

(1 pt)

H

M

L

(3 pts)

(2 pts)

(1 pt)

H

M

L

(3 pts)

(2 pts)

(1 pt)

H

M

L

(3 pts)

(2 pts)

(1 pt)

H

M

L

(3 pts)

(2 pts)

(1 pt)

H

M

L

(3 pts)

(2 pts)

(1 pt)

H

M

L

(3 pts)

(2 pts)

(1 pt)

H

M

L

(3 pts)

(2 pts)

(1 pt)

H

M

L

(3 pts)

(2 pts)

(1 pt)

H

M

L

(3 pts)

(2 pts)

(1 pt)

H

M

L

(3 pts)

(2 pts)

(1 pt)

H

M

L

(3 pts)

(2 pts)

(1 pt)

H

M

L

(3 pts)

(2 pts)

(1 pt)

Mitigation Measures
Technical 

Considerations* Relative Costs*
Human 

Intervention
Annual 

Maintenance
Total Score

Worksheet B: Appropriate Mitigation Measures
Date Prepared:
Property Owner Name:
Property Address:
Repetitive Loss Property Locator Number:
Prepared by:

Date Property Visited: 7/17/2008

123 10TH PLACE SE, 123 10TH PLACE SE, DISASTERVILLE, DC 999930000
9999002

7/17/2008

Decision Factors - LOWEST score is most appropriate - see Reverse for Notes

Instructions to complete Worksheet B:  Appropriate Mitigation Measures
1.  List the mitigation measures from the "Appropriate Miigation Measures" row from Worksheet A, Technical Considerations Scorecard (all checked boxes in 
last row of Worksheet A).
2.  Using information from Chapters 4 through 10 of FEMA 551, Selecting Appropriate Mitigation Measures for Floodprone Structures, rank each measure as 
High, Moderate, or Low.  See "Tips to Rank Mitigation Measures" on next page for additional information.
3.  Check the appropriate box (High, Moderate or Low) under each of the decision factors.
4.  Total the points for each mitigation measure.  The LOWEST total points indicates the most appropriate mitigation measure(s).
5.  Include notes describing how the determination was made for a particular ranking.

* NOTE:  Since Technical Considerations and Relative Costs are more significant in selecting appropriate mitigation measures(s), they are weighted higher than 
Human Intervention and Annual Maintenance.

H

M

L

(3 pts)

(2 pts)

(1 pt)

H

M

L

(3 pts)

(2 pts)

(1 pt)

H

M

L

(3 pts)

(2 pts)

(1 pt)

H

M

L

(3 pts)

(2 pts)

(1 pt)

H

M

L

(3 pts)

(2 pts)

(1 pt)

H

M

L

(3 pts)

(2 pts)

(1 pt)

pts

pts

pts

pts

pts

pts

Janet Inspector
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Tips to Rank Mitigation Measures (Worksheet B cont.)

Technical Considerations

Use the responses in Worksheet A, Technical Considerations Scorecard, to determine a ranking of High, Moderate or Low for each  
mitigation measure.

If there are no grayed out boxes checked for a mitigation measure, the technical consideration ranking is Low.
If there are 1 or 2 grayed out boxes checked for a mitigation measure, the technical considerations score is Moderate.
If there are3 or more grayed out boxes checked for a mitigation measure, the technical consideration score is High.

List any considerations in the implementation process that could be a limiting factor or clear constsraint in the Notes section.

Relative Costs

Rank each of the mitigation measures based on the estimated cost to address the flood risk and the likelihood of cost-effectiveness.  
Chapters 4 through 10 include information to rank each mitigation measure measure based on FEMA 312, Homeowner's Guide to 
Retrofitting:  Six Ways to Protect Your House From Flooding, and FEMA 259, Engineering Principles and Practices of Retrofitting 
Floodprone Residential Structures.  Low cost indicates Low ranking and high cost indicates High ranking.

Need for Human  Intervention

This reflects the need for human intervention to operate the mitigation measure and the warning time to conduct the required activity.  
Generally, the more "passive" the system (i.e., requiring the least human interaction), the more reliable the system will be over time, thereby 
resulting in a Low ranking.  Mitigation measures that require human intervention, such as barriers and dry floodproofing, receive a High 
ranking.

Need for Annual Maintenance

This reflects the level of effort of annual maintenance required by each mitigation measure.  Similar to human intervention, less annual 
maintenance results in a Low ranking.

NOTE:  If two or more mitigation measures tie with the lowest score, other decision factors should be considered in determining the most 
appropriate mitigation measure(s).  These considerations include, but are not limitrd to aestheteics; access to site; housing of occupants 
during the project; compliance with all applicable codes, ordinances, and regulations; historic preservation concerns; and availability of 
contractors.

The other decision factors should be listed in the Comments section of Worksheet C.

Mitigation Measures Technical Considerations

NOTES:

l

l

l
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Severe Repetitive Loss (SRL) Structures**

This report includes information from the NFIP Bureau and Statistical Agent based on the displayed NFIP data as of date.  SRL 
designations are subject to change.

For ALL Severe Repetitive Loss Structures

BEACHCOMBER, CITY OF / 099992Community Name/CID#:

 1-15 DAVIDSON ST, FLOODING BEACH, DC  99997-0000

Special Direct Facility
$143,000

Date Building Contents Total

Currently Issured:

Latitude:

1#

Longitude:

Reported Value:

9999500Property Locator/Rep Loss #:

5# Claims per NFIP:

Tax ID:

Local Lot/ Parcel ID:

SINGLE FMLYOccupancy:

5/31/2008NFIP data as of:

*

Category: V-Validated

NoPhoto:

(9 most recent claims )

NoneInspection Date:

1/2/1999 $9,852 $1,445 $11,297
10/8/1996 $16,112 $4,442 $20,555
3/13/1993 $10,994 $4,619 $15,613
8/31/1985 $1,932 $0 $1,932
6/18/1982 $4,357 $3,211 $7,568

$43,247 $13,718 $56,964Total Payments Made:

$8,649 $2,744 $11,393Average Payment per Claim:

ROCKY  PLAZA UNITS 1 - 11 1 SAMSA AVE, FLOODING BEACH, DC  99997-0000

Special Direct Facility
$159,959

Date Building Contents Total

Currently Issured:

Latitude:

2#

Longitude:

Reported Value:

9999501Property Locator/Rep Loss #:

5# Claims per NFIP:

Tax ID:

Local Lot/ Parcel ID:

SINGLE FMLYOccupancy:

5/31/2008NFIP data as of:

*

Category: V-Validated

NoPhoto:

(9 most recent claims )

NoneInspection Date:

6/21/2003 $17,322 $4,409 $21,731
9/14/2001 $3,969 $4,944 $8,914
7/22/2001 $5,598 $3,764 $9,363

11/16/1997 $6,504 $5,203 $11,706
7/20/1995 $4,413 $11,004 $15,417

$37,806 $29,324 $67,130Total Payments Made:

$7,561 $5,865 $13,426Average Payment per Claim:
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Potential Mitigation Options

Structure may be elevated

Construction of an upstream storage basin

A pending flood control/drainage improvement project may mitigate the flooding.

Pending Mitigation Actions:

Structure may be Protected with a Retrofitting Project:

Flooding may be Relieved by a Flood Control Project:

Property Address

Community Name/CID#: 

CHOWDER EIGHT UNIT 3 FIRE PL

Latitude: 

Longitude: 

Owner Interested in Mitigation? 

BEACHCOMBER, CITY OF / 099992

123.4567
321.6547

DISASTERVILLE, DC 999930000

1# Property Locator/Rep Loss #: 9999003

Current Insured's Name: 

Last Claimant's Name: JACK CORONATO

Tax ID: 

Local Lot/Parcel ID: 
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 F-1  

SAMPLE PRE-NOTIFICATION LETTER FOR FEMA OR FEMA CONTRACTOR 
FIELD CREWS DOING MITIGATION DATA COLLECTION 

 
 

U.S. Department of Homeland Security 
500 C Street, SW  

Washington, D.C. 20472 
 

 
[DATE] 
 
[Name] 
[Address] 
[City, State, Zip Code] 
 
Dear [Resident] 
 

Your property is either currently, or at some point in the past was, insured by the National Flood 
Insurance Program (NFIP) for damage from flooding. Flood insurance is underwritten by the National 
Flood Insurance Program (NFIP), a program that is administered by the Federal Emergency Management 
Agency (FEMA). FEMA has identified structures that have sustained repetitive flooding and have 
received claims payments on at least two occasions.  

The NFIP allows occupants and owners with property vulnerable to flooding to purchase flood insurance; 
private companies generally do not underwrite flood insurance because of the high risk involved. In order 
to continue to keep flood insurance premiums affordable, FEMA and the NFIP must try to address those 
structures that are repetitively flooded.  

[AGENCY OR CONTRACTOR ON BEHALF OF AGENCY] is currently surveying these repetitively 
flooded properties to collect data that will help FEMA understand why these structures are vulnerable to 
flooding and damages, and what mitigation measures may be feasible to protect them from future 
damages.  

This letter is an early notification that you will be visited by a representative of [AGENCY 
ORCONTRACTOR ON BEHALF OF AGENCY] within a few weeks. That person will have 
identification and a copy of a letter similar to this one confirming his or her authorization to conduct this 
survey on behalf of FEMA.  

The [AGENCY OR CONTRACTOR ON BEHALF OF AGENCY] will need about 30 minutes to 
observe features about the building’s construction, assess the building’s flood vulnerabilities, and take a 
few photos.  

We look forward to your cooperation in this important data collection effort. If you have any questions 
regarding this survey, please contact [REGIONAL RL COORDINATOR OR PROJECT OFFICER] at 
[telephone number].  

 
Sincerely, 
 
 
 
 
FEMA Project Officer  
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SAMPLE LETTER FOR FEMA OR FEMA CONTRACTOR FIELD CREWS 

DOING MITIGATION DATA COLLECTION 
 
 

U.S. Department of Homeland Security 
500 C Street, SW 

Washington, D.C. 20472 
 
 
 
 

 
[DATE] 
 
[Name] 
[Address] 
[City, State, Zip Code] 
 
Dear [Resident]: 
 
Your property has been identified as having experienced repetitive damage and losses from flooding and 
is either currently or at some point in the past was insured by the National Flood Insurance Program 
(NFIP) for damage from flooding. The National Flood Insurance Program (NFIP), a program that is 
administered by the Federal Emergency Management Agency (FEMA), underwrites flood insurance. 
FEMA has identified structures that have sustained repetitive flooding and have received claims payments 
for two or more events. 
 
[AGENCY OR CONTRACTOR ON BEHALF OF AGENCY] is currently surveying these repetitively 
flooded properties to collect data that will help FEMA understand why these structures are vulnerable to 
flooding and damages, and what mitigation measures may be feasible to protect them from future 
damages. This letter is a confirmation that [NAME AND AGENCY OF INSPECTOR] is authorized to 
conduct this survey on behalf of FEMA. [NAME and/or AGENCY] will have proper photo identification 
with them and a copy of this letter. The data collection effort will take approximately 30 minutes and will 
include collection of information about the building’s construction and flood vulnerabilities. Some photos 
will also be taken. 
 
We look forward to your cooperation in this important data collection effort. If you have any questions 
regarding this survey, please contact [REGIONAL RL COORDINATOR OR PROJECT OFFICER] at 
[telephone number]. 
 
Sincerely, 
 
 
 
 
FEMA Project Officer 
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SAMPLE LETTER FOR LOCAL AGENCIES WITH FIELD CREWS DOING 
MITIGATION DATA COLLECTION 

 
[DATE] 
 
Dear [Resident]; 
 
[ENTER AGENCY’S NAME or CONSULTANT ON BEHALF OF….] is conducting a study of 
properties that may be at risk for repetitive flood damage. The outcome of the study will identify 
structures in need of flood mitigation, determine what mitigation measures may be appropriate for each 
structure, and may develop an initial cost estimate for providing the recommended measure(s). 
 
Mitigation measures may include elevating buildings, wet or dry flood proofing, relocation, acquisition, 
or construction of flood control structures. Upon completion of the study [ENTER AGENCY] plans to 
apply for Federal Grants and obtain the additional local cost share necessary to assist willing property 
owners in mitigating their flood prone buildings.  
 
The study involves the collection of the following property level data elements: 
 
1. Building Permit Records (including application and associated materials) 

• Date of Original Permit 
• Square footage 

 
2. Structure and site elevation information (elevation certificate if available) 
 
3. Tax ID and Lot and Parcel Number 
 
4. Building Property Value on record (Assessed Value, Replacement Value or Both) 
 
5. Land Property Value on record 
 
6. Building Code/Floodplain Development Regulations Exceeding Minimum Standards 
 
7. Historical flood events information 

• When 
• How much damage to community 
• How did it affect property 
• Estimated frequency of event 

 
In addition, [AGENCY OR CONSULTANT NAME] will visit each property to survey the flood risk and 
to take photographs. Property owners are encouraged to visit with the surveyors to discuss any relevant 
flooding issues. 
 
You can help us prepare mitigation plans and apply for funding by facilitating [CONSULTANT OR 
AGENCY NAME] in their information and data collection needs, and also by validating field 
observations. If you have any questions, feel free to call [POC OF SPONSERING AGENCY]. 
 
Sincerely, 
 
 
 
[AGENCY POC or REP] 
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2007 INSTRUCTIONS FOR COMPLETING THE 
NFIP REPETITIVE LOSS (RL) UPDATE AW-501 WORKSHEET 

 
These instructions explain to communities participating in the National Flood Insurance Program’s (NFIP) 
Community Rating System (CRS) how to make updates on the NFIP Repetitive Loss (RL) Update       
AW-501 Worksheet.  If you have any questions on how to apply these instructions or any other repetitive 
loss issues, we suggest contacting either the person responsible for NFIP Repetitive Loss Updates 
identified below or your assigned ISO/CRS Specialist.  
 
Please read Section 501 in the 2006 CRS Coordinators Manual before completing these worksheets. All 
communities applying to and participating in the CRS with one or more repetitive loss properties will 
receive the NFIP Repetitive Loss Update Worksheet. We recognize there are many reasons why the 
property address information needs to be corrected on the community repetitive loss list. The RL Update 
Worksheet was developed to update any known errors on the list while making this process as easy and 
simple to use as possible. 
 

PROCEDURES 
 
It is the responsibility of all CRS communities with at least one repetitive loss property to review and 
update the worksheets if applicable.  Please review the properties listed under “Current Property 
Address” and select one or more of the seven update choices provided in the REQUESTED UPDATES 
section. All requested updates should be clearly legible.  You should keep a photocopy of the original 
document for your records. Please submit only those RL Update Worksheets you have updated and 
attach the transmittal sheet.  If you are submitting a new CRS application, modification, or will be 
undergoing a cycle application in 2007, the updated worksheets should be included in the documentation 
materials provided to your ISO/CRS Specialist. If you are providing voluntary updates, please send the 
updated worksheets and all necessary supporting documentation to the following NFIP Repetitive Loss 
Update address as soon as possible, but no later than December 1, 2007: 
 
NFIP Repetitive Loss Updates, c/o Ms. Sherry Harper, AICP, CFM; Insurance Services Office, Inc.; 
2382 Susan Drive, Crestview, FL 32536.  You may also provide the updated worksheet (AW-501) 
and any required supporting documentation electronically by emailing the documents to 
sharper@iso.com or send them by FAX to 201-748-1869 
 
“Repetitive Loss Number” -- This number is assigned by the RL database computer and is primarily 
used for FEMA internal program tracking. The RL number may also be referred to as a property locator 
number and will likely be referred to in correspondence or discussions concerning submitted updates.    
 
“Local Property Identifier” -- This optional information such as Tax Assessor’s number, Lot & Block, 
etc., is provided by the community. Communities have requested the inclusion of this local information in 
FEMA databases. 
 
“Current Property Address” -- This address will always be the most recent address known for a 
property. If an address update was submitted previously and processed, it will be shown in this section. 
 
“Previous Property Address” -- This is the second most recent address for a repetitive loss property. 
There is no need to modify this address field.  It is shown here and on subsequent listings only for 
informational and comparison purposes. So that you can see the current or revised address and 
community ID number versus the previous address and community ID number. If necessary, the previous 
address may help you locate the structure. 

mailto:sharper@iso.com
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“Last Claimant” --The data shown here is the name of the insured that reported the latest claim for the 
property, and may or may not be the current owner. This data is provided for informational purposes only 
in an effort to help you locate the property, if necessary. This data cannot be updated. If this is the only 
discrepancy you detect or the only entry in need of update, there is no need to submit the AW-501 
worksheet for processing. 
 
“Insured” -- If FEMA records indicate this property is currently insured under the NFIP, a “YES” will be 
shown in this field and the current name associated with the related Policy will be shown in the Named 
Insured section. Once again, the current insured name is only for informational purposes and is not 
intended for you to update. If however you feel that a property is misidentified as uninsured when in fact it 
is insured, you may wish to call that to our attention. Provide as much information as possible in the 
additional comments section on the current insured’s name and/or possible alternate address or 
community identification number that the existing policy may be written under. 
 
“Dates of Losses” -- The dates are shown as year/month/day. For example, January 14, 2005, would be 
shown 20050114.  If there are indications that the loss history reported for the property may be 
inaccurate, please call this to our attention.  For missing claims or a claims history that may include more 
than one separately insured building, provide (in the Comments section of the form or as a separate 
document) all pertinent information such as date of missing claim, name of additional claimant, address of 
missing claim or information on the number of buildings on the site or address that brings in to question 
the claim record validity. 
  

SELECTING AND DOCUMENTING UPDATES 
 
REQUESTED UPDATES 
 
* INFORMATION PROVIDED NOT SUFFICIENT TO IDENTIFY PROPERTY: Before selecting this 
update it is expected that the address information provided will have been thoroughly researched 
including the claimant name and/or the current insured name.  The claimant name provided is associated 
with the last reported loss for the property.  It may or may not be the current property owner or may have 
been a past renter or occupant of the property.  Possible sources of additional information that may help 
you identify the current property address are local tax records for the years of the claims, current and prior 
phone books, utility records, and the U.S. Postal Service.  In addition, name search engines on the 
Internet may be useful in locating a current phone number or address for the name provided.  You can 
also talk to long time citizens of your community to see if they can assist you in identifying the correct 
address of the flooded property.  
 
Please describe the investigative steps you took to locate the property in the Comments section of the 
worksheet.  AW-501s for properties previously updated using this selection are annotated to reflect the 
update by displaying in the additional comments section “Previously updated - this property is 
no longer considered a RL property. Updated as - Unable to locate.”  
 
Previous versions of the AW-501 did not contain claimant or insured name information.  If you were 
previously unable to locate the property, and are now seeing the name of the last claimant or current 
insured for the first time, please take the time to try to locate the property again using the newly provided 
information. 
 
* COSMETIC CHANGES REQUIRED TO THE ADDRESS: Use this area to correct misspellings, street 
suffixes, to provide newly established address information, or to include “Local Property Identifier” 
information that meets your needs.  To better help you locate these addresses; we have provided the 
policyholder name associated with the last reported claim.  The last claimant name associated with the 
insured location will change automatically if a future claim is paid to a new insured.  In addition, if 
currently insured the name associated with the most recent policy is also provided.  Please do not submit 
forms for which the only update is the spelling or accuracy of the claimant or insured name provided.  
Since this is an historical record, we are unable to make these types of updates.  The names will be 
updated automatically, in the event of any future reported claims or changes of the named insured. 
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* PROPERTY NOT IN OUR COMMUNITY OR JURISDICTION: If in using the information provided, you 
have positively identified the RL Property, and have determined that the building is not located in the 
community to which it is currently assigned, please provide the correct community name and NFIP 
Community ID number in the spaces provided.  It is critical that the correct community name including 
county and the NFIP community ID number be provided.  Without this information, the property will 
remain assigned to the community currently identified on the listing of RL Properties.  If necessary, to 
assist the newly assigned community in locating the building, please make any known cosmetic changes 
required to the address (see above) as well. 
 
* FLOOD PROTECTION PROVIDED: Select this update only if some type of structural intervention has 
occurred to either the building, property or the source of flooding that would provide protection to the 
building from those types of flooding events that have occurred in the past.  You also must provide the 
Mitigation Action Codes (a-f) and the Mitigation Funding Codes (j-y) that best describes the mitigation 
project. These codes are included in a separate file on the CD. Please include all available 
documentation with the RL Update Worksheet (AW-501) that supports the mitigation action taken along 
with any evidence available that indicates the mitigation was effective.  It will also be necessary to provide 
a copy of a recent Elevation Certificate if the building was retrofitted or replaced.  If the property was 
previously updated in this manner and the Mitigation Codes are not shown or are incorrect, you 
must provide the appropriate codes. This will avoid the update from being removed in the future.  
 
* NO BUILDING ON PROPERTY: Select this update only if the building in question can be positively 
identified as the previously flooded building and documentation is available to support that as a result of 
acquisition, relocation or demolition, an insurable building no longer exists at this location.  You also must 
provide the Mitigation Action Codes (g-i) and Mitigation Funding Codes (j-y) that best describe the 
mitigation project.  These codes are included in a separate file on the CD. Please include all available 
documentation with the RL Update Worksheet (AW-501) that supports the mitigation action taken.  If the 
property was previously updated in this manner as a result of a non FEMA funded mitigation action and 
has since been replaced by a new elevated or floodproofed building, it will be necessary to select the 
FLOOD PROTECTION PROVIDED update described above and provide the new applicable Mitigation 
Action and Funding Codes.  Also, if the property was previously updated in this manner and the 
Mitigation Codes are not shown or are incorrect, you must provide the appropriate codes. This 
will avoid the update from being removed in the future. 
  
Please note that if the mitigation action was primarily federally funded, it probably did not cover 
the entire cost of mitigation; consequently, a secondary funding code is required. 
 
FLOOD PROTECTION PROVIDED and NO BUILDING ON PROPERTY are two categories that generally 
describe why a property is no longer subject to the types of events that caused the original flooding.  If 
either of these two updates are selected and properly documented, future worksheets will show the 
following statement in the additional comments section: “PREVIOUSLY UPDATED – THIS PROPERTY 
IS NO LONGER CONSIDERED A RL PROPERTY,” and a bold “X” will be placed adjacent to the 
appropriate update.  However, since the property did historically suffer the loss, the property will remain 
on the master repetitive loss list (even though the problem has been reported as corrected).  If another 
claim is reported, the update will automatically be removed and the property will once again be 
considered a repetitive loss property. 
 
* DUPLICATE LISTING WITH RL NUMBER ______________________: If you identify two or more 
(AW-501) worksheets with separate address listings that are for the same building, use this update to 
identify all identical listings so they can be combined.  On each worksheet that is a duplicate property, list 
all other RL or property locator numbers that are a duplicate to that property.  To ensure the proper  
processing of this type of update, please provide all duplicate listing worksheets, for each location, 
together.  Also, please identify the appropriate address to use for the creation of the new listing.  
Remember, if any of the loss dates for the two or more properties are the same, it is not likely that they 
are a true duplicate listing.  It is more likely that there is more than one insurable building on the site that 
has suffered repetitive claims.  Please investigate the possibility of multiple buildings before requesting 
this update. 
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* HISTORIC BUILDING: Choose this update if the property identified on the worksheet has either already 
been designated as a “Historical Building” on either a State or National Historic Registry or is eligible for 
inclusion in a registry. Please provide any appropriate documentation available to support this update. 
 
* COMMENTS SECTION: Use this area to provide comments on any of the above updates or to explain 
a situation that does not fit into one of the above update fields. 
 

DOCUMENTATION REQUIREMENTS 
 
Several of the potential updates require that documentation be provided to support the claim of mitigation 
or to confirm the address or location of the subject building.  The following provides additional clarification 
on the various types of mitigation actions and the type of documentation that would likely be acceptable in 
verifying and approving the requested update. 
 
ELEVATION OR DEMOLITION AND REBUILDING – The most appropriate documentation for this type 
of mitigation is an accurately completed FEMA Elevation Certificate (EC) based on finished construction 
showing that either the lowest floor or the bottom of lowest horizontal structural member, if applicable and 
accompanying machinery is at or above the 100 year base flood elevation. In addition if applicable, the 
EC must show that the area below the next higher floor is constructed in a manner consistent with 
Federal and local floodplain regulations pertaining to the number and size of openings allowing the entry 
and exit of flood waters.  
 
ACQUISITION/DEMOLITION – Appropriate documentation for this type of mitigation action would consist 
of a demolition permit issued by the community, local property tax records showing no improvements on 
the lot, photos of the vacated site and/or written statements from the community official, (on community 
letterhead), explaining the circumstances under which the property was cleared.  A certified deed that 
shows the transfer of ownership of the property to the community and the open space use requirements 
provided for under all FEMA grant programs would also be acceptable. 
 
ACQUISITION/RELOCATION – Documentation, similar to that specified above for acquisition/demolition, 
is required to verify the removal of the structure.  A building permit and/or FEMA EC for the new structure 
showing that it was constructed either outside the special flood hazard area (SFHA) or, in accordance 
with Federal and local floodplain regulations would also be necessary. 
 
FLOODPROOFING – This mitigation measure is usually reserved for non-residential structures.  
Verification would consist of an accurately completed FEMA Floodproofing Certificate showing the 
building as floodproofed to the base flood elevation.  However, any projects that require human 
intervention will be closely reviewed. In communities approved for residential basement floodproofing, an 
accurately completed FEMA Residential Basement Floodproofing Certificate is required for new 
construction in the SFHA. 
 
DRAINAGE IMPROVEMENTS – A thorough description of the improvements and their intended effect is 
required.  The descriptions should include what was done and when, why the action taken was chosen, 
the previous and new level of protection and any evidence of the effectiveness of the project such as an 
analysis of how the system performed during a recent weather event.  Letters from the community official 
in charge of the project that answers these questions and provides examples of the scope and nature of 
the project such as plans would help to support the approval of this flood protection action.  In some 
cases a Letter of Map Revision (LOMR) based on the project is requested of and prepared by FEMA.  In 
those instances providing a copy of the LOMR clearly showing the subject property in the amended area 
and out of the SFHA would suffice for documentation of this mitigation action. 
 
The above actions represent mitigation actions that fully protect a structure from flooding up to and 
including the base flood elevation.  Several repetitive loss properties are flooded simply as a result of 
more frequent, less severe events. For mitigation actions between the 25-year and 99-year protection 
levels, a “conditional” partial protection level will be assigned only with supporting data as certified by a 
design professional and or a community official that includes sufficient engineering data to demonstrate 
that at least 25-year protection has been provided. However, should another loss occur, we reserve the 
right to reevaluate the “conditional” approval and the property may be placed back into repetitive loss 
status. Property will be “conditionally” mitigated if evidence is supplied that the project meets the flood 
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protection level of the 25-year through 99-year recurrence events and the specific property is cited as 
being protected by the project.  Examples of allowable protection projects include channelizations, culvert 
enlargements, retention/detention ponds etc.  
  
The typical documentation required would consist of letters from the community; copies of the previous 
and revised Flood Insurance Reference Maps (FIRM) with property location shown indicating that the 
property was in the SFHA and is now removed; an engineering analysis provided by the community that 
demonstrates the level of protection provided; receipts from contractors; copies of FMA or HMGP 
documentation, if available for individual properties protected by a project.  
 
LEGAL DESCRIPTIONS – Several property records in the RL database are known only by a “legal 
description.” If the documentation submitted for the mitigation project, as described above, now 
references a mailing or “group one” address as provided by the U.S. Postal Service, documentation to 
support that the “group one” address and the legal description listed currently are one and the same, is 
required. Tax records showing both a legal description and a local mailing address would suffice for 
documentation of this criterion. 
 
The above documentation stipulations represent those documents that should be available after a 
properly executed mitigation project is closed out.  On occasion circumstances dictate otherwise.  
Each request for update will be evaluated on its individual merits and will be approved or denied 
based on sound engineering principles, the support of the documentation provided, and the claim 
history of the property.    
 

SUBMITTING UPDATES 
 
UPDATES AUTHORIZED BY:  When submitting NFIP Repetitive Loss Update Worksheets (AW-501) in 
paper format by mail or fax, the RL Transmittal Sheet must be filled out, signed, and accompany the 
requested updates. When submitting updates by electronic methods, the RL Transmittal sheet must be 
filled out and accompany the submittal but the electronic signature on the email may be used for the 
authorizing signature. Any AW-501 updates submitted without a signed RL Transmittal Sheet will not be 
processed until the signed Transmittal Sheet is provided.   
 
FEMA appreciates and thanks you for your support and assistance in providing this information.  You may 
be contacted in the future if we have any questions concerning your updates.  
 
 

Under the Privacy Act (5 U.S.C. 552a), personal identifiers, such as names, may be used only for 
limited purposes. One of the allowable uses of names and flood insurance policy numbers is to analyze 
the effectiveness of local flood loss reduction efforts. Communities may use personal identifiers for this 
purpose only and are prohibited from using them for solicitation, or other reasons. 



Federal Emergency Management Agency                 OMB  1660-0022 EXPIRES August  31, 2010 

National Flood Insurance Program 
NFIP REPETITIVE LOSS (RL) UPDATE WORKSHEET (AW-501) 
NOTE: SEE REVERSE SIDE FOR MITIGATION ACTION CODES AND PAPERWORK BURDEN STATEMENT 
Printed On:                                            THE INFORMATION ON THIS FORM IS BASED ON CLAIMS ON OR BEFORE:   

REPETITIVE LOSS NUMBER:  
Internal use only           A          N/A        FRR

CURRENT NFIP COMMUNITY NAME: 

COMMUNITY ID # :  
CURRENT PROPERTY ADDRESS  PREVIOUS PROPERTY ADDRESS/COMMUNITY ID # 

   
   
   
LAST CLAIMANT:    

 INSURED:               NAMED INSURED: 
DATES OF LOSSES                                                                                   TOTAL NUMBER OF LOSSES FOR PROPERTY: 

         

REQUESTED UPDATES 
MARK ALL UPDATES BELOW THAT APPLY (IMPORTANT – READ THE INSTRUCTIONS) 

 
1.    INFORMATION PROVIDED NOT SUFFICIENT TO IDENTIFY PROPERTY. 

Choose this update if all attempts to locate the property fail.  Please describe the steps you took to locate the property in the comments 
section below. 
 

2.    COSMETIC CHANGES REQUIRED TO THE ADDRESS: 
Use this update to correct or update the property address shown above. 
Only change the address not the name. 

 
3.    PROPERTY NOT IN OUR COMMUNITY OR JURISDICTION: 

Choose this update if you have positively determined that the property shown is not located in your community.  Please provide the correct 
community name and if known the NFIP Community ID Number. If available, please attach a map showing  the property location. 

 
            ASSIGN TO COMMUNITY NAME:                                                                      NFIP COMMUNITY ID # 
 
4.    FLOOD PROTECTION PROVIDED. 

Choose this update only if some type of structural intervention has occurred to  the building,  property or the source of flooding that protects 
the building from future events similar to those that occurred in the past.  The correction must be supported by documentation such as an 
Elevation Certificate and the Mitigation information below must be provided. 
 
  Mitigation Action 1.)       Source of  Mitigation Funding 3.)                 See the back of this form for the appropriate codes. 

 
5.    NO BUILDING ON PROPERTY. 

Choose this update only if the property in question can be positively identified as the site of the previously flooded building and documentation 
is available to support that an insurable building no longer exists at this site. The correction must be supported by documentation such as a 
Demolition or Relocation Permit and the Mitigation information below must be provided.   
 
  Mitigation Action 2.)       Source of  Mitigation Funding 3.)                See the back of this form for the appropriate codes. 

 
6.    DUPLICATE LISTING WITH RL NUMBER:  ________________________  COMBINE AS ONE LISTING. 

Choose this update to identify two or more separate listings that are for the same building.  List all other RL numbers that are duplicates to this 
property.  Please indicate which address shown is the correct address to use. 

 
7.    HISTORIC BUILDING:   Check this box if you know the building is listed on a  State or National Historic Registry. 
 
 
ADDITIONAL COMMENTS: 

 
 
 

A SIGNED RL TRANSMITTAL SHEET MUST ACCOMPANY THIS FORM FOR APPOVAL OF THE UPDATE! 
 

SEE PRIVACY ACT STATEMENT ON THE BACK  
 
 
 

AW-501     Page  1 of  2 



MITIGATION ACTION CODES 
 

1.) If you checked the box that says “FLOOD PROTECTION PROVIDED,” please enter the letter below 
(a –f) that best describes the situation: 

 
a. The building was elevated to or above the Base Flood Elevation (BFE). 
b. The building was elevated but not to the BFE. 
c. The building (non-residential) was floodproofed to the BFE. 
d. The building was partially floodproofed (but, not to the BFE). 
e. The building was protected by a flood control/stormwater management project. 
f. The building was replaced by a new elevated/floodproofed building. 

 
2.) If you checked the box that says “NO BUILDING ON PROPERTY,” please enter the letter below 

(g – i) that best describes the situation. 
 

g. The building was demolished, but not acquired through any program.      
h. The building was acquired and demolished as part of a program. 
i. The building was relocated out of the floodplain. 

 
 

MITIGATION FUNDING CODES 
 
3.) Please choose from the following (j – y) to identify the primary and secondary funding sources for the 

mitigation action described by a – i above. 
 

 
FEMA PROGRAMS 
 
j. Hazard Mitigation Grant Program (HMGP). 
k. Flood Mitigation Assistance Program 

(FMA). 
l. Pre-Disaster Mitigation Grant Program 

(PDM). 
m. Repetitive Flood Claims (RFC) 
n. Severe Repetitive Loss Program (SRL) 
o. Section 1362 Acquisition Program. 
p. Other FEMA Programs 

 

 
NON FEMA  FUNDING SOURCES 
 
q. Increased Cost of Compliance (ICC) 

coverage. 
r. U.S. Housing & Urban Development 

(HUD) Community Development Block 
Grant (CDBG). 

s. U.S. Army Corps of Engineers or Natural 
Resources Conservation Service (NRCS) 
Project. 

t. Other Federal Program. 
u. State Program. 
v. Local Program. 
w. Property Owner 
x. Natural Disaster or Fire. 
y. Unknown  

 
 
 

 
 
 

OMB Statement: Public reporting burden for this information collection is estimated at 35 hours for 
the application and certification process.  Burden means the time, effort and financial resources 
expended by persons to generate, maintain, retain, disclose, or to provide information to us. You may 
send comments regarding the burden estimate or any aspect of the collection, including suggestions 
for reducing the burden to: Information Collections Management, U.S. Department of Homeland Security, 
Emergency Preparedness and Response Directorate, Federal Emergency Management Agency, 500 C Street, 
SW, Washington, DC 20472, Paperwork Reduction Project (OMB Control Number 1660-0022).  You are not 
required to respond to this collection of information unless a valid OMB control number appears in 
the upper right corner of this form.  Note: Do not send your completed questionnaire to this address.  
 
Privacy Act:  The information contained in this transmittal is legally privileged and confidential. 
Its use is protected under the Privacy Act of 1974, 5 U.S.C. Section 552(a). Use of the provided 
information is restricted to the applicable Routine Use(s) cited in the System Notice published at 67 
FR 3193 January 23, 2003. The information provided should be used consistently with the purpose(s) 
for which the records were released as stated in the applicable Routine Use(s) cited herein. 

Further, under the Privacy Act of 1974, 5 U.S.C. Section 552(a), personal identifiers, such as names, 
may be used only for limited purposes. One of the allowable uses of names and flood insurance claims 
history is to analyze the effectiveness of local flood loss reduction efforts. In addition, the 
Routine Use furthers the floodplain management and hazard mitigation goals of the Agency by making 
more detailed NFIP records available to communities. Communities may use personal identifiers for 
this purpose only and are prohibited from using them for solicitation, or other reasons. 



SAVE TIME  
WHEN SUBMITTING REPETITIVE LOSS UPDATES  

  
STATE  the nature of the address problem and steps taken to identify the property for Information 
Provided Not Sufficient To Identify Property.  
  
ATTACH  supporting documentation and include the Mitigation Action and Funding Codes when you 
select Flood Protection Provided or No Building On Property.  
  
PROVIDE  the name of the community where the property is located if the property is Not in your 
Community.  
  
INCLUDE  any missing or incorrect mitigation codes to previously updated listings.   
  
EXCLUDE  AW-501s that do not need updates.  
  
AUTHORIZE  your update by signing and dating the “Repetitive Loss Transmittal Sheet” provided or 
include a signed cover letter authorizing the updates.  
  
See enclosed 2005 Instructions For Completing The NFIP Repetitive Loss (RL) Update AW 501 Worksheet for complete instructions.  
  

NFIP Repetitive Loss Updates  
c/o Ms. Sherry Harper, AICP, CFM 

Insurance Services Office, Inc. 
2382 Susan Drive 

Crestview, FL 32536 
850-682-1998 (phone) 

201-748-1869 (fax) 
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